After you install ACID and start it for the first time, the registration wizard appears. This wizard offers easy steps that enable you to register ACID online with Sonic Foundry. Alternately, you may register ACID online at [www.sonicfoundry.com](http://www.sonicfoundry.com) at any time.

Registering your product provides you with exclusive access to a variety of technical support options, notification of product updates, and special promotions exclusive to ACID registered users.

### Registration assistance

If you do not have access to the Internet, registration assistance is available during normal weekday business hours. Please contact our Customer Service Department by dialing one of the following numbers:

<table>
<thead>
<tr>
<th>Telephone/Fax</th>
<th>Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-800-577-6642 (toll-free)</td>
<td>US, Canada, and Virgin Islands</td>
</tr>
<tr>
<td>+800-000-76642 (toll-free)</td>
<td>Australia, Denmark, France, Germany, Italy, Sweden, UK, Netherlands, and Japan</td>
</tr>
<tr>
<td>+608-204-7703</td>
<td>All other countries</td>
</tr>
<tr>
<td>1-608-250-1745 (fax)</td>
<td>All countries</td>
</tr>
</tbody>
</table>

### Customer service/sales

For a detailed list of customer service options, we encourage you to visit [www.sonicfoundry.com](http://www.sonicfoundry.com). Use the following numbers for telephone support during normal office hours:

<table>
<thead>
<tr>
<th>Telephone/Fax/E-mail</th>
<th>Country</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-800-577-6642 (toll-free)</td>
<td>US, Canada, and Virgin Islands</td>
</tr>
<tr>
<td>+800-000-76642 (toll-free)</td>
<td>Australia, Denmark, France, Germany, Italy, Sweden, UK, Netherlands, and Japan</td>
</tr>
<tr>
<td>+608-204-7703</td>
<td>All other countries</td>
</tr>
<tr>
<td>1-608-250-1745 (fax)</td>
<td>All countries</td>
</tr>
<tr>
<td><a href="mailto:customerservice@sonicfoundry.com">customerservice@sonicfoundry.com</a></td>
<td></td>
</tr>
</tbody>
</table>

### Technical support

For a detailed list of technical support options, we encourage you to visit [www.sonicfoundry.com/support](http://www.sonicfoundry.com/support).

- To listen to your support options, please call 608-256-5555.
- Customers who have purchased ACID Pro receive 60 days of complimentary phone support. The complimentary support begins the date of your first call. (Registration is required to receive this complimentary support.) Please call (608) 204-7704 if you need assistance with your Pro version product.

### User manual feedback

If you have comments or suggestions about this user manual, we would like to hear from you. Send us e-mail at docfeedback@sonicfoundry.com.
The information contained in this manual is subject to change without notice and does not represent a commitment on the part of Sonic Foundry. The software described in this manual is provided under the terms of a license agreement or nondisclosure agreement. The software license agreement specifies the terms and conditions for its lawful use.

Sonic Foundry and ACID are registered trademarks of Sonic Foundry, Inc. ASIO is a trademark and VST is a registered trademark of Steinberg Media Technologies AG. AC-3 is a trademark of Dolby Laboratories. Other brands and products named here are the trademarks or registered trademarks of Sonic Foundry, its affiliates, or their respective holders.

Copyright © 2002-2003 Sonic Foundry, Inc. This user guide can be reproduced for noncommercial reference or personal/private use only and may not be resold. Any reproduction in excess of fifteen copies or electronic transmission requires the written permission of Sonic Foundry.

A special note concerning the use of the Dolby Digital trademark:

Dolby Laboratories encourages use of the Dolby Digital trademark to identify soundtracks that are encoded in Dolby Digital. This is an effective way to inform listeners of the soundtrack format, and the use of a standard logo promotes easy recognition in the marketplace. However, like any trademark, the Dolby Digital logo may not be used without permission. Dolby Laboratories therefore provides a standard trademark license agreement for companies who wish to use Dolby trademarks. This agreement should be signed by the company that owns the program material being produced. Recording studios or production facilities which provide audio production or encoding services for outside clients generally do not require a trademark license.

If you would like more information on obtaining a Dolby trademark license, please contact Dolby Laboratories Licensing Corporation. Information on trademark licensing plus instructions for using the Dolby Digital trademark and marking audio formats can also be found on-line at http://www.dolby.com.

Dolby Laboratories Licensing Corporation
100 Potrero Ave.
San Francisco, CA 94520 USA
Phone: 415-558-0200
Fax: 415-863-1373
E-mail: tsa@dolby.com
http://www.dolby.com
Table of Contents

Introducing ACID ...................................................... 11
  Welcome to Sonic Foundry ACID .................................. 11
  System requirements ............................................... 11
  Installing ACID .................................................... 11
  Using online help ................................................... 12
    Online help ..................................................... 12
    What’sThis? help .................................................. 13
    Help on the Web .................................................. 13
  Overview of ACID .................................................... 13
    Main interface .................................................... 13
    Toolbar ........................................................... 14
    Track list ........................................................ 15
    Track view ....................................................... 16
    Window docking area ............................................. 18
    Keyboard command reference .................................. 19
    Audio signal flow ............................................... 24
    MIDI signal flow ............................................... 26

What’s New? ............................................................ 29
  Mixing ............................................................... 29
    Plug-in effects automation ...................................... 29
    5.1 surround mixing and surround pan automation ............. 29
    Alternate time signatures ....................................... 29
    ASIO driver support ............................................. 30
    Loop Cloning in the Chopper ................................... 30
    Bus tracks ....................................................... 30
    Enhanced time stretching for Beatmapped tracks .............. 30
    New audio panning types ....................................... 30
    New envelope fade types ....................................... 30
    ReWine support .................................................. 30

TABLE OF CONTENTS
TABLE OF CONTENTS

MIDI ................................................................. 30
MIDI piano roll editing ........................................... 30
MIDI step recording ............................................... 30
MIDI event list editing .......................................... 31
VSTi support ....................................................... 31
Yamaha OPT support ............................................. 31
Optimized DLS and VSTi soft synth controls ................. 31
Workspace .......................................................... 31
Multiple media file previewing and Explorer enhancements 31
Hotkey commands for track muting and soloing ............. 31
Optimized ACID playback ....................................... 31
Autosave crash recovery ....................................... 31
Customizable default track properties ......................... 31
Video ................................................................. 32
Windows Media Audio and Video import ....................... 32
Enhanced video handling ....................................... 32

Getting Started .................................................. 33
Starting projects .................................................. 33
Setting project properties ...................................... 33
Opening existing projects ........................................ 34
Getting media files ............................................... 35
Previewing media from the Explorer window ................. 35
Adding media to the project ..................................... 36
Understanding track types ...................................... 38
Loops ................................................................. 38
One-shots .......................................................... 38
Beatmapped ........................................................ 38
MIDI ................................................................. 39
Adding and editing events ....................................... 39
Painting events ..................................................... 39
Changing the length of events ................................ 40
Erasing sections of events ...................................... 40
Moving events ...................................................... 41
Using the cursor ................................................... 41
Positioning the cursor with the mouse ......................... 41
Positioning the cursor with the keyboard ...................... 41
Positioning the cursor with the Go To command ............. 42
# Table of Contents

## Making selections
- Selecting an event ........................................ 42
- Selecting multiple events .................................. 42
- Creating time selections ..................................... 44
- Creating event selections within time selections ........ 44

## Working with tracks
- Reordering tracks ........................................... 45
- Resizing tracks ................................................ 45
- Changing track colors ...................................... 45
- Renaming tracks ............................................. 45
- Duplicating tracks .......................................... 45
- Deleting tracks ............................................... 46
- Copying, cutting, and pasting tracks ..................... 46
- Adjusting the mix ........................................... 46
- Muting tracks ................................................ 47
- Soloing tracks ............................................... 48
- Working with groups of tracks ............................. 48

## Using undo and redo
- Using undo ................................................... 48
- Undoing all edits ............................................ 49
- Using redo .................................................... 49
- Clearing the undo history ................................... 49

## Playing the project
- Using the transport bar ..................................... 49
- Using playback options .................................... 50

## Using the Mixer window
- Viewing the Mixer window ................................ 51
- Using the mixer toolbar .................................... 51
- Renaming mixer controls .................................. 51
- Using the mixer’s faders ................................... 51

## Saving, rendering, and delivering projects
- Saving projects ............................................. 53
- Rendering projects ......................................... 54
- Publishing to the Internet .................................. 56
- Writing to CD ............................................... 57

## Editing Events
- Copying events ................................................ 59
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pasting events</td>
<td>59</td>
</tr>
<tr>
<td>Using the Paste command</td>
<td>60</td>
</tr>
<tr>
<td>Using Paste Repeat</td>
<td>60</td>
</tr>
<tr>
<td>Using Paste Insert</td>
<td>60</td>
</tr>
<tr>
<td>Cutting events</td>
<td>61</td>
</tr>
<tr>
<td>Deleting events</td>
<td>61</td>
</tr>
<tr>
<td>Trimming events</td>
<td>61</td>
</tr>
<tr>
<td>Splitting events</td>
<td>62</td>
</tr>
<tr>
<td>Splitting at the cursor position</td>
<td>62</td>
</tr>
<tr>
<td>Splitting an event</td>
<td>63</td>
</tr>
<tr>
<td>Splitting multiple events</td>
<td>63</td>
</tr>
<tr>
<td>Splitting a time selection</td>
<td>63</td>
</tr>
<tr>
<td>Splitting events within a time selection</td>
<td>64</td>
</tr>
<tr>
<td>Joining events</td>
<td>64</td>
</tr>
<tr>
<td>Ripple editing</td>
<td>64</td>
</tr>
<tr>
<td>Cutting events in ripple editing mode</td>
<td>65</td>
</tr>
<tr>
<td>Deleting events in ripple editing mode</td>
<td>66</td>
</tr>
<tr>
<td>Pasting events in ripple editing mode</td>
<td>66</td>
</tr>
<tr>
<td>Slipping and sliding events</td>
<td>67</td>
</tr>
<tr>
<td>Shifting the contents of (slipping) events</td>
<td>68</td>
</tr>
<tr>
<td>Slip-trimming events</td>
<td>68</td>
</tr>
<tr>
<td>Sliding events</td>
<td>68</td>
</tr>
<tr>
<td>Changing event properties</td>
<td>68</td>
</tr>
<tr>
<td>Using event envelopes</td>
<td>69</td>
</tr>
<tr>
<td>Setting an event’s volume envelope</td>
<td>69</td>
</tr>
<tr>
<td>Setting an event’s fade-in and -out envelope curve</td>
<td>70</td>
</tr>
<tr>
<td>Creating crossfades between events</td>
<td>70</td>
</tr>
<tr>
<td>Working in the Track View</td>
<td>71</td>
</tr>
<tr>
<td>Using project markers and regions</td>
<td>71</td>
</tr>
<tr>
<td>Working with standard markers</td>
<td>71</td>
</tr>
<tr>
<td>Working with time markers</td>
<td>73</td>
</tr>
<tr>
<td>Working with command markers</td>
<td>73</td>
</tr>
<tr>
<td>Working with regions</td>
<td>76</td>
</tr>
<tr>
<td>Using snapping</td>
<td>78</td>
</tr>
<tr>
<td>Choosing snapping options</td>
<td>78</td>
</tr>
<tr>
<td>Changing tempo, time signature, and key</td>
<td>79</td>
</tr>
<tr>
<td>Changing project tempo</td>
<td>79</td>
</tr>
<tr>
<td>Changing project time signature</td>
<td>80</td>
</tr>
<tr>
<td>Changing project key</td>
<td>80</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Working with tempo/key/time signature change markers</td>
<td>81</td>
</tr>
<tr>
<td>Changing a track's key</td>
<td>82</td>
</tr>
<tr>
<td>Changing an event’s key</td>
<td>82</td>
</tr>
<tr>
<td>Adjusting time</td>
<td>82</td>
</tr>
<tr>
<td>Inserting time</td>
<td>82</td>
</tr>
<tr>
<td>Fitting to time</td>
<td>83</td>
</tr>
<tr>
<td>Using the Chopper</td>
<td>85</td>
</tr>
<tr>
<td>Working in the Chopper window</td>
<td>85</td>
</tr>
<tr>
<td>Viewing the Chopper</td>
<td>85</td>
</tr>
<tr>
<td>Changing the Chopper grid</td>
<td>85</td>
</tr>
<tr>
<td>Changing Chopper snapping options</td>
<td>85</td>
</tr>
<tr>
<td>Magnifying the Chopper</td>
<td>86</td>
</tr>
<tr>
<td>Previewing in the Chopper</td>
<td>86</td>
</tr>
<tr>
<td>Using Chopper toolbar and keyboard commands</td>
<td>86</td>
</tr>
<tr>
<td>Inserting markers and regions in the Chopper</td>
<td>87</td>
</tr>
<tr>
<td>Creating selections in the Chopper</td>
<td>87</td>
</tr>
<tr>
<td>Placing files in the Chopper</td>
<td>87</td>
</tr>
<tr>
<td>Creating selections</td>
<td>87</td>
</tr>
<tr>
<td>Creating selections of a specific musical length</td>
<td>87</td>
</tr>
<tr>
<td>Inserting increments</td>
<td>88</td>
</tr>
<tr>
<td>Creating increments</td>
<td>88</td>
</tr>
<tr>
<td>Creating increments of a specific musical length</td>
<td>89</td>
</tr>
<tr>
<td>Creating increments of a custom musical length</td>
<td>89</td>
</tr>
<tr>
<td>Inserting selections in the track view</td>
<td>90</td>
</tr>
<tr>
<td>Using the Insert Selection button</td>
<td>90</td>
</tr>
<tr>
<td>Using copy and paste</td>
<td>90</td>
</tr>
<tr>
<td>Dragging selections</td>
<td>90</td>
</tr>
<tr>
<td>Moving the insert position in the track view</td>
<td>90</td>
</tr>
<tr>
<td>Saving Chopper selections as new files</td>
<td>90</td>
</tr>
<tr>
<td>Using the Chopper with one-shots</td>
<td>91</td>
</tr>
<tr>
<td>Working with Tracks</td>
<td>93</td>
</tr>
<tr>
<td>Using track effects</td>
<td>93</td>
</tr>
<tr>
<td>Creating or adding to track plug-in chains</td>
<td>93</td>
</tr>
<tr>
<td>Arranging plug-in chain order</td>
<td>95</td>
</tr>
<tr>
<td>Bypassing plug-ins in a chain</td>
<td>95</td>
</tr>
<tr>
<td>Removing plug-ins from chains</td>
<td>95</td>
</tr>
<tr>
<td>Saving plug-in chains as packages</td>
<td>96</td>
</tr>
<tr>
<td>Removing or bypassing all effects on tracks</td>
<td>96</td>
</tr>
<tr>
<td>Table of Contents</td>
<td></td>
</tr>
<tr>
<td>-------------------</td>
<td></td>
</tr>
<tr>
<td>Using track envelopes</td>
<td>97</td>
</tr>
<tr>
<td>Adding track envelopes</td>
<td>97</td>
</tr>
<tr>
<td>Adjusting envelopes</td>
<td>99</td>
</tr>
<tr>
<td>Using the Envelope tool</td>
<td>100</td>
</tr>
<tr>
<td>Hiding track envelopes</td>
<td>101</td>
</tr>
<tr>
<td>Removing track envelopes</td>
<td>102</td>
</tr>
<tr>
<td>Choosing stereo pan types</td>
<td>103</td>
</tr>
<tr>
<td>Using the Beatmapper</td>
<td>103</td>
</tr>
<tr>
<td>Understanding stretching properties</td>
<td>105</td>
</tr>
<tr>
<td>Configuring track properties</td>
<td>105</td>
</tr>
<tr>
<td>Adjusting general track properties</td>
<td>105</td>
</tr>
<tr>
<td>Adjusting stretching properties for loop or Beatmapped tracks</td>
<td>106</td>
</tr>
<tr>
<td>Adjusting track properties for MIDI tracks</td>
<td>108</td>
</tr>
<tr>
<td>Reloading files</td>
<td>108</td>
</tr>
<tr>
<td>Replacing files</td>
<td>109</td>
</tr>
<tr>
<td>Saving file properties</td>
<td>109</td>
</tr>
<tr>
<td>Mixing multiple tracks to a single track</td>
<td>109</td>
</tr>
<tr>
<td>Exporting loops</td>
<td>110</td>
</tr>
<tr>
<td>Using the Mixer</td>
<td>111</td>
</tr>
<tr>
<td>Using busses</td>
<td>111</td>
</tr>
<tr>
<td>Adding busses to the project</td>
<td>111</td>
</tr>
<tr>
<td>Routing tracks to busses</td>
<td>111</td>
</tr>
<tr>
<td>Routing busses to system hardware</td>
<td>112</td>
</tr>
<tr>
<td>Deleting busses</td>
<td>112</td>
</tr>
<tr>
<td>Using assignable effects</td>
<td>113</td>
</tr>
<tr>
<td>Adding assignable effect controls</td>
<td>113</td>
</tr>
<tr>
<td>Working with assignable effects chains</td>
<td>114</td>
</tr>
<tr>
<td>Routing tracks to assignable effect controls</td>
<td>114</td>
</tr>
<tr>
<td>Routing assignable effect controls to busses</td>
<td>114</td>
</tr>
<tr>
<td>Deleting assignable effect controls</td>
<td>115</td>
</tr>
<tr>
<td>Using soft synth controls</td>
<td>115</td>
</tr>
<tr>
<td>Adding soft synth controls to projects</td>
<td>116</td>
</tr>
<tr>
<td>Modifying soft synth control properties</td>
<td>116</td>
</tr>
<tr>
<td>Using ACID with ReWire panel applications</td>
<td>119</td>
</tr>
<tr>
<td>Deleting soft synth controls</td>
<td>120</td>
</tr>
<tr>
<td>Routing MIDI tracks to soft synth controls</td>
<td>120</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Using mixer controls</td>
<td>120</td>
</tr>
<tr>
<td>Working with mixer controls</td>
<td>120</td>
</tr>
<tr>
<td>Adding effects to mixer controls</td>
<td>121</td>
</tr>
<tr>
<td>Working with multiple mixer controls</td>
<td>125</td>
</tr>
<tr>
<td>Automating mixer controls in track view</td>
<td>125</td>
</tr>
<tr>
<td>Recording in ACID</td>
<td>127</td>
</tr>
<tr>
<td>Recording audio</td>
<td>127</td>
</tr>
<tr>
<td>Setting ACID's recording properties</td>
<td>128</td>
</tr>
<tr>
<td>Setting recording levels</td>
<td>129</td>
</tr>
<tr>
<td>Recording multiple takes</td>
<td>130</td>
</tr>
<tr>
<td>Reviewing and saving takes</td>
<td>130</td>
</tr>
<tr>
<td>Working with MIDI</td>
<td>131</td>
</tr>
<tr>
<td>Adding MIDI tracks</td>
<td>131</td>
</tr>
<tr>
<td>Adding MIDI files</td>
<td>131</td>
</tr>
<tr>
<td>Creating new MIDI files</td>
<td>131</td>
</tr>
<tr>
<td>Recording MIDI tracks</td>
<td>131</td>
</tr>
<tr>
<td>Changing MIDI track properties</td>
<td>132</td>
</tr>
<tr>
<td>Pitch shifting MIDI tracks</td>
<td>132</td>
</tr>
<tr>
<td>Setting root notes for MIDI tracks</td>
<td>132</td>
</tr>
<tr>
<td>Working with tracks in a MIDI file</td>
<td>133</td>
</tr>
<tr>
<td>Previewing MIDI files</td>
<td>134</td>
</tr>
<tr>
<td>Using the piano roll editor</td>
<td>134</td>
</tr>
<tr>
<td>Viewing the piano roll editor</td>
<td>135</td>
</tr>
<tr>
<td>Previewing MIDI</td>
<td>135</td>
</tr>
<tr>
<td>Selecting MIDI tracks</td>
<td>136</td>
</tr>
<tr>
<td>Adding note events</td>
<td>136</td>
</tr>
<tr>
<td>Editing note events</td>
<td>137</td>
</tr>
<tr>
<td>Quantizing note events</td>
<td>139</td>
</tr>
<tr>
<td>Deleting note events</td>
<td>139</td>
</tr>
<tr>
<td>Undoing and redoing</td>
<td>139</td>
</tr>
<tr>
<td>Saving MIDI</td>
<td>139</td>
</tr>
<tr>
<td>Using the list editor</td>
<td>140</td>
</tr>
<tr>
<td>Viewing the list editor</td>
<td>140</td>
</tr>
<tr>
<td>Previewing MIDI</td>
<td>140</td>
</tr>
<tr>
<td>Filtering the list</td>
<td>141</td>
</tr>
<tr>
<td>Editing events</td>
<td>141</td>
</tr>
<tr>
<td>Creating events</td>
<td>145</td>
</tr>
<tr>
<td>Step recording events</td>
<td>145</td>
</tr>
</tbody>
</table>
Quantizing events ............................................................. 146
Deleting events ................................................................ 147
Undoing and redoing ......................................................... 147
Saving MIDI ...................................................................... 147
Loading third-party OPT plug-ins. ................................. 147
Saving, reloading, or replacing MIDI files ....................... 148
Routing MIDI tracks to MIDI devices or soft synth controls ........................................................................... 149
Resetting MIDI ports .......................................................... 149
Rendering projects with MIDI tracks ................................. 150
Playing MIDI from external devices ................................... 150
Adding external devices as MIDI inputs ......................... 150
Assigning MIDI inputs to soft synth controls ................. 150
Synchronizing using MIDI timecode ................................. 151
Generating MIDI timecode ................................................. 151
Triggering from MIDI timecode ....................................... 152
Generating MIDI clock ...................................................... 152

Working with Video .......................................................... 153
Managing video ............................................................... 153
Adding or replacing video files .................................... 153
Removing the video track .............................................. 153
Hiding and showing the video track .............................. 153
Synchronizing audio and video .................................... 153
Removing the video’s audio ....................................... 154
Changing frame numbering .......................................... 154
Editing video events ......................................................... 154
Moving video events ......................................................... 154
Trimming video events .................................................. 154
Slipping and sliding video events .................................... 154
Using the Video window ................................................ 155
Using toolbar buttons .................................................... 155
Using the shortcut menu ................................................. 155
Viewing the status bar .................................................... 155
Previewing on external monitors .................................... 156
Scoring video with ACID ................................................ 156

Working with 5.1 Surround ................................................ 157
What is 5.1 surround? ..................................................... 157
Setting up surround hardware ......................................... 158

TABLE OF CONTENTS
# Setting up surround projects
- Routing to hardware in the mixer ....................................................... 159
- Assigning audio to the LFE channel .................................................... 160

# Panning audio
- Panning tracks .................................................................................... 161
- Panning mixer controls ........................................................................ 162
- Using the Surround Panner window ..................................................... 163

# Automating panning
- Turning on panning keyframes ............................................................ 165
- Adding panning keyframes .................................................................. 165
- Working with keyframes ...................................................................... 166

# Rendering surround projects .............................................................. 168
# Burning AC-3 files to DVD .................................................................. 169

## Customizing ACID ............................................................................. 171

# Working with ACID windows
- Docking and floating ACID windows .................................................... 172

# Changing the time ruler format
- Using the ruler offset ........................................................................... 173
- Using the project grid ........................................................................... 174
- Setting the grid type ............................................................................ 174

# Using the toolbar
- Hiding and displaying the toolbar ........................................................ 175
- Reordering toolbar buttons .................................................................. 175
- Adding buttons to the toolbar .............................................................. 175
- Removing buttons from the toolbar ....................................................... 176

# Using the time display
- Changing cursor position ...................................................................... 177
- Changing the time display .................................................................... 177
- Monitoring MIDI timecode ................................................................... 178

# Setting default track properties ......................................................... 178

# Setting ACID preferences
- Using the General tab ........................................................................... 179
- Using the Audio tab .............................................................................. 181
- Using the MIDI tab ................................................................................. 182
- Using the VST Instruments tab .............................................................. 182
- Using the ReWire Devices tab .............................................................. 183
- Using the Video tab ............................................................................... 183
- Using the Editing tab ............................................................................ 183
- Using the Sync tab ................................................................................ 184
# TABLE OF CONTENTS

Using the Other tab ......................................................... 185

## ACID Tips and Tricks .................................................. 187

- Adding long media files quickly ..................................... 187
- Playing with duplicate tracks ........................................ 187
  - Detuning paired tracks .......................................... 187
  - Duplicating with offset ........................................ 188
  - Creating ping-pong pan effects ................................ 188
- Adding depth with assignable effects .............................. 189
- Playing double time/half time ...................................... 189
- Constructing the wall of sound .................................... 190
- Adding through subtraction ......................................... 190
- Tweaking the dynamics .............................................. 190
  - Fading in and out of mixes ..................................... 190
  - Adding build ups ................................................. 191
- Creating wah-wah effects with automated Track EQ .......... 191
- Making automated changes more stark ............................ 191
  - Abruptly changing volume or pan ............................... 191
  - Turning automated effects on and off ........................ 192
- Making automated frequency changes more natural .......... 192
- Overriding compress/expand ........................................ 193
- Slicing and dicing in the Chopper ................................. 193
  - Chopping new loops for alternate time signatures .......... 193
  - Chopping multiple files into a new loop ...................... 193
  - Creating drum-roll build ups .................................... 194
  - Creating drum fills .............................................. 194
  - Creating one-track remixes ..................................... 194
  - Creating DJ-style crossfades .................................... 194
  - Creating pseudo-granular synthesis ............................. 195
- Building instrument solos ............................................ 195
- Building scales ....................................................... 195

## Glossary ........................................................................ 197

## Index ............................................................................ i
Welcome to Sonic Foundry ACID

Congratulations on purchasing a revolutionary software application for Windows. Using Sonic Foundry ACID® you can create great music by simply picking, painting, and playing.

System requirements

In order to use ACID, your computer must satisfy the following minimum specifications:

- 300 MHz processor (400 MHz processor required for video scoring)
- Microsoft Windows 98SE, Me, 2000, or XP
- 64 MB RAM (128 MB recommended)
- 60 MB hard-disk space for program installation
- Windows-compatible sound card
- CD-ROM drive (required for installation from CD-ROM)
- Supported CD-recordable drive (required for CD burning)
- DirectX 8.0 (included on CD-ROM)
- Internet Explorer, version 4.0 or higher (version 5.0 included on CD-ROM)

Installing ACID

Prior to installing ACID, we recommend that you exit all open applications and temporarily turn off any virus protection.

Note: If you’re installing ACID on a system running Windows 2000, your user account must be a member of the Administrators group to install ACID and a member of the Power Users group (or higher) to register ACID.

1. Insert the ACID CD-ROM. The ACID Installation screen appears if CD-ROM AutoPlay is enabled.

Note: If CD-ROM AutoPlay is turned off, click Start and choose Run. In the Run dialog, enter the CD-ROM drive’s letter and add \setup.exe. Click OK to begin installation.

2. Click Install Software to begin the installation process.

3. Follow the on-screen prompts and enter the necessary information when required. At the final screen prompt, click Finish.
Using online help

You can access two varieties of help within ACID:

- Online help
- What'sThis? help (also referred to as context-sensitive help)

Online help

To access online help, choose Contents and Index from the Help menu or press F1.

**Note:** To view online help, Internet Explorer 4.0 or later must be installed on your system. Internet Explorer 5.0 is included on the ACID CD-ROM for your convenience.

The Contents tab provides a list of available help topics. Double-click a closed book (û) to open the pages and then click a topic page (û).

The Index tab provides a complete listing of the help topics available. Scroll through the list of available topics or type a word in the Type in the keyword to find box to quickly locate topics related to that word. Select the topic and click "Display".

The Search tab allows you to enter a keyword and display all of the topics in the online help that contain the keyword you have entered. Type a keyword in the Type in the word(s) to search for box and click "List Topics". Select the topic from the list and click "Display".

The Favorites tab allows you to keep topics that you revisit often in a separate folder. To add a topic to your favorites, click "Add" on the Favorites tab.
What’s This? help

What’s This? help allows you to view pop-up window descriptions for ACID menus, buttons, and dialog boxes. Choose What’s This? from the Help menu, press Shift + F1, or click the What’s This? help button ( ) on the toolbar and then click any ACID item. To use What’s This? help in a dialog box, click the question mark help button ( ) in the upper-right corner of the dialog box and then click an item in the dialog box.

Help on the Web

Additional ACID help and information is available on the Sonic Foundry Web site. Choose Sonic Foundry on the Web from the Help menu to view a listing of Web pages pertaining to ACID and Sonic Foundry. If your browser is not already open, ACID will automatically start it for you.

Overview of ACID

ACID is designed to be a powerful and flexible, but easy-to-use music creation application. Many of the ACID operations, menu items, and shortcut keys are common to other Sonic Foundry applications.

The following sections provide a tour of the ACID work area.

Main interface

The work area includes three main areas: the track list, the track view (or timeline), and the window docking area. The other parts of the interface are tools and features used while creating and working with your project. You can resize the track list, track view, and window docking area by dragging the dividers between them.
The toolbar allows you to quickly access the most commonly used functions and features in ACID.

1. **Opens a new project. You will be prompted to save any changes to the current project.**
2. **Displays the Open File dialog. From this window, you can browse all of the available drives to select an ACID project or audio file to open.**
3. **Saves any changes to the current project. The first time you save a project, the Save As dialog appears.**
4. **Opens the Publish wizard so you can share your ACID creation on the Web.**
5. **Clears the selected items from the track view and places them on the ACID clipboard. You can then paste them to a new location.**
6. **Creates a copy of the selected items from the track view on the ACID clipboard. You can then paste them to a new location.**
7. **Inserts the contents of the ACID clipboard at the current cursor position. The pasted items cover any existing events. To make room for pasted events, choose Paste Insert from the Edit menu.**
8. **Reverses the last action performed. ACID supports unlimited undos, allowing you to restore the project to any state since the last save.**
9. **Reverses an undo.**
10. **Turns the snapping feature on or off. With snapping enabled, you can decide whether to snap to the grid or to all elements (markers, regions, etc.).**
11. **Locks envelope points so they move with an event when it is moved along the timeline.**
12. **Activates the Draw tool to add and edit events.**
13. **Activates the Selection tool to select multiple events.**
14. **Activates the Paint tool to insert events across multiple tracks. When used in conjunction with the Ctrl key, the Paint tool can paint an entire one-shot, MIDI, or Beatmapped media file to an event with one click.**
15. **Activates the Erase tool to erase events or parts of events. When used in conjunction with the Ctrl key, the Erase tool can erase an entire one-shot, MIDI track, or Beatmapped track event with one click.**
16. **Activates the Envelope tool to select and modify envelope points.**
17. **Activates the Time Selection tool to quickly select all events within range of time.**
18. **Opens a dialog where you can download media from the Internet.**
19. **Opens a frequently updated Web page containing special offers, tips, tricks, and other good stuff.**
20. **Activates What’sThis? help to obtain information about a specific option, menu, or part of the ACID window.**
Track list

This list identifies the track order in your project and contains the track’s controls. The following sections identify and briefly explain the controls located in the track list.

View buttons
These buttons control the track’s appearance (size) on the track list and the track view.

Track number and type
This area identifies the type of file (loop, one-shot, MIDI, Beatmapped) contained in the track as well as the track’s number in the project. You can quickly change the track order by dragging selected tracks within the track list.

Track type icons
- Loop
- One-shot
- Beatmapped
- MIDI

Track name
When you add a file to a project, the track name is initially the same name as the file's name. Right-click the track name and choose Rename from the shortcut menu (or double-click) to change the track name.

Bus assignment
Clicking the Bus Assignment button ( ) and selecting a letter from the menu allows you to assign the corresponding track to the specified output bus. However, the button is only available in projects containing multiple busses. For more information, see Adding busses to the project on page 111.

On a MIDI track, the Device Selection button ( ) appears instead of the Bus Assignment button. This button allows you to route a MIDI track to a soft synth or MIDI device. For more information, see Routing MIDI tracks to MIDI devices or soft synth controls on page 149.

Track FX button
The Track FX button ( ) accesses the Audio Plug-In window from which you can add, edit, and apply effects to the track. The button image changes ( ) to indicate when an automatable effect is present. For more information, see Using track effects on page 93.
**Mute button**

Clicking the Mute button ( ) temporarily suspends playback of the corresponding track, allowing you to focus on the project’s remaining tracks. A muted track appears grayed out in the track view. *For more information, see Muting tracks on page 47.*

**Solo button**

Clicking the Solo button ( ) isolates the track during playback by muting the project’s remaining tracks. *For more information, see Soloing tracks on page 48.*

**Surround panner**

In 5.1 surround projects, the surround panner allows you to view and edit surround panning settings for a track. Double-click a surround panner to view the Surround Panner window and make fine panning adjustments. *For more information, see Working with 5.1 Surround on page 157.*

**Multipurpose slider**

This multipurpose slider allows you to control the following:

- A track’s volume relative to the project’s other tracks.
- A track’s placement in the stereo spectrum (panning).
- The level of the track’s signal being routed to each of the project’s busses.
- The level of the track’s signal being routed to an assignable effect control.

The multipurpose slider defaults to displaying a track’s volume control. ACID tracks are preset to -6.0 decibels (dB), but the volume range is -inf. to 12 dB. Each track’s slider position is independent from the others; however, you can move sliders simultaneously by selecting multiple tracks before making your adjustment. If you do not see this slider, expand the track.

You may choose what the slider controls by clicking the slider label. Changing the slider type for one track changes it for all tracks so you can compare levels of the same control across the project. *For more information, see Adjusting the mix on page 46.*

**Track view**

In the track view, you can view and edit the events in a track. The area in which events display is the timeline. The track view contains other elements which are described in the following sections.
**Marker bar**

The marker bar runs the length of your project and contains the tags for markers and regions positioned along the project’s timeline.

**Beat ruler**

The beat ruler allows you to place events in reference to the musical time of bars and beats. This ruler is fixed and does not update when you change the tempo. This allows the events in the tracks to maintain their size when you adjust the tempo.

**Time ruler**

The time ruler provides a timeline for your project. This ruler can show real time in many different formats. For more information, see Changing the time ruler format on page 173. The ruler changes with tempo, since the number of beats and beats per second of real time changes with tempo.

**Transport bar**

The transport bar contains the playback and cursor positioning buttons frequently used while working on your project.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Record new track" /></td>
<td>Record new track</td>
</tr>
<tr>
<td><img src="image" alt="Loop playback" /></td>
<td>Loop playback</td>
</tr>
<tr>
<td><img src="image" alt="Play from beginning of project" /></td>
<td>Play from beginning of project</td>
</tr>
<tr>
<td><img src="image" alt="Play project from cursor position" /></td>
<td>Play project from cursor position</td>
</tr>
<tr>
<td><img src="image" alt="Pause/resume project playback" /></td>
<td>Pause/resume project playback</td>
</tr>
<tr>
<td><img src="image" alt="Stop playback" /></td>
<td>Stop playback</td>
</tr>
<tr>
<td><img src="image" alt="Move cursor to start of project" /></td>
<td>Move cursor to start of project</td>
</tr>
<tr>
<td><img src="image" alt="Move cursor to end of project" /></td>
<td>Move cursor to end of project</td>
</tr>
</tbody>
</table>

ACID also includes keyboard shortcuts for these playback commands. For more information, see Playback commands on page 19.

**Zoom controls**

To the right of the horizontal scroll bar are the time zoom controls. Clicking the **Zoom In Time** button ( ) increases the horizontal magnification of the project. To decrease the level of magnification, click the **Zoom Out Time** button ( ).

Directly below the vertical scroll bar are the dedicated track height zoom controls. Clicking the **Zoom In Track Height** button ( ) increases the vertical magnification of the project. To decrease the level of magnification, click the **Zoom Out Track Height** button ( ).

**Note:** Double-clicking the horizontal or vertical scroll bars adjusts the magnification so that as much of the project (either horizontally or vertically) is displayed as possible.

Click the **Zoom Tool** button ( ) in the corner of the track view to temporarily change the cursor into the **Zoom tool.** After you select an area of the track view to magnify, the cursor reverts to the previously active tool.

**Note:** Double-clicking the Zoom tool adjusts both the horizontal and vertical magnification so that as much of the project is displayed as possible.
Window docking area

This area allows you to keep frequently-used windows available while working on a project. Windows can be docked side by side or in stacks in the windows docking area. For more information, see Docking and floating ACID windows on page 172.

Two windows display in the window docking area when you start ACID for the first time: the Explorer and the Mixer. The Chopper™, Video, Audio Plug-In, Track Properties, Surround Panner, and Soft Synth Properties windows can be docked or undocked after they are displayed by choosing the desired window from the **View** menu.

**Tip:** You can quickly hide or show the window docking area by pressing [F11].

Explorer window

The Explorer window works similarly to the Windows Explorer. You can use the Explorer window to locate, preview and select media files to be added to your project. You can also use the Explorer window to perform common file management tasks, such as renaming files or creating folders.

Mixer

The Mixer window provides access to output levels, as well as advanced features such as busses, assignable effect chains, and soft synth controls. For more information, see Using the Mixer window on page 50.

Chopper

The Chopper isolates audio events so that you can dissect them and reinsert them into a project to produce elaborate slice-n-dice effects with minimal effort. Display the Chopper by choosing **Chopper** from the **View** menu or pressing [Alt]+[2]. For more information, see Using the Chopper on page 85.

Video

This window displays prerendered video files that can be imported and synchronized with an ACID project. The video file displays during project playback and can be rendered with the project to an appropriate format. Display the Video window by choosing **Video** from the **View** menu or pressing [Alt]+[4]. For more information, see Using the Video window on page 155.

Audio Plug-In

This window displays plug-ins and settings for track, assignable, bus, and soft synth effects chains. Display the Audio Plug-In window by clicking any FX button ( ) or by pressing [Alt]+[5]. For more information, see Using track effects on page 93 and Adding effects to mixer controls on page 121.

Track Properties

This window allows you to change track attributes and edit MIDI tracks using OPT plug-ins. Display the Track Properties window by double-clicking a track's icon or by pressing [Alt]+[6]. For more information, see Configuring track properties on page 105 and Working with MIDI on page 131.

Surround Panner

This window allows you to control panning in a 5.1 surround project. Display the Surround Panner window by double-clicking the surround panner on a track or mixer control or by pressing [Alt]+[7]. For more information, see Working with 5.1 Surround on page 157.
Soft Synth Properties

This window allows you to change the attributes of soft synth controls in the Mixer window. Display the Soft Synth Properties window by double-clicking a soft synth control’s icon or by pressing \[\text{Alt} + \text{B}]. For more information, see Using soft synth controls on page 115.

Keyboard command reference

The ACID keyboard commands are shortcuts that you can use while working on your project.

### Project file commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create new project</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Create new project and bypass the Project Properties dialog</td>
<td>Ctrl+Shift+N</td>
</tr>
<tr>
<td>Open existing project or media file</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save project</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Close current project</td>
<td>Ctrl+F4</td>
</tr>
</tbody>
</table>

### Window view commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set focus to track view</td>
<td>Alt+0</td>
</tr>
<tr>
<td>View the Explorer window</td>
<td>Alt+1</td>
</tr>
<tr>
<td>View the Chopper window</td>
<td>Alt+2</td>
</tr>
<tr>
<td>View the Mixer window</td>
<td>Alt+3</td>
</tr>
<tr>
<td>View the Video window</td>
<td>Alt+4</td>
</tr>
<tr>
<td>View the Audio Plug-In window</td>
<td>Alt+5</td>
</tr>
<tr>
<td>View the Track Properties window</td>
<td>Alt+6</td>
</tr>
<tr>
<td>View the Surround Panner window</td>
<td>Alt+7</td>
</tr>
<tr>
<td>View the Soft Synth Properties window</td>
<td>Alt+8</td>
</tr>
<tr>
<td>Shift focus forward through open ACID windows</td>
<td>F6</td>
</tr>
<tr>
<td>Shift focus backward through open ACID windows</td>
<td>Shift+F6</td>
</tr>
<tr>
<td>Shift focus forward (clockwise) through track list, track view, bus track view, and bus track list</td>
<td>Tab</td>
</tr>
<tr>
<td>Shift focus backward (counterclockwise) through track list, bus track list, bus track view, and track view</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Show/hide bus tracks</td>
<td>U</td>
</tr>
<tr>
<td>Show/hide window docking area</td>
<td>F11</td>
</tr>
<tr>
<td>Show/hide track list</td>
<td>Shift+F11</td>
</tr>
<tr>
<td>Show/hide track list and window docking area</td>
<td>Ctrl+F11</td>
</tr>
</tbody>
</table>

### Playback commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start/stop playback</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Stop playback</td>
<td>Esc</td>
</tr>
<tr>
<td>Toggle looped playback on/off</td>
<td>Q</td>
</tr>
<tr>
<td>Play from start</td>
<td>Shift+Spacebar (when working in the track view)</td>
</tr>
<tr>
<td></td>
<td>Shift+F12 (from any window)</td>
</tr>
<tr>
<td>Play from cursor</td>
<td>Ctrl+Spacebar (when working in the track view)</td>
</tr>
<tr>
<td></td>
<td>F12 (from any window)</td>
</tr>
<tr>
<td>Pause/resume playback</td>
<td>Enter (when working in the track view)</td>
</tr>
<tr>
<td></td>
<td>Ctrl+F12 (from any window)</td>
</tr>
<tr>
<td>Record</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Go to start</td>
<td>Ctrl+Home or W</td>
</tr>
<tr>
<td>Go to end</td>
<td>Ctrl+End</td>
</tr>
<tr>
<td>Skip backward</td>
<td>Page Up</td>
</tr>
<tr>
<td>Skip forward</td>
<td>Page Down</td>
</tr>
<tr>
<td>Reset all MIDI ports (panic button)</td>
<td>Ctrl+Alt+F7</td>
</tr>
</tbody>
</table>
## Cursor placement commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to beginning of active loop region or view (if no selection)</td>
<td>Home</td>
</tr>
<tr>
<td>Go to end of active loop region or view (if no selection)</td>
<td>End</td>
</tr>
<tr>
<td>Go to beginning of project</td>
<td>Ctrl+Home or W</td>
</tr>
<tr>
<td>Go to end of project</td>
<td>Ctrl+End</td>
</tr>
<tr>
<td>Move left by grid marks</td>
<td>Page Up</td>
</tr>
<tr>
<td>Move right by grid marks</td>
<td>Page Down</td>
</tr>
<tr>
<td>Go to (using measures, beats, and ticks)</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Go to (using absolute time)</td>
<td>Shift+G</td>
</tr>
<tr>
<td>Move cursor to corresponding marker or region</td>
<td>Number keys (not on numeric keypad)</td>
</tr>
</tbody>
</table>

## Loop region commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make a loop region</td>
<td>Shift+Left or Right Arrow</td>
</tr>
<tr>
<td>Extend loop region left by grid marks</td>
<td>Shift+Page Up</td>
</tr>
<tr>
<td>Extend loop region right by grid marks</td>
<td>Shift+Page Down</td>
</tr>
<tr>
<td>Expand loop region one pixel</td>
<td>Shift+Left or Right Arrow</td>
</tr>
<tr>
<td>Make a loop region during playback</td>
<td>I (in) and O (out)</td>
</tr>
<tr>
<td>Restore past loop regions (up to last five)</td>
<td>Backspace</td>
</tr>
<tr>
<td>Select loop region</td>
<td>Shift+Q (when Time Selection tool is selected)</td>
</tr>
</tbody>
</table>

## Selection commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range selection (events)</td>
<td>Shift+click range of events</td>
</tr>
<tr>
<td>Multiple selection (events)</td>
<td>Ctrl+click individual events</td>
</tr>
<tr>
<td>Select loop region</td>
<td>Shift+Q (when Time Selection tool is selected)</td>
</tr>
</tbody>
</table>

## Event commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paint the entire media file as an event for one-shot, Beatmapped, and MIDI tracks</td>
<td>Ctrl+click (on track with Paint tool enabled)</td>
</tr>
<tr>
<td>Erase entire event for one-shot, Beatmapped, and MIDI tracks</td>
<td>Ctrl+click (on event with Erase tool enabled)</td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Shift+Z</td>
</tr>
<tr>
<td>Cut selection</td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy selection</td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste from clipboard</td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Paste repeat</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Paste insert</td>
<td>Ctrl+Shift+V</td>
</tr>
</tbody>
</table>

## Description | Keys |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Center in view</td>
<td>\</td>
</tr>
<tr>
<td>Move cursor to opposite end of time selection or loop bar</td>
<td>Numeric keypad 5</td>
</tr>
<tr>
<td>Move left to marker(s)</td>
<td>Ctrl+Left Arrow</td>
</tr>
<tr>
<td>Move right to marker(s)</td>
<td>Ctrl+Right Arrow</td>
</tr>
<tr>
<td>Move left to event edit points including fade edges</td>
<td>Ctrl+Alt+Left Arrow</td>
</tr>
<tr>
<td>Move right to event edit points including fade edges</td>
<td>Ctrl+Alt+Right Arrow</td>
</tr>
<tr>
<td>Move by one pixel</td>
<td>Left or Right Arrow</td>
</tr>
<tr>
<td>Move through a video event one frame at a time</td>
<td>Alt+Left or Right Arrow</td>
</tr>
</tbody>
</table>
### Track view commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete selection</td>
<td>Delete</td>
</tr>
<tr>
<td>Move selected event(s) right one pixel</td>
<td>Numeric keypad 6</td>
</tr>
<tr>
<td>Move selected event(s) left one pixel</td>
<td>Numeric keypad 4</td>
</tr>
<tr>
<td>Split event(s)</td>
<td>S</td>
</tr>
<tr>
<td>Join events</td>
<td>J</td>
</tr>
<tr>
<td>Create fades</td>
<td>F</td>
</tr>
<tr>
<td>Render to new track</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Trim/crop time-selected events only</td>
<td>Ctrl+T</td>
</tr>
</tbody>
</table>

### Track list commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solo track</td>
<td>X</td>
</tr>
<tr>
<td>Mute track</td>
<td>Z</td>
</tr>
<tr>
<td>Delete track</td>
<td>Delete</td>
</tr>
<tr>
<td>Pitch down one semitone</td>
<td>Numeric keypad -</td>
</tr>
<tr>
<td>Pitch up one semitone</td>
<td>Numeric keypad +</td>
</tr>
<tr>
<td>Pitch down four semitones (Windows 2000 and XP only)</td>
<td>Shift+Numeric keypad -</td>
</tr>
<tr>
<td>Pitch up four semitones (Windows 2000 and XP only)</td>
<td>Shift+Numeric keypad +</td>
</tr>
<tr>
<td>Pitch down one octave</td>
<td>Ctrl+Numeric keypad -</td>
</tr>
<tr>
<td>Pitch up one octave</td>
<td>Ctrl+Numeric keypad +</td>
</tr>
<tr>
<td>Reset pitch (Windows 2000 and XP only)</td>
<td>Ctrl+Shift+Numeric keypad +/-</td>
</tr>
</tbody>
</table>

### Track view commands

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>Turn on/off ripple edit mode</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Select Draw tool</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Select next edit tool in list</td>
<td>D</td>
</tr>
<tr>
<td>Select previous edit tool in list</td>
<td>Shift+D</td>
</tr>
<tr>
<td>Mark in point for selection</td>
<td>[ or [</td>
</tr>
<tr>
<td>Mark out point for selection</td>
<td>] or ]</td>
</tr>
<tr>
<td>Show/hide track panning envelope</td>
<td>P</td>
</tr>
<tr>
<td>Insert/remove track panning envelope</td>
<td>Shift+P</td>
</tr>
<tr>
<td>Show/hide track volume envelope</td>
<td>V</td>
</tr>
<tr>
<td>Insert/remove track volume envelope</td>
<td>Shift+V</td>
</tr>
<tr>
<td>Toggle through display of track effect automation envelopes</td>
<td>E</td>
</tr>
<tr>
<td>Adjust envelope point value in fine increments without changing the envelope point’s timeline position</td>
<td>Ctrl+drag envelope point or segment</td>
</tr>
<tr>
<td>Adjust envelope point value in normal increments without changing the envelope point’s timeline position</td>
<td>Ctrl+Alt+drag envelope point or segment</td>
</tr>
<tr>
<td>Move envelope point’s timeline position without changing its value</td>
<td>Alt+drag envelope point</td>
</tr>
</tbody>
</table>
**View commands**

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom time in/out small increments when track view has focus or zoom to loop region (if one exists)</td>
<td>Up or Down Arrow</td>
</tr>
<tr>
<td>Zoom time in/out large increments when track view has focus</td>
<td>Ctrl+Up or Down Arrow</td>
</tr>
</tbody>
</table>

**Mixer commands**

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change selection of a mixer control</td>
<td>Left/Right Arrow</td>
</tr>
<tr>
<td>Select multiple, adjacent mixer controls</td>
<td>Shift+Left/Right Arrow</td>
</tr>
<tr>
<td>Select multiple nonadjacent mixer controls</td>
<td>Ctrl+Left/Right Arrow</td>
</tr>
<tr>
<td>Move the fader of the selected mixer control (for assignable effect controls, moves the Out fader)</td>
<td>Up/Down Arrow</td>
</tr>
</tbody>
</table>

**MIDI commands**

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate MIDI Timecode</td>
<td>F7</td>
</tr>
<tr>
<td>Trigger from MIDI Timecode</td>
<td>Ctrl+F7</td>
</tr>
<tr>
<td>Generate MIDI Clock</td>
<td>Shift+F7</td>
</tr>
<tr>
<td>Enable real-time MIDI</td>
<td>Alt+F7</td>
</tr>
<tr>
<td>Reset all MIDI ports (panic button)</td>
<td>Ctrl+Alt+F7</td>
</tr>
</tbody>
</table>

**Chopper commands**

For more information, see *Using Chopper toolbar and keyboard commands* on page 86.

**Surround Panner commands**

For more information, see *Moving the pan point* on page 164.

**Miscellaneous commands**

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Online help</td>
<td>F1</td>
</tr>
<tr>
<td>What'sThis? help</td>
<td>Shift+F1</td>
</tr>
<tr>
<td>Shortcut menu</td>
<td>Shift+F10</td>
</tr>
<tr>
<td>Refresh screen</td>
<td>F5</td>
</tr>
</tbody>
</table>
## Mouse scroll-wheel shortcuts

<table>
<thead>
<tr>
<th>Description</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in on timeline</td>
<td>Default mouse wheel behavior</td>
</tr>
<tr>
<td>Horizontal scroll</td>
<td>Shift+wheel</td>
</tr>
<tr>
<td>Vertical scroll</td>
<td>Ctrl+wheel</td>
</tr>
<tr>
<td>Move by video frames</td>
<td>Ctrl+Shift+Alt+wheel</td>
</tr>
<tr>
<td>Move the cursor in grid increments</td>
<td>Ctrl+Shift+wheel</td>
</tr>
<tr>
<td>Auto-scrolling</td>
<td>Press mouse wheel and move the mouse in the desired direction</td>
</tr>
<tr>
<td>Move fader</td>
<td>Wheel over a fader</td>
</tr>
<tr>
<td>Make fine fader adjustments</td>
<td>Ctrl+wheel over a fader</td>
</tr>
<tr>
<td>Move pan point front/back in Surround Panner window</td>
<td>Default mouse wheel behavior (when pan point is selected)</td>
</tr>
<tr>
<td>Move pan point left/right in Surround Panner window</td>
<td>Shift+wheel (when pan point is selected)</td>
</tr>
</tbody>
</table>
Audio signal flow

Audio event

Event envelope

Assignable FX
pre/post volume

Assignable FX send

Assignable FX

Input

Chain

Output

Mute

(Pan)

Bus pre/post volume

Bus send

Bus pre/post volume

Bus assignment

Bus assignment

Bus Control

Master Bus Control

Hardware output

Hardware output
Notes on audio signal flow

* This diagram describes non-MIDI audio events. For MIDI events, see MIDI signal flow on page 26.

† In 5.1 surround projects, tracks routed to the Surround Master bus send surround panning (six-channel) information. Tracks routed to busses (e.g., Bus A) send stereo panning (two-channel) information.

‡ Assignable effect chain panning is available only in 5.1 surround projects. In 5.1 surround projects, assignable effect chains routed to the Surround Master bus send surround panning (six-channel) information. Assignable effect chains routed to busses (e.g., Bus A) send stereo panning (two-channel) information.

^ Bus panning is available only in 5.1 surround projects. In 5.1 surround projects, busses routed to the Surround Master bus send surround panning (six-channel) information. Busses routed to hardware send stereo panning (two-channel) information.
MIDI signal flow

MIDI event → Track volume → Mute track → Device or soft synth assignment → DLS or VSTi assignment → External MIDI device

MIDI

DLS voice set → VST instrument → Audio

Soft Synth Control

Mute → FX → Volume → (Pan)*

Bus Control

Mute → FX → Volume → (Pan)^

Master Bus Control

Mute → FX → Volume

Hardware output
Notes on MIDI signal flow

* Soft synth panning is available only in 5.1 surround projects. In 5.1 surround projects, soft synth controls routed to the Surround Master bus send surround panning (six-channel) information. Soft synth controls routed to busses (e.g., Bus A) send stereo panning (two-channel) information.

^ Bus panning is available only in 5.1 surround projects. In 5.1 surround projects, busses routed to the Surround Master bus send surround panning (six-channel) information. Busses routed to hardware send stereo panning (two-channel) information.
What’s New?

This chapter is intended for experienced ACID users. It simply addresses the question on everyone’s mind: “What’s new in this version of ACID?”

Mixing

Plug-in effects automation

In ACID 4.0, you can automate the parameters of plug-ins, provided that the plug-ins support automation. Effect automation relies on track envelopes, a tool you may already be familiar with from creating volume, pan, bus send, or assignable effect send envelopes.

You can choose which parameters of a given effect to automate and then add points to a track envelope for the different parameter settings. By viewing bus tracks, you can automate effects not only for tracks, but for busses, assignable effects, and soft synth controls. For more information, see Bus tracks on page 30.

ACID 4.0 includes new Sonic Foundry automatable effects such as Flange/Wah-wah, Resonant Filter, and Track EQ.

For more information, see Adding effect automation envelopes on page 98.

5.1 surround mixing and surround pan automation

ACID 4.0 introduces 5.1 surround mixing capability and surround panning automation. In a surround project, you pan tracks or busses using the Surround Panner window. For even greater control, you can add keyframes to automate panning changes over time.

Note: ACID mixes 5.1-channel audio only. Authoring software such as the Sonic Foundry 5.1 Surround Plug-In Pack is required to encode final output in AC-3™ format.

For more information, see Working with 5.1 Surround on page 157.

Alternate time signatures

ACID 4.0 breaks free from the 4/4 model and allows you to see (and snap to) measures of any time signature from 1/1 to 99/32. You can choose a custom time signature for the project, as well as change time signatures along the timeline by adding time signature change markers. For more information, see Changing tempo, time signature, and key on page 79.
ASIO driver support

In addition to supporting Microsoft Mapper, Windows Classic Wave, and WDM drivers, ACID 4.0 now supports ASIO™ drivers. With its more direct data delivery to the sound card, the ASIO driver model provides professional users with faster audible responses. You can choose which driver model ACID uses on the Audio tab in the Preferences dialog. For more information, see Using the Audio tab on page 181.

Loop Cloning in the Chopper

ACID 4.0 provides the option to create new loops using the Chopper. Simply open a track in the Chopper, make a selection for the new loop, and drag the selection to the track list. ACID saves the selection as a new file and adds it to the project as a new track. For more information, see Saving Chopper selections as new files on page 90.

Bus tracks

You can now view any mixer control (bus, assignable effect, or soft synth) on a track at the bottom of the track view. This allows you to add envelopes to any of these controls. Want to pan several tracks as a group? Route the tracks to a bus and pan the bus using a pan envelope on the bus track. Want your assignable effect parameters to change over time? Add an effect automation envelope to the bus track for the assignable effect. For more information, see Automating mixer controls in track view on page 125.

Enhanced time stretching for Beatmapped tracks

In ACID 4.0, you can time-stretch a Beatmapped track with less stuttering and improved playback.

New audio panning types

Whether you’re using standard stereo panning or 5.1 surround panning, you can choose from among five types of panning for ACID tracks and busses. For more information, see Choosing stereo pan types on page 103.

New envelope fade types

ACID 4.0 provides three new fade types: smooth, sharp, and hold. Fade types determine the interpolation between two envelope points. For more information, see Changing envelope fade curves on page 100.

ReWire support

ACID is now a ReWire mixer (host) application. For more information, see Using soft synth controls on page 115.

MIDI

MIDI piano roll editing

ACID 4.0 introduces a piano roll editor that you can use to create, edit, and quantize MIDI data. The piano roll editor is one of two OPT (Open Plug-in Technology) plug-ins included in ACID 4.0. For more information, see Using the piano roll editor on page 134.

MIDI step recording

The new list editor OPT plug-in allows you to step record MIDI from within ACID. For more information, see Step recording events on page 145.
MIDI event list editing

ACID 4.0 includes a list editor OPT plug-in that gives you direct access to all MIDI data for a track. You can use the list editor to add, edit, quantize, and delete MIDI events or to step record new MIDI material. For more information, see Using the list editor on page 140.

VSTi support

You can route MIDI tracks in an ACID 4.0 project to a VST® instrument (VSTi) using the new soft synth controls in the Mixer window. For more information, see Using soft synth controls on page 115.

Yamaha OPT support

ACID 4.0 is an early adopter for Yamaha’s new Open Plug-in Technology (OPT) specification. You can choose any OPT plug-in (including a piano roll editor and a list editor included with ACID) to edit a MIDI track. This expands ACID’s MIDI capabilities to allow plug-ins for MIDI edit views, MIDI effect processors and filters, arpeggiators, and real-time panel automation. For more information, see Working with MIDI on page 131.

Optimized DLS and VSTi soft synth controls

With this release, you can route MIDI tracks to a soft synth control in the Mixer window. The soft synth control acts as a sound module, allowing you to choose a DLS set or VST instrument to which you can route MIDI tracks or external MIDI input devices. For more information, see Using soft synth controls on page 115.

Workspace

Multiple media file previewing and Explorer enhancements

The Explorer allows you to select multiple files and preview them in sequence. For more information, see Previewing multiple media files on page 35.

You can also rename media files from within the Explorer window. Simply right-click a file, choose Rename from the shortcut menu, and enter a new name for the file.

Hotkey commands for track muting and soloing

Press X to solo or Z to mute selected tracks or busses in your ACID 4.0 project.

Optimized ACID playback

The new ACID audio engine is designed to take advantage of the latest processing power, allowing you to enjoy significant performance increases during playback.

Autosave crash recovery

ACID automatically saves your work for you so that you can recover your work if your system crashes. For more information, see Using the General tab on page 179.

Customizable default track properties

You can choose the default volume, pan type, height, track effects, and MIDI editors for all new tracks you create in ACID. For more information, see Setting default track properties on page 178.
Video

Windows Media Audio and Video import

You can now add Windows Media Audio (WMA) and Windows Media Video (WMV) files to an ACID project.

Enhanced video handling

ACID 4.0 provides two new options for rendering projects containing video: Stretch video to fill output frame (do not letterbox) and Fast video resizing. For more information, see Rendering projects on page 54.

In addition, the Video window now provides an option to display square pixels to compensate for any spatial distortions due to non-square pixel aspect ratios. For more information, see Using the Video window on page 155.
Now that you have an understanding of ACID's interface and controls, you are ready to begin learning the techniques needed to pick, paint, and play ACID projects. In this chapter you will learn the skills that will allow you to create music in ACID, from locating media files to writing the finished project to CD.

Starting projects

Double-clicking the ACID icon on the desktop starts ACID. You can immediately begin building your ACID project using the application's default project properties. However, you may prefer to customize the project properties prior to beginning the project.

Setting project properties

ACID allows you to configure project properties and add summary information prior to beginning a project. Choosing New from the File menu displays the New Project dialog. This dialog contains two tabs: Summary and Audio. Selecting the Start all new projects with these settings check box configures ACID to use the parameters and information in both tabs as defaults when starting all subsequent projects.

Note: You can edit project audio properties and summary information at any time. Choose Properties from the File menu to display the Project Properties dialog, which contains the identical tabs and parameters as the New Project dialog.

Using the Summary tab

This tab allows you to enter information about the project. These boxes may be left blank or if information exists, you may change it at any time.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Enter the name or title of the project.</td>
</tr>
<tr>
<td>Artist</td>
<td>Enter the name of the narrator, band, or artist(s) being recorded into the project.</td>
</tr>
<tr>
<td>Engineer</td>
<td>Enter the name(s) of the people who mixed and edited the project.</td>
</tr>
<tr>
<td>Copyright</td>
<td>Enter the date and ownership rights of the project.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enter information that identifies and describes the project.</td>
</tr>
<tr>
<td>Start all new projects with these settings</td>
<td>Select this check box if your projects' requirements do not change or you want consistent settings for future projects.</td>
</tr>
</tbody>
</table>
Using the Audio tab

This tab allows you to set different characteristics the project uses to handle the audio.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master bus mode</td>
<td>Choose either Stereo for a standard audio project or 5.1 Surround for a surround project.</td>
</tr>
<tr>
<td>Number of additional stereo busses</td>
<td>Enter the number of stereo busses that you want in your project. You may add up to 26 busses. The busses appear in the Mixer window. For more information, see Using busses on page 111.</td>
</tr>
<tr>
<td>Sample rate</td>
<td>Choose a sample rate from the drop-down list or enter your own rate. The sample rate range is 2,000 Hz to 192,000 Hz. Higher sample rates result in better quality sound, but also mean larger audio files.</td>
</tr>
<tr>
<td>Bit depth</td>
<td>Choose a bit depth from the drop-down list. A higher bit depth results in better quality sound, but also means larger audio files.</td>
</tr>
<tr>
<td>Enable low-pass filter on LFE</td>
<td>Select this check box to limit the audio sent to the LFE channel in a 5.1 surround project. For more information, see Working with 5.1 Surround on page 157.</td>
</tr>
<tr>
<td>Cutoff frequency for low-pass filter</td>
<td>Enter a low-pass cutoff frequency value for 5.1 surround projects. ACID limits audio sent to the LFE channel to frequencies lower than the value you enter. Applying a low-pass filter approximates the bass-management system in a 5.1 decoder and ensures that you're sending only low-frequency audio to the LFE channel.</td>
</tr>
<tr>
<td>Low-pass filter quality</td>
<td>Choose a setting from the drop-down list to determine the sharpness of the low-pass filter's rolloff curve. Best produces the sharpest curve.</td>
</tr>
<tr>
<td>Start all new projects with these settings</td>
<td>Select this check box if your project requirements do not change or you want consistent settings for future projects.</td>
</tr>
</tbody>
</table>

Opening existing projects

1. From the File menu, choose Open. The Open dialog appears.
2. Choose a drive and folder from the Look in drop-down list.
3. Select a file in the browse window or type a name in the File name box. Detailed information about the selected file appears at the bottom of the dialog box.
4. Choose a file type from the Files of type drop-down list to limit the files displayed in the dialog box.
5. Click Open.

Note: If ACID is unable to locate one of the media files when you open an ACID project, you can choose to leave the media offline and continue to edit events on the track. The events point to the location of the source media file. If you restore the source media file at a later time, the project opens normally.

Opening ACID projects with embedded media

When you open an .acd-zip project, the project file and all media files are copied to the temporary files folder.

Note: You can customize the location of the temporary files folder. For more information, see Using the General tab on page 179.

Any changes you make to the project are saved to the files in this temporary folder until you save the .acd-zip file again. For more information, see Saving projects on page 53.
Getting media files

Now that you’ve created a new project or opened an existing project, the next step is to add media to the project. You can use the Explorer window to locate, preview and add media to your project. You can also extract audio from a CD or download media from the Web.

Previewing media from the Explorer window

The Explorer window allows you to preview files in looped playback at the current project tempo before adding them to your project. You can also preview files in the Explorer in conjunction with playing your project, thereby allowing you to preview how a file will sound in the project.

To preview files, use the Start Preview ( ), Stop Preview ( ), and Auto Preview ( ) buttons at the top of the Explorer window.

Previewing a media file

1. Select the media file in the Explorer window that you want to preview.
2. Click the Start Preview button ( ). The media file begins looped playback. You can monitor its levels on the preview bus.
3. Click the Stop Preview button ( ) to end playback.

Previewing multiple media files

You can use the Explorer’s multiple-selection preview feature to preview a group of files in the order that you select them.

1. From the Options menu, choose Preferences, and on the Other tab of the Preferences dialog, select the Enable multiple-selection preview in Explorer window check box.
   If you want, you can enter values in the Number of times to repeat each Loop box, Seconds of each One-Shot to play box, and Number of Beatmapped measures to play box to specify how ACID previews different file types.
2. Click OK to close the Preferences dialog.
3. In the Explorer, select the media you want to preview. Hold Shift while clicking to select multiple, adjacent files or hold Ctrl while clicking to select multiple, nonadjacent files.
4. Click the Start Preview button ( ). ACID previews the first selected file in the list and continues through the list of selected files. ACID changes a file’s icon to a Play icon ( ) to indicate which file is currently previewing.

   Note: To add the currently previewing file to your project, press Ctrl + Enter. Press Enter to add all selected files to your project.

Using Auto Preview

The Auto Preview button ( ) sets ACID to automatically play back media files when you select them in the Explorer. If your project is currently playing when you select a new file, the new file plays back along with your project. This feature allows you to listen to the media file in the context of your project.

Click the Auto Preview button ( ) to toggle auto preview on or off.
Adding media to the project

You must add media files to a project before you can paint, arrange, and process them. When you add a file to a project, ACID creates a new track to accommodate it. ACID adds new tracks at the current volume of the Preview fader in the Mixer window, unless you have set a default track volume level. For more information, see Setting default track properties on page 178.

There are several methods of adding media files to a project.

**Note:** ACID may create proxy files for media whose compression scheme may cause working with them to be inefficient and slow. For more information, see Proxy File on page 201.

**Note:** Before using long Beatmapped or long one-shot files from CDs or shared network folders, copy the media to your local drive for the best possible performance.

ACID temporary files

When you add a media file to a project from a removable device, ACID stores a copy of the media file in the temporary files folder. This keeps the media file available for use even if the source of the media is no longer accessible.

**Note:** You can customize the location of the temporary files folder. For more information, see Using the General tab on page 179.

Be aware that the temporary files folder is cleared when you close ACID. However, files are not cleared from the folder if ACID closes inappropriately.

**Adding media files from the Explorer window**

The Explorer window will likely be your primary means of locating media files used in projects. Display the Explorer, if needed, by choosing Explorer from the View menu, or by pressing Alt + 1.

There are three ways to add media files from the Explorer window:

- Double-click the desired file.
- Drag the file from the Explorer to the track view or track list. Dragging a file from the Explorer to the track name of an existing track allows you to replace the original file with the new file, while all events remain in place.
- Right-click and drag a file to the track view or track list to specify the type of track to be created. When you drop the file, a shortcut menu appears that allows you to choose whether to treat the file as a loop, one-shot, Beatmapped track, or as an autodetected type.

**Adding media files from the Open dialog**

There are three ways to add media files from the Open dialog:

- Select the desired file and click Open.
- Right-click the selected file and choose Select from the shortcut menu.
- Double-click the selected file.
Adding media files from outside the application
You can also add a media file to a project by dragging it from Windows Explorer to the track view.

Adding multiple media files simultaneously
To add multiple media files to the project, Ctrl-click (or Shift+click) to select the files and drag them to the track view or the track list.

Extracting media files from CD
ACID allows you to extract 44.100 Hz, 16-bit, stereo data from CDs. ACID adds extracted CD tracks to new tracks in your ACID project.

1. Insert a CD in the CD-ROM drive.
2. From the File menu, choose Extract Audio from CD. The Extract Audio from CD dialog appears.
3. If you have more than one CD drive, choose the CD drive that contains the audio you want to extract from the Drive drop-down list.
4. From the Action drop-down list, choose how you want to extract audio:
   • Choose Read by track and select each track you want to extract. ACID extracts each track to a new track in your project.
   • Choose Read entire disc to extract the current CD to a single file.
   • Choose Read by range and enter a starting time and ending time (or a starting time and length). ACID extracts the time range to a new track in your project.

   Click Play to preview your selection. In order to preview, your CD drive's audio output must be connected to your sound card, or you can connect headphones to the front of the CD drive.
5. From the Speed drop-down list, choose the speed at which you want to extract audio.
6. Click OK. The Save As dialog appears.
7. Enter a file name and choose a location for the new file(s).

Note: ACID can automatically name extracted tracks for you. From the Options menu, choose Preferences, and on the General tab, select the Autoname extracted CD tracks check box. For more information, see Using the General tab on page 179.

8. Click Save to start extracting audio.

ACID begins extracting data from the CD and displays a progress meter. If the file is longer than 30 seconds, the Beatmapper™ Wizard appears.
9. Use the Beatmapper Wizard or choose to open the file as a one-shot. ACID adds the extracted file to a track. For more information, see Using the Beatmapper on page 103.
You can also double-click a CDA file in the Explorer window (or drag it to the track view) to extract a CD track without opening the Extract Audio from CD dialog.

Note: When adding media from multiple CDs, you may need to press F5 to refresh the Explorer window to view the new CD’s contents.

Downloading media files from the Web

The Get Media from the Web command allows you to view and download various audio and video files available on the Internet.

1. From the File menu, choose Get Media from the Web.
2. Choose an icon from the left frame to specify the media provider from which you want to download files.
3. Preview the file, select the file you want to open and click Download. The Browse for Folder dialog appears.
4. Select a folder for the download. The selected file is downloaded to the folder specified in the Destination box.
5. When you are done downloading, close the Get Media from the Web dialog. ACID adds the file(s) to your project.

Click Show Details to display additional information about your download. In this mode, you can add files to a download queue, specify where the downloaded files should be stored, and monitor the progress of your downloads. Click Start to begin downloading queued files, or click Hide Details to return to basic mode.

Understanding track types

When you add media to a project, ACID creates a new track for the file. Depending on the type of media you add, ACID creates one of four track types to accommodate it: loop, one-shot, Beatmapped, or MIDI. You can identify a track’s type by looking at the track number/type icon in the track header.

Loops

Loops are small chunks of audio that are designed to create a continuous beat or pattern when played repeatedly. They are usually one to four measures long. Loops are the type of file that you will use most frequently.

One-shots

One-shots are chunks of audio that are not designed to loop, and they are streamed from the hard disk rather than stored in RAM if they are longer than three seconds. Things such as cymbal crashes and sound bites could be considered one-shots.

Unlike loops, one-shots do not change pitch or tempo with the rest of a project.

Beatmapped

When you add a file that is longer than thirty seconds to a project, the Beatmapper Wizard starts, allowing you to add tempo information to the file. As a result, these tracks respond to tempo and key changes just like loops. For more information, see Using the Beatmapper on page 103.
Tip: You can change the length of the file that starts the Beatmapper in the Audio tab of the Preferences dialog. For more information, see Using the Audio tab on page 181.

MIDI
ACID creates a MIDI track when you open a MID, SMF, or RMI file. You can use MIDI tracks to record data from and play back through synthesizers and other MIDI-compliant equipment. For more information, see Working with MIDI on page 131.

Adding and editing events

You have added media to the project, and ACID has created tracks for the media files. Now you can add events to the track view. The following sections describe three basic techniques used when working with audio events: painting, deleting, and moving.

Painting events

After you add a media file to your project, you must paint it on the timeline in order to hear it. When you paint on the media file's track, you create an event that displays the file's waveform. You can paint events on the timeline using either the Draw tool or the Paint tool.

Note: Media files must be added to the project before either of these tools can be used to paint events.

Placing events with the Draw tool

The Draw tool is the most common method of placing events on the timeline. This tool allows you to add track-specific events, one at a time. In addition, you can use the Draw tool to select, edit, and move events. For more information, see Adding and editing events on page 39.

1. Click the Draw Tool button ( ) or choose Editing Tool from the Edit menu and choose Draw from the submenu. The pointer displays as a pencil icon.
2. Place the Draw tool at the left edge of any track containing a media file.
3. Click and hold the mouse button while dragging the Draw tool to the right. A waveform representing the event appears on the timeline as you drag the mouse.

Tip: Events can be also be drawn from right (end) to left (beginning).

4. Release the mouse button to end the event.
5. Click the Play from Start button ( ) on the transport bar. The event plays back.
Painting events with the Paint tool

Unlike the Draw tool, the Paint tool allows you to quickly paint multiple events across several tracks. This can be useful when you need to quickly add several seemingly random events to a project. The Paint tool is also best used for painting multiple one-shot events that will be evenly spaced on the grid lines.

1. Click the Paint Tool button ( ) or choose Editing Tool from the Edit menu and choose Paint from the submenu. The mouse pointer displays as a brush icon.

2. Click and hold the mouse button while dragging the Paint tool randomly across the several tracks. Notice that events are painted in every grid space the Paint tool contacts.

3. Release the mouse button to stop adding events.

4. Click the Play from Start button ( ) on the transport bar. All new events play back.

Tip: With the Paint tool selected, you can use +click to paint an entire event for one-shot, Beatmapped, and MIDI tracks.

Changing the length of events

After an event is painted on the track view, you may discover that it is too long or not long enough; however, ACID makes it easy to change the length of an event. You may find it helpful to turn snapping options on by choosing Snapping from the Options menu and choosing Enable from the submenu.

To alter an event’s length, click the Draw Tool button ( ) and drag either end of the event. When you drag the event past the end of the file, looped files repeat, but one-shot and Beatmapped tracks draw silence.

Erasing sections of events

Occasionally you may need to delete only specific sections of an event and leave the rest of it intact. The easiest method of deleting a section of an event is to use the Erase tool.

1. Click the Erase Tool button ( ) or choose Editing Tool from the Edit menu and choose Erase from the submenu. The pointer displays as an eraser icon.

2. Drag in the track view to delete event data.

Tip: With the Erase tool, you can delete an entire one-shot, Beatmapped, or MIDI event. Just hold while you click the event.
Moving events

The position of the left edge of an event indicates when the event becomes audible during playback. You can move events along the timeline either individually or as a group.

In addition, you can stack events on top of one another. A longer event placed over a smaller event conceals the smaller event and makes it inaudible. A smaller event placed over a larger event is audible and renders the section of the longer event it covers inaudible.

1. Click the Draw Tool button ( ).
2. Click the event to be moved. The event is highlighted to indicate that it is selected.
   
   **Tip:** You can hold Ctrl or Shift to select multiple events.

3. Drag the event to a new location on the track.
   
   **Note:** Multiple selected events move in relation to the event being dragged.

Using the cursor

ACID’s cursor is a flashing vertical line that spans the track view of the entire project. The cursor position determines where events split, where playback/recording starts, and where clipboard contents are pasted. In addition, the positioning of the cursor is essential to the creation of time selections.

Positioning the cursor with the mouse

1. Click the Draw Tool button ( ).
2. Click in the track view to position the cursor.

Positioning the cursor with the keyboard

While using the mouse to position the cursor in the timeline is quick and intuitive, it is not always precise. For example, you may want the beginning of a guitar solo to coincide with a snare drum hit, or background vocals to enter exactly 3 minutes and 24 seconds into a song. For these reasons, ACID also allows you to position the cursor using your keyboard. For more information, see Cursor placement commands on page 20.
Positioning the cursor with the Go To command

The Go To command is used to place the cursor at a specific location in the ACID project.

- Press `Ctrl`+`G` to position the cursor based on the position displayed on the beat ruler. Specify a position (in measures.beats.ticks format) in the box that appears in the time display and press `Enter`.

- Press `Shift`+`G` to position the cursor based on the time displayed on the time ruler. Specify a time in the box that appears in the time display and press `Enter`.

Tip: You can also open the boxes in the time display by double-clicking the desired value.

Making selections

You must select events before you can move or edit them.

Selecting an event

1. Click the Draw Tool button ( ).
2. Click an event. The event is highlighted.

Selecting multiple events

ACID provides you with several methods of selecting multiple events:

- Press `Ctrl` or `Shift` while clicking events.
- Use the Select All on Track command.
- Use the Select Events to End command.
- Use the Select All command.
- Use the Selection tool.

Note: Unless stated otherwise, selections can only be made using the Draw tool.
Selecting multiple events using the keyboard and mouse

Holding \texttt{[Ctrl]} while clicking events allows you to select multiple, nonadjacent events that reside on any track. This method is useful when you need to move several scattered events by an equal amount within the project.

Holding \texttt{[Shift]} allows you to select multiple, adjacent events. Selecting any two events while holding \texttt{[Shift]} automatically selects all events located between the selected events. Events may be selected from the same track or across tracks. This method is useful when you want to move several adjacent events by an equal amount within the project.

Selecting multiple events using the Select All on Track command

Right-clicking any track in the track view and choosing \texttt{Select All on Track} from the shortcut menu selects every event on the track.

Selecting multiple events using the Select Events to End command

Right-clicking an event in the track view and choosing \texttt{Select Events to End} from the shortcut menu selects every event on the track after the selected event.

You use this command across multiple tracks by holding \texttt{[Ctrl]} to click events on several tracks and then right-clicking and choosing \texttt{Select Events to End} from the shortcut menu.

Selecting events using the Select All command

Choosing \texttt{Select All} from the \texttt{Edit} menu selects all events in a project.

Selecting multiple events using the Selection tool

You can drag the Selection tool across the track view to select events across multiple tracks. This tool allows you to select events using three methods: vertical, horizontal, and free selection.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
<th>Displays as...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical</td>
<td>Allows you to select all events on all tracks within an interval of time.</td>
<td>Parallel dashed line spanning the vertical length of the project.</td>
</tr>
<tr>
<td>Horizontal</td>
<td>Allows you to select all events on a track or several adjacent tracks.</td>
<td>Parallel dashed line spanning the horizontal length of the project.</td>
</tr>
<tr>
<td>Free selection</td>
<td>Allows you to select a group of adjacent events on adjacent tracks. This is ACID’s default selection method.</td>
<td>Dashed line box.</td>
</tr>
</tbody>
</table>

1. Click the Selection Tool button (\texttt{[Select Tool]}) or choose \texttt{Editing Tool} from the \texttt{Edit} menu and choose \texttt{Selection} from the submenu.

2. Place the pointer on the track view. The pointer displays as an arrow with an adjacent dotted box (\texttt{[Dotted Box]}).

3. Drag the mouse on the track view. A dashed rectangular box appears on the track view and all events within and adjacent to it are selected.

4. While holding the left mouse button, click and release the right mouse button (referred to as toggle-clicking). The selection method changes to vertical and again, all events within and adjacent to the selection area are selected.

5. Toggle-click the mouse once more. The selection method changes to horizontal and all events within and adjacent to the selection area are selected.
Creating time selections

ACID does not limit you to selecting events. Frequently, you may want to select only audio events occurring within a time selection. You can do this using the Time Selection tool.

1. Click the Time Selection Tool button ( ) or choose Editing Tool from the Edit menu and choose Time Selection from the submenu. The pointer displays with an adjacent cursor ( ).

2. Drag the mouse in the track view. The selection area is highlighted on the track view.

3. Release the mouse button. A time selection is created and all events within it are selected.

Note: If the selection area is automatically snapping to the track view’s grid lines, ACID’s snapping feature is turned on. You can turn snapping off by pressing F8.

Creating event selections within time selections

ACID also allows you to select specific events within a general time selection. This technique is useful for selecting individual instruments from a particular section of a song. For example, you may want to copy all percussion events from a song’s bridge and re-use them in the coda.

1. Click the Time Selection Tool button ( ) or choose Editing Tool from the Edit menu and choose Time Selection from the submenu. The pointer displays with an adjacent cursor ( ).

2. Drag the mouse in the track view. The selection area is highlighted on the track view.

3. Release the mouse button. A selection is created and all events within it are selected.

4. Hold Ctrl and click any event that extends beyond the time selection. The entire event appears highlighted; however, only the section of the event contained within the time selection is actually selected.

Tip: You can select additional events within the time selection by continuing to hold Ctrl while clicking events. In addition, holding Shift allows you to select the events of multiple adjacent tracks within a selection.

Working with tracks

ACID automatically creates a new track for each media file added to a project, and all events placed on the track derive from that file. Because of this, you can use track-level functions to affect every event on the track. The following sections explain several basic track functions and features.
Reordering tracks

When building an ACID project, you may want to reorder the tracks to place similar instruments in proximity to one another. For example, placing all drum loops together in the track view makes it easier for you to fine-tune the mix of the song's overall drum sound.

1. Drag the track header to a new location in the track list. A heavy black horizontal line appears on the track list to indicate where the track will be placed.

2. Release the mouse button. The track is dropped in the new location and the entire track list/track view adjusts accordingly.

Tip: You can reorder multiple tracks by holding Ctrl or Shift while selecting tracks and dragging the tracks as a group.

Resizing tracks

ACID allows you to change the height of a track, thereby affecting how many tracks display in the track view. This is especially useful when building a project with a large number of tracks. In addition, you can decrease the track’s height until only the multipurpose slider, Track FX button, Mute button, and Solo button are visible.

1. Drag the bottom edge of a track up or down in the track list. The pointer displays as a vertical stretch icon (\textsuperscript{-}).

2. Release the mouse button to establish the track’s new height.

Tip: You can set the default height for all new tracks by right-clicking the newly resized track in the track list and choosing Set Default Track Properties from the shortcut menu. For more information, see Setting default track properties on page 178.

Changing track colors

As mentioned previously, ACID automatically creates tracks to accommodate new media files. ACID also supplies these tracks with a default color. However, you can change track colors to organize the tracks in your project. To change the color, right-click the track in the track list, choose Color from the shortcut menu, and choose the desired color from the submenu.

Renaming tracks

To rename a track, right-click the track name and choose Rename from the shortcut menu, or double-click the track name. Renaming a track applies to the project only and does not change the file associated with the track.

Duplicating tracks

To duplicate a track, right-click it and choose Duplicate Track from the shortcut menu. ACID creates an exact copy of the track and its events and adds it below the original track in the project. The words “Copy of” appear before the name of the duplicate track to identify it in the track list.

For creative ways to use duplicate tracks, see Playing with duplicate tracks on page 187.
Deleting tracks

You can delete unnecessary tracks from a project by selecting the track and using any of the following methods:

- Choose Delete from the Edit menu.
- Right-click a track and choose Delete Track from the shortcut menu.
- Press Delete.

Copying, cutting, and pasting tracks

Copying a track places an exact copy of the selected track on the clipboard, but leaves the track view unchanged. To copy a track, select the track and do one of the following:

- Click the Copy button ( ) on the toolbar.
- Choose Copy from the Edit menu.
- Right-click the track header and choose Copy Track from the shortcut menu.
- Press Ctrl+C.

Cutting a track removes it from the track view and places it on the clipboard. To cut a track, select it and do one of the following:

- Click the Cut button ( ) on the toolbar.
- Choose Cut from the Edit menu.
- Right-click the track header and choose Cut Track from the shortcut menu.
- Press Ctrl+X.

Tracks that are copied or cut to the clipboard can be pasted back into the current project or into a different project an unlimited number of times. This is a useful way to share tracks between different compositions. You can paste a track in one of the following ways:

- Click the Paste button ( ) on the toolbar.
- Choose Paste from the Edit menu.
- Right-click the track view and choose Paste Track from the shortcut menu.
- Press Ctrl+V.

Adjusting the mix

Use the multipurpose slider to adjust the mix of a specific track.
Click the slider label to choose what you want to adjust.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume</td>
<td>Controls how loud a track is in the mix. A value of 0 dB means that the track plays with no boost or cut from ACID. Dragging the fader to the left cuts the volume; dragging to the right boosts the volume.</td>
</tr>
<tr>
<td>Pan</td>
<td>Controls the position of a track in the stereo field. Dragging the slider to the left places the track in the left speaker more than the right, while dragging the slider to the right places the track in the right speaker. Because ACID uses true stereo panning, you can introduce clipping when panning a track to the left or right. Unlike a left/right balance control—which simply decreases the volume of one channel—ACID’s default panning mode actually adds the audio from one channel to the other. When panning a track, adjust the track volume accordingly. You can choose among five panning types to determine how ACID pans a track. For more information, see Choosing stereo pan types on page 103.</td>
</tr>
<tr>
<td>FX</td>
<td>Controls the level of the track sent to each of the assignable effect chains that you have created. Dragging the fader to the left cuts the volume; dragging to the right boosts the volume.</td>
</tr>
<tr>
<td>Bus</td>
<td>Controls the level of the track sent to each of the additional busses that you have created for your project. Dragging the fader to the left cuts the volume; dragging the fader to the right boosts the volume.</td>
</tr>
</tbody>
</table>

Once you have chosen what you want to adjust, drag the slider to adjust the level. You can hold [Ctrl] or Shift to select multiple tracks and move the sliders together as a group.

---

**Note:** When adjusting the mix of your tracks, remember to look at the meters on the mixer. Because you are adding the volumes of all the tracks together, it is easy to clip the audio output. Make sure that the meters never display the red clip indicator during playback.

---

**Muting tracks**

Each track has a Mute button (Hold). Clicking this button shades the corresponding track (to indicate that it is muted) and renders it inaudible during playback. Clicking the Mute button a second time returns the track to its original level in the mix. Toggle-muting a track is an effective way of determining whether a track contributes to the overall sound of a project.

You can also press [Z] to mute a track or group of tracks.

---

**Tip:** Press [Ctrl] and click the Mute button to mute only the selected track (and restore any other muted tracks). If the selected track is already muted, press [Ctrl] and click the Mute button to restore all tracks.
Soloing tracks

Located next to the Mute button, the Solo button ( ) allows you isolate tracks in a project during playback. When you click this button during playback, the corresponding track remains audible and all other tracks are muted. Clicking the Solo button a second time returns all tracks to their original levels in the mix. Toggle-soloing a track is an effective method of configuring and previewing isolated track effects against how they sound in the project.

You can also press X to solo a track or group of tracks.

Tip: Press Ctrl and click the Solo button to solo only the selected track (and restore any other soloed tracks). If the selected track is already soloed, press Ctrl and click the Solo button to restore all tracks.

Working with groups of tracks

Select a group of tracks by holding the Ctrl key while you click the track header of the desired tracks. Now you can adjust the volume, panning, track color, and other track attributes simultaneously.

Using undo and redo

ACID provides unlimited undo and redo capabilities. ACID adds each edit you perform in the project to an undo history, which allows you to quickly restore the project to any of its previous states. In addition, undoing an edit automatically places it in the project’s redo history where it can be quickly re-performed. However, any new edit performed on the project overwrites the redo history.

Note: The undo and redo histories are cleared when you close the project or exit ACID.

Using undo

To undo an edit, click the Undo button ( ) on the toolbar or press Ctrl + Z. Edits are undone in the reverse order they were performed.

Tip: You can also undo the most recent edit by choosing Undo from the Edit menu.

Undoing a series of edits

Clicking the down arrow next to the Undo button ( ) displays the project’s undo history. The history displays as a drop-down list with the most recent edit located at the top. Undoing an edit in the list requires all subsequent edits to be undone as well.

1. Click the arrow to the right of the Undo button ( ). The undo history appears.
2. Locate the edit to be undone. Notice that all subsequent edits are automatically selected and the total number of edits to be undone is indicated at the bottom of the drop-down list.
3. Click the edit to be undone. The project is restored to the state it was in prior to the selected edit.
**Undoing all edits**

Choosing Undo All from the Edit menu undoes all project edits and automatically adds them to the redo history.

**Using redo**

To redo an edit, click the Redo button ( ) on the toolbar or press Ctrl + Shift + Z. Edits are re-performed in the reverse order they were undone.

Tip: You can also redo the most recent undone edit by choosing Redo from the Edit menu.

**Redoing a series of edits**

Clicking the down arrow next to the Redo button ( ) displays the project’s redo history. The history displays as a drop-down list with the most recently undone edit located at the top. Redoing an edit in the list requires all subsequently undone edits to be re-performed as well.

1. Click the arrow to the right of the Redo button ( ). The redo history appears.
2. Locate the edit to be redone. Notice that all subsequently undone edits are automatically selected and the total number of edits to be redone is indicated at the bottom of the drop-down list.
3. Click the edit to be redone. The project is restored to the state it was in prior to the selected undone edit.

Tip: Clicking the desktop outside the drop-down list cancels the redo operation.

**Clearing the undo history**

ACID allows you to clear the undo and redo histories without closing the project or exiting the application. After the histories are cleared, ACID creates new ones as you continue building the project.

1. From the Edit menu, choose Clear Undo History. A confirmation dialog appears, alerting you that this action permanently deletes the current edit histories.
2. Click Yes to clear the edit histories or No to retain the current edit histories.

**Playing the project**

ACID provides several methods of playing your projects.

**Using the transport bar**

All buttons required to play your project are located on ACID’s transport bar. The transport bar should look somewhat familiar to you, as it contains buttons found on most home CD and cassette players. For more information, see Transport bar on page 17.
Using playback options

As you build a project, you will likely have different playback needs. For example, you may want to hear the project in its entirety when checking the final mix, but not when you are working on the ending. Because of this, ACID offers three playback options:

- Playing the entire project.
- Playing from the cursor position.
- Playing in looped playback.

Playing the entire project

To begin playback from the beginning of the project, click the transport bar’s Play From Start button ( ) or press Shift + Space. To stop playback, click the transport bar’s Stop button ( ) or press Space.

Playing from the cursor position

To begin playback from the current cursor position, click the transport bar’s Play button ( ) or press Space. To stop playback, click the transport bar’s Stop button ( ) or press Space.

Playing in looped playback

You can also limit playback to a specific loop region on the track view. This playback method uses the transport bar’s Loop Playback button ( ) and allows you to fine-tune mixes and effects while continually listening to the selected area. For more information, see Transport bar on page 17.

1. Drag the handles of the loop bar to create the desired loop region.

2. Click the Loop Playback button ( ) to turn on looped playback.

3. Click the transport bar’s Play button ( ) or press Space. ACID begins playback of the selected area. To stop playback, click the transport bar’s Stop button ( ) or press Space.

Using the Mixer window

The Mixer window is a dockable window with a default location in the lower-right corner of the ACID workspace. The Mixer window contains the following controls:

- A Preview fader, which allows you to adjust the loudness of media files previewed from the Explorer window, Track Properties window, Beatmapper, or the Chopper. Also, the Preview fader’s volume determines the volume of new tracks added to the project, unless you have set a default track volume level. For more information, see Setting default track properties on page 178. This allows you to set up a quick mix while you are adding media to your project.
- A Master bus fader, which controls the overall volume.
- Faders for up to 26 project busses when added to the project.
- Faders for up to 32 assignable effect chains when added to the project.
- Faders for up to 32 soft synth controls when added to the project.

The function of the bus, assignable effect, and soft synth controls are beyond the scope of this chapter. For more information, see Using the Mixer on page 111.
Viewing the Mixer window

The Mixer window appears by default when you start ACID, but you can hide it if necessary. To view or hide the Mixer window, choose Mixer from the View menu or press Alt + 3. A check mark appears adjacent to the command to indicate when the window is displayed.

Using the mixer toolbar


<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Project Audio Properties]</td>
<td>Displays the Project Properties dialog.</td>
</tr>
<tr>
<td>![Insert FX]</td>
<td>Adds an assignable effect chain to your project. The Plug-In Chooser dialog appears so that you can create a plug-in chain. For more information, see Using assignable effects on page 113.</td>
</tr>
<tr>
<td>![Insert Bus]</td>
<td>Adds another bus to your project. The Audio tab in the Project Properties dialog updates to reflect the new number of busses. For more information, see Using busses on page 111.</td>
</tr>
<tr>
<td>![Insert Soft Synth]</td>
<td>Adds a soft synth control to your project. You can assign MIDI tracks or external MIDI input devices to the soft synth control and assign the soft synth control to a DLS set or VSTi plug-in. For more information, see Using soft synth controls on page 115.</td>
</tr>
</tbody>
</table>

Renaming mixer controls

Double-clicking a mixer control name allows you to rename the control. Press Enter to save the change.

Using the mixer’s faders

**Adjusting the Preview fader**

Drag the fader up or down to adjust the preview volume.

**Hiding the Preview fader**

Once you have added all desired media files to a project, you may want to hide the Preview fader to make room for additional busses, assignable effects, and soft synth controls. To hide the Preview fader, right-click within the Mixer window and choose Show Preview Fader from the shortcut menu. The fader remains hidden until you choose Show Preview Fader from the shortcut menu again.
Adjusting split faders in the mixer
Split faders allow you to adjust the levels of the left and right channels independently. To move the faders individually, drag the fader for the desired channel and release the mouse when it is in the correct position.

However, you can adjust both channels simultaneously by doing either of the following:

- Drag in the middle of the fader while making your adjustment.
- Click the Lock Fader Channels button before adjusting the fader.

You can also change the fader level by double-clicking:

- Double-click the fader to reset it to 0.0 dB.
- If you have set each channel differently, double-click either channel to match the remaining channel to its level.

Changing meter resolution
ACID allows you select the meter resolution. This is useful when building a project from several media source pools that have varying volume levels. To change the resolution, right-click a meter and choose the desired resolution from the shortcut menu.

---

**Note:** Changing the meter resolution of one fader automatically changes all other meters in the mixer to match the selected resolution.

---

Adjusting for clipping
The volume of certain media files may cause a meter to clip. Clipping results in a distorted audio signal and displays in a red indicator at the top of the meter. If the meter clips, lower the volume and click the red clip indicator to reset the meter. Continue adjusting the fader and resetting the meter until you eliminate the clipping.

**Tip:** You can also reset a meter by right-clicking it and choosing Reset Clip from the shortcut menu.

---

Saving, rendering, and delivering projects
Though ACID provides you with the tools to quickly build impressive musical projects, you may find yourself building elaborate projects over a period of weeks or even months. While you are working on a project, you should save it in ACID's native format, the ACID project file (.acd).

**Important:** If you save a project created in an earlier version of ACID in ACID 4.0, it will be unusable in earlier versions of ACID. Use the Save As dialog to save the project with a new name after editing it in ACID 4.0.
When you are finished building a project, ACID allows you to render projects in a variety of formats. You should determine the project's final format (or formats) based on how you will deliver the media. For example, you would render your project to a streaming media format if you plan to publish it to the Internet.

**Note:** Be aware that projects containing MIDI files that are routed to external MIDI ports must be rerouted to internal DLS sets or VST instruments (VSTi) to be included in the rendered mix. For more information, see Rendering projects with MIDI tracks on page 150.

### Saving projects

An ACID project file (.acd) is the default file format for saving a new project and should be used for saving unfinished projects. There are two ACID project file types.

<table>
<thead>
<tr>
<th>Format</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACID Project File</td>
<td>.acd</td>
<td>Contains all information regarding the project including track layout,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>envelope settings, and effects parameters. However, this type of file does</td>
</tr>
<tr>
<td></td>
<td></td>
<td>not contain actual audio, only references to the audio files.</td>
</tr>
<tr>
<td>ACID Project with Embedded Media</td>
<td>.acd-zip</td>
<td>Contains all information regarding the project including track layout,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>envelope settings, and effects parameters. In addition, all audio files</td>
</tr>
<tr>
<td></td>
<td></td>
<td>used in the project are embedded into the project file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you save a project in .acd-zip format, the project file and all media</td>
</tr>
<tr>
<td></td>
<td></td>
<td>files are copied to a temporary files folder. If you continue to work on</td>
</tr>
<tr>
<td></td>
<td></td>
<td>your project after saving the .acd-zip file, your changes are saved to the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>files in this temporary folder. You can customize the location of the</td>
</tr>
<tr>
<td></td>
<td></td>
<td>temporary files folder. For more information, see Using the General tab on</td>
</tr>
<tr>
<td></td>
<td></td>
<td>page 179.</td>
</tr>
</tbody>
</table>

1. To save a file, display the Save As dialog using any of the following options:
   - Click the Save button (\(\) on the toolbar.
   - From the **Edit** menu, choose **Save**.
   - Press \(\text{Ctrl} + \text{S}\).
2. From the **Save in** drop-down list, choose the drive and directory where the file will be saved.
3. Enter a name for the project in the **File name** box.
4. From the **Save as type** drop-down list, choose the desired ACID project file type.
5. If you want ACID to save a copy of each of the project’s media files to the same location as your project file, select the **Copy all media with project** check box. This is available when saving as an ACID project file.
6. Click **Save**. ACID saves the project.

Once the project is saved, you can use the **Save As** command from the **File** menu to create a copy of the project with a new name or save to a different ACID project file format.
Rendering projects

Rendering refers to the process of converting the ACID project into a file that is formatted for a specific playback method. Possible playback methods include media player applications, Internet streaming media, CD-ROM, and CD audio. When an ACID project is rendered, it is not overwritten, deleted, or altered and you are able to return to the original project to make changes and re-render.

1. From the **File** menu, choose **Render As**. The Render As dialog appears.

2. From the **Save in** drop-down list, choose the drive and folder where the file will be saved.

3. Enter a new name for the project in the **File name** box.

4. From the **Save as type** drop-down list, choose the desired file format.

5. If the selected file type supports it, you can choose an encoding template from the **Template** drop-down list, or click Custom to create a new template. For more information, see **Creating custom rendering settings** on page 55.

6. Select or clear the following check boxes as needed:
   - Select the **Render loop region only** check box if you want to save only the portion of the project that is contained within the loop region. The loop region does not need to be active for this option to work.
   - If the selected file type supports it, you can select the **Save project markers with media file** check box to include markers and regions in the rendered media file.
   - Select the **Save each track as a separate file** check box if you want to render each track in the project to its own file. The **File name** box changes to Folder, which displays the name of the folder in the **Save in** box.
   - **Stretch video to fill output frame (do not letterbox)**: Selecting this check box stretches the source video frame if the destination frame size differs. When this check box is cleared, ACID uses letterboxing or pillarboxing to keep the frame aspect correct.
   - **Fast video resizing**: Selecting this check box speeds the process of saving video. When this check box is cleared, the time required to save the file can increase dramatically. Clear this check box only when you have critical material where nothing but the highest quality video rendering will do.

7. Click **Save**. A progress dialog appears.

When rendering is complete, you can choose one of the following options:

- Click **Open** to start the associated media player and play the newly rendered file.
- Click **Open Folder** to open Windows Explorer and display the location of the newly rendered file.
- Click **Close** to close the progress dialog and return to the ACID window.
Supported formats for rendering

The following table briefly describes the file formats available for rendering a project.

<table>
<thead>
<tr>
<th>Format</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIFF File</td>
<td>.aif</td>
<td>The standard audio file format for audio used on Macintosh computers.</td>
</tr>
<tr>
<td>MPEG-1 and MPEG-2</td>
<td>.mpg</td>
<td>MPEG files are a format used when burning audio and video to a Video CD, Super Video CD, or DVD. ACID supports MPEG-1 and MPEG-2 file creation through the use of the MainConcept MPEG plug-in.</td>
</tr>
<tr>
<td>MPEG-1 Layer 3</td>
<td>.mp3</td>
<td>A highly compressed format used for portable digital players and Internet sharing of media. ACID provides 20 free MP3 encodes. After you have used the free encodes, you must register the plug-in to continue rendering MP3s.</td>
</tr>
<tr>
<td>Ogg Vorbis</td>
<td>.ogg</td>
<td>A patent-free audio encoding and streaming technology.</td>
</tr>
<tr>
<td>QuickTime</td>
<td>.mov</td>
<td>QuickTime for Microsoft Windows.</td>
</tr>
<tr>
<td>RealMedia</td>
<td>.rm</td>
<td>The RealNetworks standard for streaming media via the Web. This option renders both audio and video into one file.</td>
</tr>
<tr>
<td>Sonic Foundry Perfect Clarity Audio</td>
<td>.pca</td>
<td>A Sonic Foundry proprietary lossless audio compression format.</td>
</tr>
<tr>
<td>Sonic Foundry Wave64</td>
<td>.w64</td>
<td>A Sonic Foundry proprietary wave format that does not have a restricted file size (unlike Windows standard WAV format which is limited to ~2GB).</td>
</tr>
<tr>
<td>Video for Windows</td>
<td>.avi</td>
<td>The standard video file format used on Windows-based computers.</td>
</tr>
<tr>
<td>Wave</td>
<td>.wav</td>
<td>The standard audio file format used on Windows-based computers.</td>
</tr>
<tr>
<td>Windows Media Audio</td>
<td>.wma</td>
<td>The Microsoft audio format used to create files for streaming or downloading via the Web.</td>
</tr>
<tr>
<td>Windows Media Video</td>
<td>.wmv</td>
<td>The Microsoft audio and video format used to create files for streaming or downloading via the Web.</td>
</tr>
</tbody>
</table>

Note: Some plug-ins, such as MP3, may require registration.

Creating custom rendering settings

The Custom Settings dialog appears when you click Custom in the Save As dialog. You can use the Custom Settings dialog to create custom encoding templates for many of the file formats available in ACID.

1. From the File menu, choose Render As. The Render As dialog appears.

2. Choose your preferred file format from the Save as type drop-down list. If the format allows you to create custom settings, the Custom button becomes active.

3. Click Custom. The Custom Settings dialog appears.

4. Make the appropriate setting changes for the chosen file format. For help on individual settings, click the What's This? Help button ( ) and click a setting.

   Tip: To save the custom settings for future use, enter a name for the template in the Template box and click the Save Template button ( ).

5. Click OK. The Custom Settings dialog closes.
Publishing to the Internet

When your project is finished, you have the option of publishing it to the Internet. The most common place to publish your project is ACIDplanet.com, a virtual community of ACID users. ACIDplanet.com allows you to do the following:

- Share your music.
- Listen to projects built by other ACID enthusiasts.
- Download free loops.
- Enter remix contests co-sponsored by Sonic Foundry and major record labels.

Publishing your project to the Internet involves two distinct procedures: creating a personal account and uploading the project.

Creating a personal account

ACID allows you to create accounts at Web sites where you can publish your song files. Each Web site that offers publishing directly through ACID will guide you through its own account creation process. If you haven’t created an account and you attempt to publish a song, you will be directed to complete the Publish Setup utility.

1. From the File menu, choose Publish Setup.

2. Follow the on-screen instructions to set up your account.

At any time, you can go back and create another account at a different Web site. The Web site you are currently logged into in the Publish Setup utility is where ACID publishes your song when you choose Publish from the File menu.

Uploading a project

Publishing a project file copies your media to the Web so you can share it with other Web users. The following procedure assumes you already have an account set up with a publish provider. If not, you will first be redirected to set up an account. After successfully creating an account, you will be directed back to the Publish feature.

1. From the File menu, choose Publish. The Publish dialog appears.

2. Select the appropriate radio button to specify whether the song to be published is the current ACID song or a different song.

   - To publish your current ACID song, choose a streaming format and bit rate.
   - To publish a different song, enter the path to the song or click Browse to locate the file. This song must already be in a streaming format.

3. Click Next. If you are publishing the current ACID song, ACID renders it in the format and bit rate you specified. A window appears from the publish provider with directions for completing the publishing process.

4. Follow the instructions provided by the publish provider. ACID begins uploading the file to the provider. A progress dialog informs you when the upload is finished.

5. Click OK. The publish provider provides a link to the song on their Web site; however, this may vary depending on provider.
Writing to CD

ACID allows you to burn your projects to CD using supported CD-R/CD-RW drives. ACID renders your project so it can be played on consumer CD players; however, the disc must be closed before it can be played in a CD player.

Note: ACID writes the entire project length to a CD track. If your project has events on muted tracks that extend beyond the end of the audible material, the muted events burn as silence at the end of your CD track. To burn just a portion of a project, create a loop region and select the Burn loop region only check box.

1. Insert a blank CD in a supported CD-R/CD-RW drive.

2. From the Tools menu, choose Burn Track-at-Once Audio CD.

   Notice that the Burn Track-at-Once Audio CD dialog indicates the amount of time that the current project will fill on the CD as well as the total amount of time remaining on the CD. If the Time needed for audio value exceeds the Time available on disc value, ACID does not allow you to write the track to the CD.

   Note: If there is no CD in the CD-R/CD-RW drive, only the Cancel button is available in this dialog.

3. Choose a setting from the Action drop-down list:
   - Choose Burn audio to begin recording audio to your CD when you click Start. You must close the disc before it can be played in an audio CD player.
   - Choose Test, then burn audio to test whether your files can be written to the CD without encountering buffer underruns. Recording begins after the test if it is successful.
   - Choose Test only to test whether your files can be written to the CD without encountering buffer underruns. No audio is recorded to the CD.
   - Choose Close disc to close your disc without adding any audio when you click Start. Closing a disc allows your files to be played on an audio CD player. You cannot add tracks to a CD once it has been closed.
   - Choose Erase RW disc to erase a rewritable CD when you click Start.

4. Select your burning options:
   - Select the Erase RW disc before burning check box to erase a rewritable CD before you begin burning.
   - Select the Close disc when done burning check box to close the CD after burning. Closing a disc allows your files to be played on an audio CD player. You cannot add tracks to a CD once it has been closed.
   - Select the Eject disc when done check box to eject the CD automatically when burning is complete.
   - Select the Burn loop region only check box to burn only the selected loop region. Clear the check box to burn the entire project.

5. From the Drive drop-down list, choose the drive for burning CDs.

6. From the Speed drop-down list, choose the speed at which you want to burn. Choosing Max uses your drive’s fastest possible speed; decrease the setting if you have difficulty burning because of buffer underruns.

7. Click Start.

Important: Once ACID begins writing to the CD, cancelling the write operation renders the CD unusable.
In this chapter, you'll learn about basic event editing techniques such as cutting, copying, pasting, trimming, splitting, and joining events. You'll also learn how to use ripple editing to expand the possibilities of timeline editing. Finally, you'll take a look at advanced editing techniques such as slipping and sliding events, changing event properties, and adding event envelopes.

**Note:** For the basic event editing topics in this chapter, make sure that ripple editing is turned off. Verify that the Ripple Edits command in the Options menu is not selected. For more information, see Ripple editing on page 64.

### Copying events

Copying an event, a time selection, or event within a time selection places an exact copy of the selected event(s) on the clipboard, but leaves the track view unchanged. Events copied to the clipboard can be pasted in the project an unlimited number of times. In addition, clipboard content remains on the clipboard until replaced by new content.

1. Select the event data you want to copy or make a time selection. For more information, see Making selections on page 42.
2. Copy the event data using any of the following methods:
   - Click the Copy button ( ) on the toolbar.
   - Choose Copy from the Edit menu.
   - Right-click the selection and choose Copy from the shortcut menu.
   - Press Ctrl + C.

### Pasting events

The clipboard's contents can be pasted in a project an unlimited number of times. However, an event is always pasted in the track it was copied/cut from. In addition, pasting the contents of the clipboard over an existing event results in the pasted event overlapping the existing event. To avoid pasting over existing events, you have two options:

- Use the Paste Insert command. For more information, see Using Paste Insert on page 60.
- Turn on ripple editing. For more information, see Ripple editing on page 64.
When events are cut/copied to the clipboard and subsequently pasted into a project, ACID maintains and pastes the time data inherent in the cut/copied events. For example, if you select two events on the same track that are separated by five seconds of silence, copying and pasting these events results in the five seconds of silence also being pasted into the project.

Taking this concept a step further, if you select discontinuous events from several tracks, copying and pasting these events results in any selected time data being pasted into the project as well. This maintains the relative position of events in the project.

Using the Paste command

1. Place the cursor at the desired position on the timeline.
2. Paste the clipboard contents using any of the following methods:
   - Click the Paste button ( ) on the toolbar.
   - Choose Paste from the Edit menu.
   - Right-click the track view and choose Paste from the shortcut menu.
   - Press Ctrl + V.

Using Paste Repeat

When building projects, you often need to paste the contents of the clipboard several times. Rather than repeatedly pasting and moving the content, the Paste Repeat command allows you to specify the number of times and at what interval the clipboard's contents are pasted on the track view. This is a useful way of quickly building a project that uses a repetitive riff or structure. For example, you can build the backing tracks for a twelve-bar blues, copy them, and use Paste Repeat to paste several copies of it in the project.

1. Click the Time Selection Tool button ( ).
2. Drag the mouse in the track view to create a time selection spanning several events and copy it to the clipboard.
3. Click the Go To End button ( ) on the transport bar or press Ctrl + End to send the cursor to the end of the project.
4. From the Edit menu, choose Paste Repeat or press Ctrl + B. The Paste Repeat dialog appears.
5. Enter a number in the Number of times to paste box.
6. Select the End to end radio button and click OK. ACID pastes the events end to end the number of times specified in step five, starting at the cursor position.

Using Paste Insert

To insert the contents of the ACID clipboard at the current cursor position and force existing events to move in time to accommodate the pasted events, choose Paste Insert from the Edit menu.

If the cursor is in the middle of an event, the event splits at the cursor position where the new events are pasted. For more information, see Splitting events on page 62.
Cutting events

Cutting an event, a time selection, or an event within a time selection removes the audio data from the track view and places it on the clipboard. Once data is placed on the clipboard, it can be pasted back into the project an unlimited number of times. Clipboard content remains on the clipboard until it is replaced by new data.

1. Select the event data you want to cut or make a time selection. For more information, see Making selections on page 42.
2. Cut the event data using any of the following methods:
   - Click the Cut button ( ) on the toolbar.
   - Choose Cut from the Edit menu.
   - Right-click the selection and choose Cut from the shortcut menu.
   - Press Ctrl + X.

   All selected events are removed from the track view and placed on the clipboard.

Deleting events

Deleting an event, a time selection, or an event within a time selection removes the data from the track view and discards it. Deleted events are not placed on the clipboard and do not replace or interfere with current clipboard content. In addition, deleted events cannot be pasted back into a project.

Note: Deleted data can only be replaced in a project using the Undo command. For more information, see Using undo on page 48.

1. Select the event data you want to delete or make a time selection. For more information, see Making selections on page 42.
2. Delete the event data using any of the following methods:
   - Choose Delete from the Edit menu.
   - Right-click the selected event and choose Delete from the shortcut menu.
   - Press Delete.

   All selected events are removed from the track view and discarded.

Trimming events

Whereas deleting allows you to select event data to be removed from the project, trimming allows you to select the data that remains. Trimming is performed by creating a time selection or selecting an event within a time selection and subsequently deleting all unselected data.

1. Create a time selection or select specific events within a time selection. For more information, see Creating time selections on page 44.
2. Press Ctrl + T to trim the data within the selection. All unselected event data is removed from the track view and discarded.
Splitting is a quick way to create independently functioning events from a single one. You might consider splitting an event if you want to adjust a small part of the track. For example, you may want to apply pitch shift to a guitar track for a few measures and then return the track to its original setting.

Splitting occurs at the cursor position or at the in and out points of a time selection. When you split an event, ACID creates a new ending point for the original event and creates a starting point for the newly created event.

When you split an event, the newly created events abut each other. If Quick fade edges to prevent clicks is selected in the Event Properties dialog, ACID adds fades at the split point. For more information, see Changing event properties on page 68.

However, you may move either of the events, which creates a gap.

Splitting at the cursor position splits all selected events that the cursor crosses on all tracks.

1. Select the event(s) that you want to split.
2. Place the cursor where you want the split to occur or make a time selection.
3. From the Edit menu, choose Split or press [5]. The result of the split depends on how events were selected.

Splitting at the cursor position splits all events that the cursor crosses on all tracks.
Splitting an event

Selecting a single event prior to splitting prevents other events from being split at the cursor’s position.

Splitting multiple events

Selecting multiple events splits only the selected events at the cursor’s position. Be sure to set your cursor position before selecting events. Attempting to set your cursor after selecting events causes you to lose your event selection.

Splitting a time selection

Making a time selection allows you to split events at the time selection’s in and out points across all tracks.
Splitting events within a time selection

When selecting events within a time selection, only the selected events in the time range split at the in and out points.

Joining events

You may join events on ACID tracks that have been segmented along the timeline. Joining events is an efficient way to redraw an event and remove any splits or silent regions between events.

You would want to join events if you decided that the event should play uninterrupted over the specified time range.

1. Select the events or range of events that you want to join. For more information, see Selecting multiple events on page 42.
2. From the Edit menu, choose Join or press[J]. The selected events are joined.

Ripple editing

ACID includes a ripple editing feature. This feature is a timeline-based procedure that allows you to cut, delete, and paste events or portions of events within a time selection and simultaneously adjust the position of all later events on a selected track. The existing events’ timeline position adjusts by the total amount of the time selection that is being cut, deleted or pasted from the clipboard.

You may turn on ripple editing mode by choosing Ripple Edits from the Options menu or pressing [Ctrl]+[L].

Note: Ripple editing is only available when a time selection is present.
Cutting events in ripple editing mode

Cutting events or portions of events removes them and their time information from their respective tracks. This information is placed on the clipboard, from which you may paste the information back into your project.

1. From the Options menu, choose Ripple Edits to enter ripple editing mode.

2. Click the event to be cut or make a time selection.

   To cut multiple events, use the Ctrl key, the Shift key, or the Selection tool to select the events. For more information, see Selecting multiple events on page 42.

3. Click the Cut button on the toolbar to cut the event(s) to the clipboard.

   The cut events and their time information are removed from the selected track(s) and placed on the clipboard. Existing events in the selected track(s) move forward to occupy the space created by the cut.

Cutting time selections in ripple editing mode

Events within the time selection are reproduced and placed on the clipboard. Also, the time information is placed on the clipboard. Existing events occurring after the time selection move forward in the project by the length of the time selection.

Cutting time and event selections in ripple editing mode

Events and portions of events within the time selection are reproduced and placed on the clipboard. Also, the time information is placed on the clipboard. Existing events occurring later than the time selection move forward by the length of the time selection. Only tracks containing selected events are affected by the ripple edit.
Deleting events in ripple editing mode

Deleting events or portions of events removes them and their time information from their respective tracks. However, this information is not placed on the clipboard. Existing events move forward when you delete material from a selected track.

1. From the **Options** menu, choose **Ripple Edits** to enter ripple editing mode.
2. Click the event to be deleted or make a time selection.
   
   To cut multiple events, use the **Ctrl** key, the **Shift** key, or the **Selection** tool to select the events. *For more information, see Selecting multiple events on page 42.*
3. Press **Delete** to delete the event(s).

Deleting time selections in ripple editing mode

Events within the time selection and their time information are removed from the project. Existing events occurring after the time selection move forward in the project by the length of the time selection. When information is deleted, it is not placed on the clipboard.

Deleting time and event selections in ripple editing mode

Events within the time selection and their time information are removed from the project. Existing events occurring after the time selection move forward in the project by the length of the time selection. When information is deleted, it is not placed on the clipboard.

Pasting events in ripple editing mode

Once information is copied to the clipboard, you may choose a variety of ways to paste the clipboard items into tracks. *For more information, see Pasting events on page 59.* The following procedures explain pasting information in ripple editing mode.

---

**Note:** Events are always pasted into their own tracks at the cursor position.

1. From the **Options** menu, choose **Ripple Edits** to enter ripple editing mode.
2. Move the cursor to the desired timeline location.
3. Place the cursor within the track where you want to paste the event.
4. Click the **Paste** button on the toolbar to paste the event into the track.
Clipboard information is pasted at the cursor’s position on the track. Existing events or portions of events after the cursor adjust to occur later in the project. The amount of adjustment is based on the total length of the information being pasted.

**Pasting single track information in ripple editing mode**

The information on the clipboard determines how many tracks are affected when you paste. If you have copied or cut information from one track, only the selected track is affected by the pasted event and time information.

**Pasting multitrack information in ripple editing mode**

ACID can paste multiple events as easily as single events.

---

**Note:** Pasting in ripple editing mode ripples only the events on the tracks that receive the clipboard contents. If you want to ripple all tracks at the paste position, use the Paste Insert command from the Edit menu.

---

**Slipping and sliding events**

To help you picture what happens when you slip and slide events, think of an event as a window to a media file. The window can display the entire media file or a small section. When the window displays only a portion of the media file, you can move either the window or the underlying media to adjust the media played by an event:

- **When you slip** an event, your event maintains its place on the timeline, but the media file moves in the direction you drag.
- **When you slide** an event, the media file maintains its place on the timeline, but the event moves in the direction you drag.
Shifting the contents of (slipping) events

Hold [Alt] while dragging an event. The slip cursor appears (→).

As you drag the event, the contents of the event shift, but the event does not move. You can use this technique when you want to maintain an event’s length and position but want the event to play a different section of the source media file.

For creative ways to use event slipping, see Duplicating with offset on page 188.

Slip-trimming events

Hold [Alt] while dragging the right or left edge of an event. The slip-trim cursor appears (↑). As you drag the event edge, the media moves with the event edge.

Sliding events

Hold [Ctrl]+[Alt] while dragging an event. The slide cursor appears (↓).

As you drag, the relative position of the media remains fixed on the track, and the event position changes. You can use this technique when you want to maintain an event’s length but want the event to play a different section of the source media file at a different point in your project.

Changing event properties

To access event properties, right-click the event and choose Properties from the shortcut menu, or simply double-click the event.

These properties are saved in the project but are not saved into the file when you save changes to a track in the Track Properties window. For more information, see Saving file properties on page 109.
The following table describes each of the settings in the Event Properties dialog.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start offset</td>
<td>The Start offset for an event specifies a playback starting position that is different than the beginning of the file. This is especially useful for loops; you can change the feel of a loop by simply starting on beat two rather than beat one.</td>
</tr>
<tr>
<td>Pitch shift</td>
<td>The Pitch shift value specifies a pitch shift for the selected event. Event-based pitch shift is calculated after the project key and any pitch shift assigned to a track. For more information, see Changing tempo, time signature, and key on page 79.</td>
</tr>
<tr>
<td>Speed</td>
<td>The Speed setting allows you to change the playback speed of an event on a one-shot track. Changing the speed also changes the pitch.</td>
</tr>
<tr>
<td>Quick fade edges to prevent clicks</td>
<td>When you add an offset to an event so that it does not end on a loop point, you can introduce an audible click at the edges of the event. Select the Quick fade edges to prevent clicks check box, and ACID performs a quick fade-in or fade-out on the event edges. To adjust a quick fade, zoom into the event and hover over the upper-left or upper-right corner of an event until the cursor is displayed as . Drag the edge of the fade to adjust its duration. For more information, see Setting an event's fade-in and -out envelope curve on page 70.</td>
</tr>
</tbody>
</table>

Using event envelopes

ACID enables you to use envelopes on individual events. Envelopes give you the ability to control each event's fade-in, fade-out, and overall volume. Envelopes are useful for transitional effects between events by subtly fading out one event's volume while another fades in.

These envelopes are different than track envelopes because they affect only the event whereas track envelopes can affect multiple events on the track. For more information, see Using track envelopes on page 97.

The event's volume level and fade curves are represented by a line on the event.

Setting an event's volume envelope

You can control an event's overall volume by setting an envelope at the desired decibel (dB) level.

1. Place the mouse pointer at the top of the event. The envelope cursor (Appears) appears.

2. Drag the volume line to the desired level. As you drag the volume line, ACID displays the event's decibel level.

![Volume envelope](image)

3. Release the mouse to set the event's dB level.

After you set the event volume level, you may change it later by dragging the envelope line.
EDITING EVENTS

Setting an event’s fade-in and -out envelope curve

You can control an event’s envelope fade-in and -out characteristics by adjusting the event’s envelope handles. These handles allow you to control the length and dB level of fade-ins and fade-outs. Also, you can change the type of curve that the event uses to control the volume’s fade characteristics.

1. Place the mouse pointer on the upper corner of the event. The envelope cursor ( Española) appears.
2. Drag the envelope cursor and position the envelope curve. As you drag the cursor, ACID displays the following information:
   • The event decibel level.
   • The length (in measures.beats.ticks) of the fade-in or fade-out.
3. Release the mouse to set the fade-in or fade-out characteristics.

Changing the event’s fade curve type

You can set an event’s fade curves (fast, linear, slow, smooth, or sharp) that are used to raise or lower the volume over time. Right-click the fade region, select Fade Type from the shortcut menu, and choose the appropriate fade curve from the submenu.

Creating crossfades between events

ACID allows you to quickly create crossfades between overlapping events painted on different tracks.
1. Select two events. The events must overlap, but do not need to be on adjacent tracks.
2. Press [F]. The end of the first event fades out, and the second event fades in.

For creative ways to use crossfades, see Creating DJ-style crossfades on page 194.
This chapter introduces you to several ACID features that increase your productivity, such as markers, regions, and snapping options. You’ll also learn about the different ways to change a project’s tempo, key and time signature. Finally, you’ll learn several options for adjusting the project timeline.

Using project markers and regions

ACID markers and regions identify areas of your project and provide navigational cues for quickly finding those areas. After you insert markers and regions, you may adjust their position along the project’s timeline and label them with meaningful names for your reference.

<table>
<thead>
<tr>
<th>Marker type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Marker (standard)</td>
<td>Markers identify specific reference points in your project. Points that you may want to identify are introductions, bridges, refrains, choruses, or whatever you choose.</td>
</tr>
<tr>
<td>Time marker</td>
<td>Time markers are fixed to the time ruler and mark absolute time in your project. They are very useful when scoring video.</td>
</tr>
<tr>
<td>Command marker</td>
<td>Command markers indicate when an instruction or function occurs in a streaming media file.</td>
</tr>
<tr>
<td>Regions</td>
<td>Regions subdivide your project into time segments. Regions have in and out points, which allow them to function as permanent time selections.</td>
</tr>
</tbody>
</table>

Working with standard markers

Markers are tools that can make creating music easier by identifying specific points along the project’s timeline. They can be named, moved, and serve as snap and navigational points for the cursor and events. When you place markers, ACID automatically numbers them in the order that you place them.

Placing markers

Markers are placed at the cursor position. You may place a marker in one of the following ways:

- From the **Insert** menu, choose **Marker**.
- Right-click the marker bar, choose **Markers/Regions** from the shortcut menu, and choose **Insert Marker** from the submenu.
- Press **M**. You may use this method to place a marker while the project is playing.
Moving markers
1. Place the mouse pointer on the marker to be moved. The hand cursor (巯) appears.
2. Drag the marker to the desired position.

Naming markers
ACID allows you to name markers in your project. You may want to name markers based on parts of the project. For example, you may want to identify choruses, refrains, bridges, or instrument solos as reference points along the timeline.
1. Place the mouse pointer on the marker to be named. The hand cursor (巯) appears.
2. Right-click the marker and choose Rename from the shortcut menu. A box appears next to the marker.
3. Type a marker name in the box and press Enter to save the name.

Tip: You can use the same steps to rename a marker. Alternately, you can double-click the marker and enter a new name.

Navigating to markers
While you are working on your project, you may have scrolled to a portion of the project where the cursor is not visible. There are two ways to move the cursor directly to the selected marker:
- Right-click the marker and choose Go To from the shortcut menu.
- Click the marker once.
- Press the number key (not on the numeric keypad) corresponding to the marker number.

Tip: You may also navigate from one marker to the next by pressing Ctrl+left/right arrow key.

Adjusting tempo to match cursor to marker
Position the cursor, right-click the marker tab, and choose Adjust tempo to match cursor to marker from the shortcut menu. The project tempo changes so that the cursor position matches the selected marker.

Deleting markers
You may remove markers from the project at any time. Because markers are automatically numbered when they are placed, ACID does not renumber the remaining markers when one is deleted. Rather, the remaining markers retain their numbers. However, if you add markers later, ACID begins numbering to fill the sequence gap.

For example, if you have five markers in your project and delete markers three and four, the remaining markers are listed as one, two and five. When you add markers again, ACID begins numbering the markers as three and four.
1. Place the mouse pointer on the marker to be deleted. The hand cursor (巯) appears.
2. Right-click the marker and choose Delete from the shortcut menu. The marker is removed from the project.
Working with time markers

Unlike standard markers, time markers are tied to absolute time within your project. They are added differently than standard markers and appear on the time ruler at the bottom of the track view. Otherwise, time markers can be manipulated just like other markers.

Placing time markers

Time markers are placed at the cursor position. You may place a time marker in one of the following ways:

- From the Insert menu, choose Time Marker.
- Press $\text{Alt}$ $\text{H}$. You may use this method to place a time marker while the project is playing back.

Note: ACID does not number time markers.

Adjusting tempo to match marker to cursor

Using this function with time markers is particularly useful when scoring video. For more information, see Scoring video with ACID on page 156.

Position the cursor, right-click the marker tab, and choose Adjust tempo to match marker to cursor from the shortcut menu. The project tempo changes so the time marker matches the cursor position.

You can also align the marker and cursor by holding $\text{Alt}$ while dragging the marker. For example, hold $\text{Alt}$ while dragging a time marker to a location on the beat ruler. The project tempo adjusts so the time at the marker occurs on a specific beat. For example, if you place a time marker at 10 seconds on the time ruler and hold $\text{Alt}$ while dragging the marker to 5.1 on the beat ruler, ACID adjusts the project’s tempo so the first beat of measure five occurs at ten seconds.

Working with command markers

Command markers add interactivity to a multimedia presentation streamed over the Internet. As your media plays, any number of other actions can be programmed to execute. These commands are a part of the Windows Media and RealMedia streaming formats. Most frequently, these actions add text or open a related Web site. The specific commands available vary depending on the final format of your project.

Note: Streaming media files can be played back from a hard drive or CD-ROM, but in order to stream properly across the Internet, the file must be on a streaming media server. Check with your internet service provider for details and availability of this service.
Placing command markers

Command markers appear on the command ruler, which is above the marker bar.

1. Position the cursor where you want to place the command marker.

2. From the **Insert** menu, choose **Command**, or press **C**.

3. Complete the Command Properties dialog:
   - From the Template drop-down list, choose a custom template. *For more information, see Saving command properties as a custom template on page 74*.
   - From the Command drop-down list, choose the type of command. *For more information, see Defining streaming media commands on page 75*.
   - Enter parameters in the Parameter box to define the behavior of the command.
   - Enter your own notes or comments in the Comment box.
   - Specify the timing of the command in the Position box. Command markers are automatically set to the current cursor position unless you change this value.

4. Click **OK**. The new command marker appears on the command bar.

   After you create a command marker, you can move the marker by dragging it to a new location.

**Editing command marker properties**

Double-click any command marker to open the Command Properties dialog and edit its contents. You can also right-click a command marker and choose **Edit** from the shortcut menu.

**Saving command properties as a custom template**

If you plan to use a command more than once, you can save command properties as a template. You can then reuse the command properties by selecting the template from the Template drop-down list.

1. Create a command and complete the Command Properties dialog.

2. Click in the Template box and enter a name for the template.

3. Click the **Save Template** button ( ).

**Tip:** ACID saves your metadata command templates in the cmdtemp.xml file in the ACID program folder. You can edit this file directly to modify your templates.
Defining streaming media commands

In a streaming media file, command markers can be used to display headlines, show captions, link to Web sites, or any other function you define.

ACID includes several command types that you may add to a streaming media file. Some command types are exclusive to either the Windows Media (WMA or WMV) or the RealMedia (RM) file types.

<table>
<thead>
<tr>
<th>Command</th>
<th>Player Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Windows Media and RealMedia</td>
<td>Indicates when an instruction is sent to the user’s Internet browser to change the content being displayed. With this command, you enter the URL that displays at a specific time during the rendered project’s playback.</td>
</tr>
<tr>
<td>TEXT</td>
<td>Windows Media</td>
<td>Displays text in the captioning area of the Windows Media Player located below the video display area. You enter the text that displays during playback.</td>
</tr>
<tr>
<td>WMClosedCaption</td>
<td>Windows Media</td>
<td>Displays the entered text in the captioning window defined by an HTML layout file.</td>
</tr>
<tr>
<td>WMTextBodyText</td>
<td>Windows Media</td>
<td>Displays the entered text in the text window defined by an HTML layout page.</td>
</tr>
<tr>
<td>WMTextHeadline</td>
<td>Windows Media</td>
<td>Displays the entered text in the headline window defined by an HTML layout file.</td>
</tr>
<tr>
<td>Title</td>
<td>Windows Media and RealMedia</td>
<td>Displays the entered text on the player’s title bar.</td>
</tr>
<tr>
<td>Author</td>
<td>Windows Media and RealMedia</td>
<td>Displays the entered text (author’s name) when a user selects ‘About this Presentation’ from the RealPlayer’s shortcut menu or ‘Properties’ from the Windows Media shortcut menu.</td>
</tr>
<tr>
<td>Copyright</td>
<td>Windows Media and RealMedia</td>
<td>Displays the entered copyright information when a user selects ‘About this Presentation’ from the RealPlayer’s shortcut menu or ‘Properties’ from the Windows Media shortcut menu.</td>
</tr>
<tr>
<td>HotSpotPlay</td>
<td>RealMedia</td>
<td>Allows you to define an area in the RealPlayer video display that users can click to jump to another RealMedia file.</td>
</tr>
<tr>
<td>HotSpotBrowse</td>
<td>RealMedia</td>
<td>Allows you to define an area in the RealPlayer video display that users can click to jump to a Web page that you specify.</td>
</tr>
<tr>
<td>HotSpotSeek</td>
<td>RealMedia</td>
<td>Allows you to define an area in the RealPlayer video display that users can click to jump to a point in the current RealMedia file.</td>
</tr>
</tbody>
</table>

Defining HotSpot commands

Hotspots are defined using the following parameter syntax:

- HotSpotPlay MM:SS (LEFT, TOP, RIGHT, BOTTOM) "LABEL" FILENAME
- HotSpotBrowse MM:SS (LEFT, TOP, RIGHT, BOTTOM) "LABEL" URL
- HotSpotSeek MM:SS (LEFT, TOP, RIGHT, BOTTOM) "LABEL" MM:SS

The Parameter box for a typical HotSpotBrowse command for a hotspot rectangle that is 50 pixels wide by 20 pixels tall and lasts for 10 seconds would look like this:

- HotSpotBrowse 00:10 (0, 0, 50, 20) "Sonic Foundry" http:\\www.sonicfoundry.com

All parameters are optional except the last. The hotspot defaults to the entire duration of the file and the entire video frame if the duration and dimensions are not specified.

Adjusting tempo to match cursor to marker

Position the cursor, right-click the marker tab, and choose Adjust tempo to match cursor to marker from the shortcut menu. The project tempo changes so that the cursor position matches the selected command marker.

Deleting command markers

To delete a command marker, right-click the marker and choose Delete from the shortcut menu.
Working with regions

Regions are useful tools that allow you to subdivide your project into time sections by designating in and out points along the timeline. Regions can function as permanent time selections for playback and editing purposes. Like markers, regions can serve as reference points and may be moved, named, and provide snap points for the cursor and events.

When you place regions, ACID automatically numbers them in the order that you place them.

Placing and moving regions

Regions are placed at the start and end points of a loop region (time selection). You may place a region in one of the following ways:

- From the Insert menu, choose Region.
- Right-click the marker bar, choose Markers/Regions from the shortcut menu, and choose Insert Region from the submenu.
- Press R.

After you place a region, you may change its position by dragging the region tag to the desired position.

Tip: You can move a region without changing its size by holding Alt while dragging either region tag.

Naming regions

ACID allows you to name the placed regions in your project. You may want to name regions based on parts of the project or to define the amount of time that the regions encompass. For example, you may want to identify introductions, solos, or special time-related features in your project as reference points.

1. Right-click the region’s start tag and choose Rename from the shortcut menu. A box appears next to the tag.
2. Type a region name and press Enter to save the name.
Navigating to regions

While you are working on your project, you may have scrolled to a portion of the project where the cursor is not visible. You may click in the track view to move and view the cursor or you may use region tags to bring the cursor into view.

To move the cursor to the selected region tag, right-click the region tag and choose Go To from the shortcut menu.

Tip: You may also navigate between regions in your project by pressing Ctrl+left/right arrow key or the number key (not on the numeric keypad) corresponding to the region number.

Selecting regions

You may use the region’s start and end tags to make a time selection across all tracks in your project. The information within the time selection can then be used for playback or editing.

To select a region, right-click a region tag and choose Select Region from the shortcut menu. The loop bar appears between the region tags and the tracks are highlighted.

Deleting regions

You may remove regions from the project at any time. Because regions are automatically numbered when they are placed, ACID does not renumber the existing regions when one is removed. Rather, the existing regions retain their numbers. However, if you add regions later, ACID begins numbering to fill the sequence gap that exists.

For example, if you have six regions in your project and delete regions four and five, the remaining regions are listed as one, two, three and six. When you add regions again, ACID begins numbering the regions as four and five.

To remove a region from a project, right-click the region tag marker and choose Delete from the shortcut menu.
Using snapping

Snapping helps you to align events in your project with other items. ACID is preset to snap event edges to the project's grid lines as you drag an event along the track. If snapping is enabled and the Grid Only option is turned off, the event's edges automatically align to these designated snap points:

- Cursor position
- Grid lines
- Markers
- Regions start and end points
- Loop region (time selection) in and out points

You may turn on snapping for these elements in the project or limit snapping to grid lines.

Choosing snapping options

If the snap function is preventing you from placing an event precisely where you want it, you may turn snapping off. Turning off snapping prevents events from automatically aligning to the cursor, grid lines, markers, regions, and time selections.

The Options menu allows you to toggle snap functions. The button image next to the Enable command indicates when snapping is turned on. The button image next to the Grid Only command indicates the type of snapping in use.

Tip: You can temporarily suspend snapping while dragging by holding down the Shift key.

Turning snapping on and off

You may turn snapping on and off in one of the following ways:

- Click the Enable Snapping button ( ) on the Toolbar.
- From the Options menu, choose Snapping, and choose Enable from the submenu.
- Press F8.

Snapping to grid lines

With snapping turned on, you may choose to snap only to grid lines. From the Options menu, choose Snapping, and choose Grid Only from the submenu. The button image next to the command indicates that it is active.
Snapping to all elements

With snapping turned on, you may choose to snap to all elements. From the Options menu, choose Snapping, and choose Grid Only from the submenu. The button image next to the Grid Only command appears deselected when snapping to all elements.

Tip: Press [Ctrl]+[F8] to toggle between grid only and all elements.

Changing tempo, time signature, and key

You can set a tempo, time signature, and key for your ACID project. You can also make adjustments during playback.

ACID allows you to add specific tempo, time signature, and key changes within a project using tempo/key/time signature change markers. These markers appear on the marker bar above the track view. When the cursor passes over one of these markers, the master project tempo, key, and/or time signature changes in real time.

Changing project tempo

With ACID, you can change the tempo of a project without affecting the project’s key.

Changing tempo using the Project Tempo slider

Drag the Project Tempo slider at the bottom of the track list. Dragging the slider to the left slows the tempo, while dragging it to the right speeds the tempo.

Tip: Double-click the tempo value next to the Project Tempo slider to enter an exact value. Press Enter when you are finished.

As you drag the Project Tempo slider, a colored bar appears under each track’s name to represent the amount a track is being stretched to match the project tempo. The mark in the center of the bar represents the original tempo of a file. When the bar appears to the right of the mark, the project tempo is faster than the original file; when the bar appears to the left of the mark, the project tempo is slower than the original file. The amount of change also displays as a percentage at the right end of the bar.
As you drag the slider, a colored bar appears for each track.

Changing project tempo to match file tempo

Each track's shortcut menu contains the option Use Original Tempo. The original tempo of the file used on the track appears to the right of this option in the shortcut menu. To change the project's tempo to match the original file tempo, simply choose Use Original Tempo from the shortcut menu.

Changing project time signature

Click the Project Time Signature control and select a time signature from the menu to adjust a project's time signature. Select Other from the menu to enter a custom time signature.

Changing project key

Click the Project Key control and select a key from the menu to adjust a project's key.

This feature makes it possible to use media that are in different keys in the same project: each loop that has a specified root note is transposed to the key indicated by the Project Key control.

For example, if three loops have root notes of A, B, and C, and your Project Key control is set to D, ACID pitch-shifts the loops by five, three, and two semitones, respectively.

**Note:** If the root note for a track is set to Don't Transpose in the Track Properties window, the track does not pitch shift with the rest of the project.
Working with tempo/key/time signature change markers

Tempo/key/time signature change markers allow you to make changes to the tempo, key, and/or time signature at specified points in your project.

**Note:** Time signature changes must occur on the first beat of a measure.

Adding tempo/key/time signature change markers

1. Position the cursor where you want the change to occur.
2. From the **Insert** menu, choose **Tempo/Key/Time Signature Change**. The Tempo/Key/Time Signature Change dialog appears.
3. Select the check boxes for the types of changes you want to occur at the cursor position.
   - **Key Change** changes the key of all tracks until ACID encounters another tempo/key/time signature change marker.
   - **Tempo Change** changes the tempo of all tracks until ACID encounters another tempo/key/time signature change marker.
   - **Time Signature Change** changes the time signature of all tracks until ACID encounters another tempo/key/time signature change marker.
4. Specify the desired change information and click **OK** to close the dialog. A marker appears in the marker bar at the cursor position that displays the change information.

Editing tempo/key/time signature change markers

There are several ways to edit the tempo/key/time signature change marker:

- Position the cursor on or after the marker and adjust the **Project Tempo**, **Project Time Signature**, or **Project Key** controls. The marker’s text reflects the change.
- Right-click the marker, choose **Edit** from the shortcut menu, and enter the appropriate change in the Tempo/Key/Time Signature Change dialog.
- Double-click the marker and enter the appropriate change in the Tempo/Key/Time Signature Change dialog.

Adjusting tempo to match cursor to marker

Position the cursor, right-click the marker tab, and choose **Adjust Tempo to Match Cursor to Marker** from the shortcut menu. The project tempo changes so that the cursor position matches the selected marker.

Deleting tempo/key/time signature change markers

To delete a marker, right-click the marker and choose **Delete** from the shortcut menu.
Changing a track’s key

You can change the key of an entire track without affecting the project’s key. For creative ways to use track key changes, see Detuning paired tracks on page 187.

1. Right-click the track and choose Properties from the shortcut menu. The Track Properties window appears.
2. On the General tab, enter the number of semitones by which to adjust the key in the Pitch Shift box or use the spinner control. Use the minus (-) key for negative values.
3. Close the Track Properties window. The pitch shift displays in the track’s icon.

Tip: Another way to change the key of the track is to select the track in the track list and press $+$ or $-$ on the numeric keypad.

Changing an event’s key

You can change the key of an individual event without affecting the pitch of the track or project.

Right-click the event in the track view, choose Pitch Shift from the shortcut menu, and choose Up Semitone or Down Semitone from the submenu. The pitch shifts one semitone in the direction specified, and the amount of shift displays on the event itself.

You can also change an event’s key using keyboard shortcuts. For more information, see Event commands on page 20.

Adjusting time

ACID provides two commands for adjusting your project’s timeline: Insert Time and Fit to Time.

Inserting time

Use the Insert Time command to insert a specified amount of blank space into the project at the current cursor position. This feature can be used to create space in the project for new events.

1. Position the cursor where you want to insert time.
2. From the Insert menu, choose Time. The Insert Time dialog appears.
3. Enter the amount of time you want to insert and click OK.

Note: The Insert Time dialog uses the measures.beats.ticks format used by the beat ruler.
Fitting to time

The Fit to Time command allows you to adjust the project’s overall length to a specified amount of time.

---

**Note:** The maximum and minimum length is limited to reduce the possibility of creating audible artifacts through the compression/expansion process.

---

1. From the **Edit** menu, choose **Fit to Time**. The Fit to Time dialog appears with the current project length displayed in the **New length** box.

   ![Fit to Time dialog](image)

2. Enter the new project length in the **New length** box. The length is always entered in time format, regardless of the format used on the time ruler.

3. Click **OK**. The dialog closes and ACID adjusts the tempo to alter the project’s length.
Using the Chopper

The Chopper allows you to quickly create slice-and-dice effects. For creative ways to use the Chopper, see Slicing and dicing in the Chopper on page 193.

Working in the Chopper window

Selecting a track automatically places it in the Chopper where it can be immediately manipulated and inserted into the track view.

Viewing the Chopper

To display the Chopper, choose Chopper from the View menu or press Alt + 2.

Changing the Chopper grid

The Chopper's grid uses the same increments available on the track view. To change the grid display, right-click the waveform area of the Chopper, choose Grid Spacing from the shortcut menu, and choose the desired display from the submenu.

Changing Chopper snapping options

The snapping behavior of the track view and Chopper are linked. To enable snapping in both components, choose Snapping from the Options menu and choose Enable from the submenu, or press F8.

When snapping is turned on, you can choose between snapping only to the grid or snapping to all elements. For more information, see Using snapping on page 78.
Magnifying the Chopper

There are three ways of adjusting the magnification of the Chopper.

- Click the Zoom In Time ( ) and Zoom Out Time ( ) buttons located in the lower-right corner of the window.
- Click within the Chopper and use the mouse wheel.
- Quickly magnify a selection by right-clicking and choosing Zoom to Loop Region from the shortcut menu.

Previewing in the Chopper

The Chopper contains a dedicated transport bar that can be used to preview selections prior to inserting them into the project.

Using Chopper toolbar and keyboard commands

In addition to the transport bar, the Chopper contains a toolbar that is designed to make creating selections quick and easy. The following table briefly describes the toolbar buttons and the associated keyboard commands.

<table>
<thead>
<tr>
<th>Button</th>
<th>Keyboard</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![insert]</td>
<td></td>
<td>Inserts the Chopper selection in the track view at the current cursor position.</td>
</tr>
<tr>
<td>![comma]</td>
<td>Ctrl + (comma)</td>
<td>Shifts the track view’s cursor position to the left by the length of the increment arrow.</td>
</tr>
<tr>
<td>![period]</td>
<td>Ctrl + (period)</td>
<td>Shifts the track view’s cursor position to the right by the length of the increment arrow.</td>
</tr>
<tr>
<td>![N]</td>
<td></td>
<td>Links the length of the increment arrow with the length of the selection. When toggled on, the length of the increment remains equal to the length of the selection. When toggled off, you can configure the increment independently of the Chopper selection.</td>
</tr>
<tr>
<td>![semicolon]</td>
<td></td>
<td>Halves the length of the Chopper selection.</td>
</tr>
<tr>
<td>![apostrophe]</td>
<td></td>
<td>Doubles the length of the Chopper selection.</td>
</tr>
<tr>
<td>![comma]</td>
<td>Ctrl + (comma)</td>
<td>Shifts the Chopper selection to the left by the length of the selection.</td>
</tr>
<tr>
<td>![period]</td>
<td>Ctrl + (period)</td>
<td>Shifts the Chopper selection to the right by the length of the selection.</td>
</tr>
<tr>
<td>Ctrl + Shift + (comma)</td>
<td></td>
<td>Shifts the selection left by the increment length.</td>
</tr>
<tr>
<td>Ctrl + Shift + (period)</td>
<td></td>
<td>Shifts the selection right by the increment length.</td>
</tr>
<tr>
<td>Ctrl + (semicolon)</td>
<td></td>
<td>Doubles the length of the increment arrow.</td>
</tr>
<tr>
<td>Ctrl + (apostrophe)</td>
<td></td>
<td>Halves the length of the increment arrow.</td>
</tr>
<tr>
<td>![R]</td>
<td></td>
<td>Inserts a region.</td>
</tr>
<tr>
<td>![M]</td>
<td></td>
<td>Inserts a marker.</td>
</tr>
<tr>
<td>![I]</td>
<td></td>
<td>Marks the start point of a loop region.</td>
</tr>
<tr>
<td>![D]</td>
<td></td>
<td>Marks the end point of a loop region. Once the endpoint is established, the loop region becomes highlighted.</td>
</tr>
</tbody>
</table>
Inserting markers and regions in the Chopper

When working with events in the Chopper, you can drop markers and create regions just like in the track view. For more information, see Using project markers and regions on page 71.

These markers and regions are saved with the project when it is saved. They can also be saved back to the original media file by clicking the Save File button ( ) in the Track Properties window. For more information, see Saving file properties on page 109.

Creating selections in the Chopper

After you place a file in the Chopper, you can use the toolbar, transport bar, and mouse (or their keyboard equivalents) to create and preview selections within the file. When you have made the selection you want, you can insert the selection into the track view.

Placing files in the Chopper

To place a file in the Chopper, do any of the following:

- Select a track in the track list.
- Select an event.
- Right-click an event and choose Select in Chopper from the shortcut menu.

Note: If you choose Select in Chopper on an event that contains only a portion of a file, ACID places the entire contents of the file in the Chopper. The part of the waveform selected, however, matches the contents of the selected event. This allows you to see the event in the context of the entire media file.

Creating selections

To create a selection, drag the mouse, or hold Shift while pressing the arrow keys. A shaded region appears in the Chopper to indicate the current selection, and its start point, end point, and length display at the bottom-right corner of the window in measures.beats.ticks format. You can preview the selection at any time by clicking the Play button ( ) on the Chopper’s transport bar or pressing Space.
**Note:** In addition, an increment arrow appears on the track view above the selected block. For more information, see *Inserting increments on page 88.*

As you make a selection in the Chopper, a colored block appears in the track view. This block indicates where the selection will be placed on the track view when you insert it from the Chopper.

Creating selections of a specific musical length

You may want to create a selection with a length corresponding to a musical value. You can easily do this in ACID using the Chopper's selection shortcut menu.

1. Create a selection or place the cursor in the Chopper. *For more information, see Creating selections on page 87.*

2. Right-click and choose the desired musical length from the shortcut menu. ACID creates a selection equal to the specified musical length.

Inserting increments

In addition to creating selections, the Chopper allows you to configure the sections of silence between selections painted on a track. When you click the *Link Arrow to Selection* button ( ), ACID links the increment arrow length with the selection length. This forces the increment and selection lengths to remain equal, thereby allowing you to insert selections seamlessly, end-to-end, in the project.

When the *Link Arrow to Selection* button is toggled off, the increment arrow is displayed in black and you are able to establish a increment length that is independent of the selection length. The increment arrow can be set by dragging either end of the arrow or by using the increment shortcut menu.

When the increment length is greater than the length of the selection, ACID inserts an appropriate amount of silence following the selection when you insert it in the track view. This affects the track’s insert position and allows you to paint selections separated by the specified increment.
When the increment length is less than the length of the selection, ACID overlaps the selections as you insert them in the track view.

![Increment less than selection](image1)

![Selection overlaps when inserted three times](image2)

**Creating increments**

1. Verify that the Link Arrow to Selection button ( ) is toggled off and the increment arrow is displayed in black.

2. Drag the point of the arrow to configure an increment of the desired length.

   **Tip:** While dragging the increment arrow, the Chopper’s middle status value temporarily displays the length of the increment.

**Creating increments of a specific musical length**

The increment shortcut menu, like the selection shortcut menu, allows you to create increments that correspond to the specified musical length.

1. Verify that the Link Arrow to Selection button ( ) is toggled off and the increment arrow is displayed in black.

2. Right-click the increment arrow and choose the desired musical value from the shortcut menu. The increment length is automatically configured to the selected value in both the Chopper and the track view.

**Creating increments of a custom musical length**

1. Verify that the Link Arrow to Selection button ( ) is toggled off and the increment arrow is displayed in black.

2. Right-click the increment arrow and choose Custom from the shortcut menu. The Custom Length dialog appears.

3. Choose the desired increment format from the drop-down menu.

4. Enter an appropriate value in the adjacent box and click OK. The increment length is automatically configured to the selected value in both the Chopper and the track view.

   **Note:** It is possible to set an increment value that results in the increment arrow extending beyond the scope of the Chopper. If this occurs, an accurate depiction of the increment still appears in the track view.
Inserting selections in the track view

You can add selections from the Chopper to your project in several ways.

Using the Insert Selection button

After you create the desired selection and increment, you can insert the selection in the project at the track view’s cursor position by clicking the Insert Selection button (Insert). After the Chopper inserts the audio, the cursor moves to the end of the increment.

- If the increment length is equal to the selection length, selections are painted end-to-end.
- If the increment length is greater than the selection length, an appropriate amount of silence is painted prior to the next insert position.
- If the increment length is less than the selection length, selections overlap.

Using copy and paste

You can right-click the selection in the Chopper and choose Copy from the shortcut menu to copy the current selection to the clipboard. You can then use the Paste command to insert the selection in the track view. After the event is pasted, the cursor advances to the end of the pasted event.

Note: When you paste a selection from the Chopper to the track view, ACID ignores the increment setting.

Dragging selections

You can drag a Chopper selection from the Chopper to the track view. Release the mouse at the location where you want to insert the selection.

Moving the insert position in the track view

Click the Move Track View Cursor Left button ( ) and the Move Track View Cursor Right button ( ) to move the current insert position in the track view left/right by the increment length.

Saving Chopper selections as new files

You can quickly create a new loop by making a selection in the Chopper and saving the selection as a new file. ACID adds the file to your project as a new track.

1. Make a selection in the Chopper.

Tip: You can also drag a selection from the Chopper to the track list.

3. In the File name box, enter a name for the new file.
4. From the Save as type box, choose a file format for the new file.
5. From the Template drop-down list, choose a template for rendering the file, or click Custom to create custom rendering settings. For more information, see Creating custom rendering settings on page 55.

6. Click Save.

ACID saves the selection and adds the file as a loop to a new track in the project.

Using the Chopper with one-shots

Selections of loops and Beatmapped files transfer flawlessly between the Chopper and the track view because the beats are clearly identified. However, one-shot files present more of a problem. You can use the following method to create accurate single-hit selections in one-shot files.

1. Verify that ACID’s snapping options are active. If snapping is not active, choose Snapping from the Options menu and choose Enable from the submenu, or press F8.

2. Verify that the Link Arrow to Selection button is selected.

3. Create a selection of the desired musical length in the Chopper. For more information, see Creating selections of a specific musical length on page 88.

4. From the Options menu, choose Snapping, and choose Enable from the submenu, or press F8 to toggle all snapping options off.

5. Click the Link Arrow to Selection button to toggle the linking option off. You can now adjust the selection without changing the increment.

6. Drag the middle of the increment arrow to reposition selection length in the Chopper.

7. Use the mouse and/or keyboard to fine-tune the selection. The increment arrow does not change.

8. Insert the desired selection data in the track view. For more information, see Inserting selections in the track view on page 90.

9. Repeat steps six through eight to insert all desired selections in the track view.
CHAPTER 7 - WORKING WITH TRACKS

This chapter covers advanced track features including track effect chains, track envelopes, and stereo panning modes. You'll also learn more about track types, track properties, and rendering tracks to new files.

Using track effects

ACID enables you to create DirectX plug-in chains, adjust the order of plug-ins on a chain, bypass a plug-in, remove plug-ins from the chain, and save frequently used chains as presets.

The EQ plug-in is assigned to all tracks by default; however, it does not use CPU power or affect the sound until you adjust its settings. You can remove the EQ plug-in if desired. For more information, see Removing plug-ins from chains on page 95.

**Important:** We recommend that you do not use time-altering effects (such as time stretch, gapper/snipper, pitch-shift without preserving duration, and some vibrato settings) with an ACID project. Time-altering effects cause a track to play out of synchronization with the waveform display in the track view and with other tracks.

In addition, you can use effect plug-ins in the Mixer window by applying effect chains to busses or soft synths, or by creating assignable effect chains and routing tracks to them. For more information, see Using the Mixer on page 111.

Creating or adding to track plug-in chains

A plug-in chain can contain one or more plug-ins. When you add multiple plug-ins, you may set the processing sequence that the track’s events go through when the project is played back. Moreover, the plug-ins that you add to the chain may be added more than once. For example, a plug-in chain could look something like this: EQ, Compression, EQ, and Noise Gate.

After you create a plug-in chain, ACID processes the track’s events by each plug-in in its respective order on the chain. The events’ effects processing is cumulative, so in some cases, you may want to rearrange the order of plug-ins to achieve the desired sound. For more information, see Arranging plug-in chain order on page 95.

1. Click the Track FX button ( ). The Audio Plug-In window appears.

**Note:** The Track FX button indicates whether the current plug-in chain includes automatable effects ( ) or does not include automatable effects ( ). By default, an ACID Pro track plug-in chain includes the Track EQ plug-in, which is automatable. For more information, see Adding effect automation envelopes on page 98.
2. Click the Edit Chain button ( ) to display the Plug-In Chooser dialog.

3. Select the plug-ins that you want to add. There are three ways to add a plug-in to the chain:
   - Double-click the plug-in.
   - Drag the plug-in to the chain area.
   - Select the plug-in and click the Add button.

4. Rearrange the order of plug-ins as needed by dragging plug-ins to different locations in the chain or by selecting a plug-in and clicking the Shift Plug-In Left ( ) and Shift Plug-In Right ( ) buttons.

5. Click OK. The Plug-In Chooser dialog closes. The Audio Plug-In window displays the plug-in chain and the settings for the plug-in last selected on the Plug-In Chooser dialog.

6. Click a specific plug-in and adjust the effect’s parameters manually, or choose one of the presets from the Preset drop-down list. For more information about effect parameters, click the Plug-In Help button ( ) in the Audio Plug-In window.

   **Tip:** You can save an effect’s parameters as a preset to be used in other projects. To save a preset, enter a name in the Preset box and click the Save Preset ( ) button.

7. Click the Close button ( ) to close the Audio Plug-In window.

You can use a track effect chain as a default for all new tracks you create. For more information, see Setting default track properties on page 178.

**Automating plug-in parameters**

You can automate the parameters of certain plug-ins by adding envelopes to the track. For more information, see Adding effect automation envelopes on page 98.
Arranging plug-in chain order

The plug-ins are cumulative during playback. For example, when the track’s signal passes through the EQ, it carries the EQ’s settings as it passes through the compression plug-in, then the signal carries both those plug-in settings to the next plug-in.

Because of this cumulative effect, you may need to arrange plug-ins in a certain order so that one plug-in’s processing does not adversely affect the next plug-in on the chain. There is no right or wrong way to order plug-ins, although some plug-ins work better when they follow another. However, the plug-in order in the chain is strictly based on your preferences and desired output.

1. Click the Track FX button ( ). The Audio Plug-In window appears.
2. There are two ways to arrange plug-ins in your chain:
   • Drag the plug-in to a new location in the chain.
   • Right-click the plug-in and choose Move Left or Move Right from the shortcut menu.
3. Click the Close button ( ) to close the Audio Plug-In window.

Bypassing plug-ins in a chain

You can bypass a plug-in without removing it from the chain by clearing the check box for the plug-in. Alternately, right-click the plug-in and choose Bypass from the shortcut menu.

Tip: To bypass (or re-enable) all plug-ins in a chain, right-click the Track FX button ( ) and choose Bypass All or Enable All.

Bypassing effect automation

For plug-in chains that include effect automation using envelopes, you can bypass automation by clicking the Bypass FX Automation button ( ). This does not remove any effect automation envelopes from the track, but rather temporarily bypasses processing of the effect automation. You can toggle this button on and off to hear the difference between the plug-in chain as a standard (non-automated) effect versus an automated effect.

Removing plug-ins from chains

1. Click the Track FX button ( ). The Audio Plug-In window appears.
2. Right-click the plug-in and choose Remove from the shortcut menu, or click the Remove Selected Plug-In button ( ).
3. Click the Close button ( ) to close the Audio Plug-In window.

Tip: To remove all plug-ins in a chain, right-click the Track FX button ( ) and choose Delete All.
Saving plug-in chains as packages

ACID allows you to save plug-in chains as packages so that you may use them again with other projects. If you use a combination of plug-ins often, saving them as a package saves you time. Effect packages retain their chain order and individual plug-in settings.

You may save plug-in chains as packages from existing chains on tracks or when you are creating a plug-in chain. The plug-in chains that you save as packages appear in the Plug-In Chooser dialog in the Packaged Chains folder. You can apply an effect package to a track the same way you assign a plug-in to a track.

Once you have created custom presets for effects or effect chains, you can use the Preset Manager to back up, transfer, or delete custom presets from any of the plug-ins you use in ACID. For more information, see Using the Preset Manager on page 124.

1. Click the Track FX button ( ). The Audio Plug-In window appears.

   *Note: If the track has no plug-in chain, clicking the Track FX button ( ) displays the Plug-In Chooser dialog.*

2. Click the Edit Chain button ( ) to display the Plug-In Chooser dialog.

3. Add and arrange plug-ins to create a plug-in chain and click OK.

4. Click a specific plug-in and adjust the effect’s parameters manually, or choose one of the presets from the Preset drop-down list. For more information about effect parameters, click the Plug-In Help button ( ) in the Audio Plug-In window.

5. Click the Save Chain Preset button ( ). The Save Plug-In Package dialog appears.

![Save Plug-In Package dialog](image)

6. Enter a name for the package.

7. Click OK to save the plug-in chain as an effect package.

Removing or bypassing all effects on tracks

You can clear a track of all effects by right-clicking the Track FX button ( ) and choosing Delete All from the shortcut menu.

You can bypass all of a track’s effects without removing them by right-clicking the Track FX button ( ) and choosing Bypass All from the shortcut menu. To apply them again, right-click the Track FX button ( ) and choose Enable All from the shortcut menu.
Using track envelopes

Track envelopes allow you to control volume, panning, assignable effect send levels, bus send levels, and effect parameters (for effects that support automation) for a specific track. You can distinguish the various envelopes by their color.

<table>
<thead>
<tr>
<th>Envelope type</th>
<th>Envelope color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Volume</td>
<td>Blue</td>
</tr>
<tr>
<td>Pan</td>
<td>Red</td>
</tr>
<tr>
<td>Bus send</td>
<td>Purple</td>
</tr>
<tr>
<td>Assignable effect send</td>
<td>Green</td>
</tr>
<tr>
<td>Effect automation</td>
<td>Wood tones (various)</td>
</tr>
</tbody>
</table>

Tip: You can customize ACID envelope colors. For more information, see Using the Other tab on page 185.

Adding track envelopes

This section describes how to add each type of track envelope. For creative ways to use track envelopes, see ACID Tips and Tricks on page 187.

Adding volume or pan envelopes

1. Select the track to which you want to add the envelope. (You may select multiple tracks.)

2. Add the envelope to the selected track(s) in one of following ways:
   - From the Insert menu, choose Envelopes, and choose Volume or Pan from the submenu.
   - Right-click the track header in the track list, choose Insert/Remove Envelope from the shortcut menu, and choose Volume or Pan from the submenu.
   - Press Shift + V (volume envelope) or Shift + P (pan envelope).

A blue line appears across the track(s) for a volume envelope, and a red line appears across the track(s) for a pan envelope.

Note: Because the default panning mode is additive, you can introduce clipping when panning a track to the left or right. Choose an appropriate pan type and adjust the track volume accordingly. For more information, see Choosing stereo pan types on page 103.
Adding bus envelopes

A bus envelope controls the level of a track sent to a particular bus. Before you can add a bus envelope, you must add busses to the project. For more information, see Adding busses to the project on page 111.

1. Select the track to which you want to add the bus envelope. (You may select multiple tracks.)

2. Add the envelope to the selected track(s) in one of the following ways:

   - From the Insert menu, choose Envelopes, and choose the bus for which you want to add an envelope from the submenu.
   - Right-click the track header in the track list, choose Insert/Remove Envelope from the shortcut menu, and choose the appropriate bus from the submenu.

   A purple line representing the envelope appears across the track(s).

Adding assignable effect envelopes

An assignable effect envelope controls the level of a track sent to a particular assignable effect chain. Before you can add an assignable effect envelope, you must add an assignable effect chain to the project. For more information, see Adding assignable effect controls on page 113.

1. Select the track to which you want to add the assignable effect envelope. (You may select multiple tracks.)

2. Add the envelope to the selected track(s) in one of the following ways:

   - From the Insert menu, choose Envelopes, and choose the assignable effect chain for which you want to add an envelope from the submenu.
   - Right-click the track header in the track list, choose Insert/Remove Envelope from the shortcut menu, and choose the appropriate assignable effect chain from the submenu.

   A green line representing the envelope appears across the track(s).

Adding effect automation envelopes

If a plug-in supports automation, you can use envelopes to adjust effect parameters over time. The appearance of the plug-in in the Plug-In Chooser window indicates whether the plug-in supports automation. Plug-ins with this icon ( ) support automation, while plug-ins with this icon ( ) do not. In addition, you can quickly locate plug-ins that support automation in the Automatable subfolder.

For creative ways to use effect automation envelopes, see Creating wah-wah effects with automated Track EQ on page 191 and Turning automated effects on and off on page 192.

1. Click the Track FX button ( ) on a track to open the Audio Plug-In window.

   If no track effects exist, clicking the Track FX button displays the Plug-In Chooser. Use the Plug-In Chooser to create an effect chain including an automatable plug-in. For more information, see Creating or adding to track plug-in chains on page 93.

2. Click the FX Automation button ( ) to display the FX Automation Chooser.

3. Click a plug-in at the top of the FX Automation Chooser. A list of the effect’s automatable parameters appears.
4. Select the check box for each parameter that you want to control with an envelope. You can use the Select All and Select None buttons to quickly change your selections to all or none of the parameters.

5. Click OK to close the FX Automation Chooser.

Envelopes display on the track for parameters that you selected in the FX Automation Chooser. To control which effect parameter envelope displays on the track, click the arrow adjacent to the Track FX button ( ) and choose an envelope from the menu.

Tip: Press E to toggle through the display of all effect parameter automation envelopes.

Adjusting envelopes

To adjust the overall level of an envelope, simply drag the envelope line up or down. A tooltip displays the amount of the adjustment as you drag. You can adjust envelopes in real time.

You can also change the level of an envelope over time by adjusting individual envelope points that you place along the envelope line.

Tip: If you have multiple envelopes on a track, hover over an envelope to display a tooltip indicating the name of the envelope.

Adding envelope points

After you have inserted an envelope, you can add envelope points to control the level of signal or amount of panning at specific points in time.

1. Place the mouse pointer on the envelope line. The envelope cursor ( ) appears.

2. Add an envelope point in one of the following ways:
   - Double-click the envelope.
   - Right-click the envelope and choose Add Point from the shortcut menu.

Tip: If you add too many points, you may delete a point by right-clicking it and choosing Delete from the shortcut menu. You may also clear all envelope points by selecting Reset All from the shortcut menu.
Adjusting individual envelope points

You can set the level of each envelope point by dragging it up or down. As you move an envelope point, a tooltip displays both the point's occurrence on the timeline and its level.

Other ways to set the level include:

- Right-click an envelope point and choose a setting from the shortcut menu.
- Choose Select All from the shortcut menu to raise or lower all points on the envelope.
- Right-click an envelope point and choose Set To from the shortcut menu. This displays a box in which you can specify a setting.

You can adjust an envelope point's location on the timeline by dragging it right or left. If snapping is enabled, the envelope point snaps to time divisions as you drag. Hold Shift while dragging to override snapping. For more information, see Using snapping on page 78.

Flipping envelopes

You can flip an envelope to invert the envelope around its center.

1. Right-click a track that has an envelope. A shortcut menu appears.
2. From the shortcut menu, choose Flip Envelope, and choose the type of envelope to flip from the submenu.

Changing envelope fade curves

You may set the type of fade curve that occurs between envelope points: linear, fast, slow, smooth, sharp, or hold. To change the fade curve, right-click an envelope between two envelope points and choose the appropriate fade curve from the shortcut menu.

Locking envelope points to an event

From the Options menu, choose Lock Envelopes to Events if you want envelope points to move with an event when it is moved along the timeline.

Using the Envelope tool

The Envelope tool is designed to manipulate multiple envelope points. Use the Envelope tool when you want to edit envelope points but do not want to change other elements of the project. With the Envelope tool selected, events cannot be moved or edited.

Selecting and moving envelope points

To select multiple envelope points using the Envelope tool, click the track that contains the envelope and drag your cursor in the track view to select the points you want to move. Selected points display in an alternate color. Click any selected point and drag it to the new position; all selected points will follow.

To deselect the points, click anywhere outside the selection.
Cutting, copying, and pasting envelope points

1. Select the Envelope tool using one of the following methods:
   - From the **Edit** menu, choose **Editing Tool**, and choose **Envelope** from the submenu.
   - Click the **Envelope Tool** button ( ) on the toolbar.

2. Click within a track to select it.

3. Drag along the timeline to select envelope points.

4. From the **Edit** menu, choose **Cut** or **Copy**.

5. Position the cursor where you want to paste envelope points across a track.

6. From the **Edit** menu, choose **Paste**.

Copying envelopes to another track

1. Select the Envelope tool using one of the following methods:
   - From the **Edit** menu, choose **Editing Tool**, and choose **Envelope** from the submenu.
   - Click the **Envelope Tool** button ( ) on the toolbar.

2. Click within a track to select it.

3. From the **Edit** menu, choose **Select All**.

4. From the **Edit** menu, choose **Cut** or **Copy**.

5. Click within a track to select it.

6. Click the **Go to Start** button ( ) if you want the envelope to appear exactly as it was in the original track, or click to position the cursor where you want the envelope to start.

7. From the **Edit** menu, choose **Paste**.

Hiding track envelopes

After you have created your envelope and set your envelope points, you may hide the envelope. Hiding an envelope does not affect the envelope point settings or track playback.

Hiding volume, pan, bus, or assignable effect envelopes

1. Select the track(s) whose envelope(s) you want to hide.

2. From the **View** menu, choose **Show Envelopes**. A submenu appears. A check mark next to an envelope type indicates that it is visible in the track view.

3. From the submenu, choose the type of envelope you want to hide. The specified envelope type no longer appears in the track view for the selected track.

   You can use the same steps to display the envelope again.

   **Tip:** Select a track and press **[V]** to hide a volume envelope or **[P]** to hide a panning envelope. Press the key again to display the envelope.
Hiding effect automation envelopes on a track

To hide effect parameter envelopes, click the arrow adjacent to the Track FX button ( ) and choose Hide All FX Automation Envelopes from the menu. To display envelopes again, click the arrow adjacent to the Track FX button ( ) and choose Show All FX Automation Envelopes from the menu.

Tip: Press E to toggle through the display of all effect parameter automation envelopes.

Removing track envelopes

You can remove envelopes from tracks quickly and easily.

Note: When you remove an envelope from a track and then add it again, you must recreate its envelope points.

Removing volume, pan, bus, or assignable effect envelopes

1. Select the track(s) from which you want to remove the envelope(s).
2. From the Insert menu, choose Envelopes. A submenu appears showing a check mark next to the envelopes being used.
3. From the submenu, choose the type of envelope you want to remove. The envelope type is removed from the selected track(s).

Tip: Press Shift + V to remove a volume envelope or press Shift + P to remove a pan envelope.

Removing effect automation envelopes

1. Click the arrow adjacent to the Track FX button ( ) and choose FX Automation from the menu. The FX Automation Chooser appears.
2. Click the plug-in whose automation envelopes you want to remove. The parameters for the effect appear in the dialog.
3. Clear the check boxes for the envelopes to be removed.
4. Click OK.

Tip: You can bypass effect automation without removing envelopes. For more information, see Bypassing effect automation on page 95.
Choosing stereo pan types

When you pan a track using the multipurpose slider or a pan envelope, you can choose among several pan types to determine how ACID pans the track.

**Note:** When applying stereo pan types, ACID interprets a monaural track as a stereo track with the same data in both channels.

1. Click the multipurpose slider label and choose **Pan**. The pan slider appears.
2. Click the multipurpose slider label again, choose **Pan** from the menu, and choose a pan type from the submenu.
   - **The Add Channels** pan type is most useful for panning stereo source material. This pan type makes the stereo image appear to move as a unit between the speakers. As the fader is moved from the center to a side, more and more of the signal from the opposite side is folded into the side you are panning towards, until at the extreme, both channels are fed at full intensity into a single channel. This pan type uses a linear panning curve.
   - **The Balance** pan type is most useful for adjusting the relative signal levels of the right and left channels in stereo source material. In this pan type, moving from the center to a side, the opposite side starts at a base dB level (either 0 dB, -3 dB, or -6 dB) and decays to no signal level. The signal in the side you are panning towards starts at the base dB level (either 0 dB, -3 dB, or -6 dB) and increases to 0 dB. When the stereo source is panned fully to one side, that side plays at 0 dB while the other side provides no signal at all. This pan type uses a linear panning curve.
   - **The Constant Power** pan type is most useful for panning mono source material. As you move the fader from side to side, this pan type creates the illusion of the source moving around the listener from one side to the other, in a semi-circle. This pan type uses the constant-power panning curve.

You can choose a pan type as a default for all new tracks you create. For more information, see Setting default track properties on page 178.

Using the Beatmapper

When you add a file to a project that is longer than 30 seconds, ACID’s Beatmapper Wizard starts. This allows you to decide whether or not to add tempo information to the file.

The Beatmapper identifies a file’s downbeats and measures, allowing the file to stretch/compress in conjunction with the project’s tempo. A file added without the Beatmapper behaves as a one-shot, maintaining its original length regardless of the project tempo.

1. Add the file to your project. The Beatmapper Wizard starts if the file is longer than 30 seconds.

   **Note:** You can change the file length that triggers the Beatmapper in the Audio tab of the Preferences dialog. For more information, see Using the Audio tab on page 181.

2. Specify whether you want to use the Beatmapper Wizard:
   - Select the Yes radio button and click **Next** to detect measures and downbeats.
   - Select the No radio button and click **Finish** to close the Beatmapper and add the file as a one-shot.
3. Click the Play button (▶) to verify the downbeat marker's position. If the marker is positioned on a downbeat, click Next. Otherwise, drag the marker to the appropriate location and click Next. The Beatmapper draws the file’s waveform and places a region to indicate the length of the first measure.

**Tip:** The Reset button sets the downbeat marker back to its detected position.

4. Click the Play button (▶) to verify the measure’s length.
   - Select the Metronome check box to preview the measure with the assistance of a metronome.
   - Click the Halve Loop Region (/package) or Double Loop Region (package) button to change the length of the selection. If the Beatmapper misdetects the length of the measure, it may be off by either half or double the actual amount.
   - If the region is positioned correctly, click Next. Otherwise, drag the region markers to the appropriate locations and click Next.

The waveform appears with measure lengths selected.

5. Drag the Measure slider to scroll through the song and click the Play button (▶) to verify each measure's length. If the song's tempo is consistent, the measures are placed correctly. If the tempo fluctuates, you can drag the end of the measure selection to change the measure's position.

Changing the measure length affects the entire song; if adjusting the last measure of the song causes the first measure to be incorrect, the downbeat may not be positioned correctly, or the song’s tempo may not be consistent enough for the Beatmapper.

6. Click Next when the measure lengths are correct. The Beatmapper adds tempo information to your file and displays some additional options.

7. Specify your preferences for the following options:
   - Select the Change project tempo to match Beatmapped track check box if you want ACID to set your project tempo to match the tempo calculated by the Beatmapper Wizard. Selecting the check box ensures that your Beatmapped track plays at the original tempo.
   - Select the Preserve pitch of the Beatmapped track when tempo changes check box to maintain the track's original pitch regardless of the project's tempo.
   - Select the Save Beatmapper information with file check box if you want the file to open with the Beatmapper settings each time you use the file.

8. Click Finish to close the Beatmapper Wizard. The file is added to the project as a Beatmapped track.

9. Draw the event in the track view.

**Tip:** You can place the entire event by using the Paint ((Paint)) tool. With the Paint tool selected, press [Ctrl] while you click once in the track to place the Beatmapped file.
Understanding stretching properties

All loops on the ACID 4.0 CD-ROM (as well as all loop library CD-ROMs) contain stretching properties. This means that tempo and key information is stored in the loops, allowing the application to accurately perform its time stretching/compressing and pitch-shifting functions on these loops when placed in a project.

Keep in mind that you do not need to designate stretching properties for loops that you create for ACID projects. The application typically makes an accurate estimate regarding the loop file’s tempo. In addition, you can temporarily assign a root note to the file to allow it to be transposed to the project’s key. However, when creating custom loops for use in multiple projects, you should define stretching properties.

You can set the stretching properties for loops and Beatmapped tracks. For more information, see Adjusting stretching properties for loop or Beatmapped tracks on page 106.

Configuring track properties

Double-click a track icon (such as ) to display the Track Properties window.

Note: This section addresses track properties for non-MIDI tracks. For information on MIDI track properties, see Changing MIDI track properties on page 132.

Once you modify the properties of a track, ACID saves the information with your project, but does not alter the original media file. If you want, you can save your changes to the media file as well. For more information, see Saving file properties on page 109.

Note: When you edit a track in an external editor, changes to the sound file are reflected immediately after you save the file. Changes to a media file’s ACID properties are not updated in your ACID project until you click Reload on the Track Properties window.

Adjusting general track properties

The General tab displays information about the file associated with a track and allows you to change the track type (except for MIDI track types), apply pitch shifting to all events on the track, and adjust time stretching for Beatmapped tracks.

Changing track type

For non-MIDI tracks, choose a setting from the Track type drop-down list to change the way ACID handles the track.

<table>
<thead>
<tr>
<th>Track Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loop</td>
<td>When you select Loop, ACID transposes the track to the key of the project and stretches the track to fit the project tempo. Loops can be drawn across the track and will repeat end-to-end.</td>
</tr>
<tr>
<td>One-Shot</td>
<td>When you select One-Shot, ACID streams the track from the hard disk rather than storing it in RAM if it is longer than thirty seconds. One-shot files do not change tempo with the rest of the loops, and are not transposed to the project key. The Stretch tab is not available when One-Shot is selected.</td>
</tr>
<tr>
<td>Beatmapped</td>
<td>When you add a file that is longer than 30 seconds to a project, ACID’s Beatmapper Wizard allows you to add tempo information to the file.</td>
</tr>
</tbody>
</table>
Adjusting time stretching (Beatmapped tracks only)

If you want ACID to preserve the track’s pitch while you adjust the tempo, select the Preserve pitch when stretching check box. When the check box is cleared, you can still adjust the tempo of the track, but the pitch is also affected.

Adjusting pitch shift

Enter a value in the Pitch Shift box (or use the spinner control) to adjust the pitch of all events on the track.

Adjusting stretching properties for loop or Beatmapped tracks

The Stretch tab allows you to specify how ACID handles pitch shifting and time stretching for loop or Beatmapped tracks. After you have edited a file's properties, click the Save File button ( ) to embed ACID information with the file.

Tip: To save to a different file, click the Save File As button ( ).

If you cannot or do not wish to embed ACID information with the file, you can set the properties to suit your needs, and they will be saved with the ACID project (but not with the file). This means, however, that you must set the properties for every project where you use the loop. Configuring the stretching properties and clicking the Save File button ( ) allows you to “set and forget” the properties so the properties will be set for any project.

If you edit the file in another audio-editing program, ACID-specific data may be removed. If this occurs, simply set the stretching properties again and click the Save File button ( ).

Note: The Stretch tab for Beatmapped tracks is essentially the Beatmapper without the wizard.
Stretching properties for loop tracks

The following table describes the settings on the Stretch tab for loop files.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root note</td>
<td>Choose a note from the drop-down list to set the base note for loops that you want to conform to the project key. If you do not want a track transposed to the project key (a track that contains a drum sample, for example) choose Don’t transpose.</td>
</tr>
<tr>
<td>Number of beats</td>
<td>Choose a setting from the drop-down list to specify the length of the original file. Selecting a value that does not match the actual file causes the loop to play at a different speed. For example, specifying a length of 8 beats for a 4-beat loop causes the loop to play at half-speed at any given tempo. You can misinform ACID regarding the beat length of a loop for creative ends. For more information, see Playing double time/half time on page 189.</td>
</tr>
<tr>
<td>Stretching method</td>
<td>Stretching properties determine how ACID performs time compression and expansion on audio events. If you hear audio anomalies due to time compression, try editing the stretching properties of the track. Looping segments is the default stretching method, and it works well with most types of material. Choose Nonlooping segments for sustaining material such as synthesizer pads and held notes. Choose Pitch shift segments to shift the pitch of the track to adjust for increases or decreases in tempo. Using this option, you can eliminate some of the problems that occur with extreme tempo changes. For example, if you have slowed the project tempo down and hear echo artifacts, choosing Pitch shift segments can eliminate these artifacts. You can adjust stretching properties creatively. For more information, see Overriding compress/expand on page 193.</td>
</tr>
<tr>
<td>Force divisions at</td>
<td>Choose a setting from the drop-down list to adjust the resolution of beat detection. Higher settings increase resolution and lower settings decrease resolution. Audio that contains rapid notes—such as drum rolls—benefits from setting the divisions at a smaller fraction of a beat. Slower-paced material, however, may actually suffer from high resolution.</td>
</tr>
<tr>
<td>Additional transient detection</td>
<td>Enter a value in the box or use the spin control to adjust the amount of extra beat detection that ACID performs for the beat subdivision specified by the Force divisions at setting. A higher percentage detects a greater number of transients. Increasing this number can be advantageous when working with audio that has complex rhythms. Lower numbers are more suitable for synthesizer pads and other basic material.</td>
</tr>
</tbody>
</table>

Stretch markers for loop tracks

On the Stretch tab of the Track Properties window is a graphic of a track’s waveform along with the stretch markers that ACID has automatically placed in the file. These markers correspond to detected subdivisions of beats in the audio file. Accurately detecting beats is essential to making quality time compression/expansion.

The color of the markers on the beat ruler provides you with additional information. The following table describes the correlation between marker color and status.

<table>
<thead>
<tr>
<th>Marker Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>This is an auto-detected marker that has been placed on a beat by ACID.</td>
</tr>
<tr>
<td></td>
<td>This is a custom marker. A file may contain custom markers if its stretching properties have been adjusted previously, like the loops on the ACID CD.</td>
</tr>
<tr>
<td></td>
<td>This is a disabled marker.</td>
</tr>
</tbody>
</table>
Setting markers
You can use the mouse to add, move, disable, and delete markers from the track's beat ruler. The following table briefly describes each of these actions.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clicking</td>
<td>Resets all markers to their default state, but also sets all other values on this page back to default.</td>
</tr>
<tr>
<td>Dragging a marker</td>
<td>Moves markers on the beat ruler. Moving an auto-detected marker ( ) causes it to become a custom marker ( ).</td>
</tr>
<tr>
<td>Double-clicking an empty section of the marker ruler</td>
<td>Adds a new custom marker ( ) to the beat ruler.</td>
</tr>
<tr>
<td>Double-clicking an existing marker</td>
<td>Enables the marker and toggles it back to its default color ( ). Auto-detected markers cannot be removed.</td>
</tr>
<tr>
<td>Double-clicking a disabled auto-detected marker ( )</td>
<td>Removes the marker from the beat ruler.</td>
</tr>
</tbody>
</table>

Tip: Right-clicking a marker displays a shortcut menu that allows you to perform many of the same functions.

Stretching properties for Beatmapped tracks
The following table describes the settings on the Stretch tab for Beatmapped tracks.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Root note</td>
<td>Choose a note from the drop-down list to set the base note for tracks that you want to conform to the project key. If you do not want a track transposed to the project key, choose Don't transpose.</td>
</tr>
<tr>
<td>Original tempo</td>
<td>Displays the original tempo of the track as determined by the Beatmapper Wizard. Enter a value in the box or use the spin control to adjust the tempo.</td>
</tr>
<tr>
<td>Downbeat offset</td>
<td>Displays the location of the track's first downbeat as determined by the Beatmapper wizard. Enter a value in the box or use the spin control to adjust the location.</td>
</tr>
<tr>
<td>Beatmapper Wizard</td>
<td>Click the Beatmapper Wizard button to adjust a track's tempo information. For more information, see Using the Beatmapper on page 103.</td>
</tr>
</tbody>
</table>

Adjusting track properties for MIDI tracks
You can use the General tab to change the track's pitch and root note, as well as work with the tracks inside a MIDI file. The Piano Roll Editor and List Editor tabs allow you to view and edit all MIDI data. You can also load third-party OPT MIDI plug-ins on your system in the Track Properties window. For more information, see Working with MIDI on page 131.

Reloading files
Clicking the Reload button ( ) restores all settings from the media file. Any setting changes made on the Stretch tab of the Track Properties are discarded.

Clicking this button also updates the Track Properties window when changes are made to the properties from an external editor.
Replacing files

Clicking the Replace File button ( ) displays the Replace File dialog and allows you to replace the audio file on the current track with a new audio file. This feature only replaces the actual audio. All track timing, effects, and envelopes remain.

Tip: You can also replace a file by dragging an audio file from the Explorer and dropping it on the track name of an existing track.

Saving file properties

When you make changes in the Track Properties window, ACID saves the changes you have made in the project file, but does not alter the original media file. To save track property changes in the media file, click the Save File button ( ).

You can also click the Save File As button ( ) to save the changes to a new file. ACID saves the media with the modified track properties to a new file, and renames the track in the track list to reflect the change.

ACID saves all the information in the Track Properties window to your file except for any pitch-shifting you have applied and, for MIDI tracks, any volume or panning settings you have adjusted. ACID also saves any regions or markers you have created in the Chopper. For more information, see Inserting markers and regions in the Chopper on page 87.

Mixing multiple tracks to a single track

ACID allows you to mix a selected group of tracks or an entire project to a single-track stereo event. If your project includes any muted tracks, however, ACID does not mix those events into the new track. The original tracks and their events are unaffected when you mix to a single track.

Typically, you would use this feature when you are finished refining a few tracks and want to combine them to conserve processing power. Also, when you mix multiple tracks to a single stereo track, any envelope or track effects that you applied are rendered into the newly mixed-down track. You can also use this feature to downmix 5.1 surround projects to stereo.

This option also allows you to destructively process any track effect plug-ins.

1. Solo the tracks you want to mix. To mix down the whole project, skip to step two.

2. From the Tools menu, choose Render to New Track or press Ctrl+M. The Render to New Track dialog appears.

3. Complete the Render to New Track dialog:
   - From the Save in drop-down list, choose the location where you want to save the new media file.
   - Enter a name for the track in the File name box.
   - From the Save as type drop-down list, choose a file format.
   - From the Template drop-down list, choose an audio format from the template list, or click Custom to create custom rendering settings.

   Note: If you want to downmix a 5.1 surround project, choose a stereo rendering format.

   - Select the Render loop region only check box if you want to render only the loop region to the new mixed down track. Clear the check box to render the full length of the project.
4. Click Save. The time selection or project is mixed down to a new track and a copy of the file is saved in the folder specified.

As the tracks are being mixed down, a status bar appears in the lower-left corner of the ACID window. Tip: You may cancel the rendering process by clicking the Cancel button (×) on the status bar.

After ACID mixes down the new track, it appears at the bottom of the track view. If you mixed down the entire project, you may delete or mute the other tracks from the project, as they are all contained on the new track.

5. Use the Draw (🖌) tool to paint the waveform on the new track.

Exporting loops

From the File menu, choose Export Loops to create new loops using the original loop media files in your ACID project.

A new loop file is created for every tempo change in the project, which can result in multiple loop files being created from a single loop media file.

1. From the File menu, choose Export Loops. The Export Loops dialog appears.
2. From the Save in drop-down list, choose the drive or folder to which the new files will be saved.
3. From the Save as type drop-down list, choose the file format.
4. From the Template drop-down list, choose an audio format, or click Custom to create custom rendering settings.
5. Click Save. A progress dialog appears for each track as it is rendered to a file. ACID includes tempo information in the file name of each loop file created (e.g., bass 120.000 BPM. wav).
In the Mixer window, you'll manage the project's busses, assignable effects, and soft synth controls. In this chapter, you'll learn how to add each of these controls to the mixer and route individual tracks to them. You'll also learn about working with the mixer controls, including adjusting levels, muting, soloing, and adding effects. This chapter also describes how to automate mixer controls by viewing them in the track view and adding envelopes.

Using busses

Think of busses as virtual pathways where signals from multiple tracks or effects can be mixed. You can add as many as 26 busses to the Mixer window, which provides you with a great deal of flexibility and mixing power.

Busses are the last stage of the ACID signal flow and as such can be used to output audio signals to specific hardware. For more information, see Routing busses to system hardware on page 112.

Adding busses to the project

Add a bus to a project by clicking the Insert Bus button ( ) in the Mixer window or by choosing Bus from the Insert menu.

Adding multiple busses

1. Display the Project Properties dialog using one of the following methods:
   - Choose Properties from the File menu.
   - Press Alt + Enter.
2. Click the Audio tab.
3. Enter a value in the Number of stereo busses box and click OK. The busses are added to the Mixer window.

Routing tracks to busses

If your project contains multiple busses, you can assign tracks to specific bus outputs. To assign a track to a bus, click the Bus Assignment button ( ) on the track header and choose the desired bus from the menu.

Assigning tracks to busses allows you to apply settings to a series of tracks and to route tracks to a particular hardware output.

Note: The Bus Assignment button only appears if you have more than one bus in the project.
Adjusting the bus send level

You can adjust the level of a track sent to a bus with the multipurpose slider in the track list.

Tip: Bus sends are pre-volume by default. To change to post-volume, click the multipurpose slider label in the track list, choose the appropriate bus from the menu, and choose Post Volume from the submenu.

Routing busses to system hardware

You can route individual busses to specific system hardware for output. This allows you to configure busses to route output (projects or individual tracks) to sound cards, recording devices, mixing boards, etc.

By default, all busses are assigned to the Master bus. In this configuration, you can use busses for creating subgroups of tracks. For example, you could route all your drum tracks to a bus so you can adjust their levels together without changing their relative levels. However, you can also route busses to hardware outputs so you can use busses for sending tracks to external effects processors or for mixing on an external mixer.

Note: When you installed ACID, the application automatically identified all hardware available for output on your computer and listed these components as options on the Audio tab in the Preferences dialog. For more information, see Using the Audio tab on page 181.

To route busses to hardware, you must first verify whether you are using a Windows Classic Wave Driver, a DirectSound driver, or an ASIO driver as your audio device. Then you can choose the appropriate hardware device in the Mixer window.

1. From the Options menu, choose Preferences and click the Audio tab.
2. From the Audio device type drop-down list, choose Windows Classic Wave Driver or an ASIO driver.
3. Click OK to close the Preferences dialog.

Note: If you have chosen Microsoft Sound Mapper in the Audio device type drop-down list on the Audio tab, you cannot assign the bus to a different device.

4. In the Mixer window, click the Playback Device Selector button ( ) on the bus you want to route.
5. Choose a hardware device from the menu that appears.

Deleting busses

Just as you can add busses to a project at any time, you can also delete superfluous busses. When you delete a bus from a project, tracks assigned to it are reassigned to the Master bus.

Deleting a bus

Right-click the bus in the mixer and choose Delete from the shortcut menu.
Deleting multiple busses

1. Display the Project Properties dialog using one of the following methods:
   - Choose Properties from the File menu.
   - Press Alt + Enter.

2. Click the Audio tab.

3. Enter a value in the Number of stereo busses box and click OK. The busses are removed from the Mixer window.

Using assignable effects

You can use assignable effect controls to send various levels of multiple tracks to a single effect chain. Like busses, these controls reside in the Mixer window and support plug-in chains. In addition, assignable effect outputs can be routed to project busses. You can add up to 32 assignable effect controls to a project, and each control supports as many as 32 DirectX plug-ins on its chain.

For creative ways to use assignable effects, see Adding depth with assignable effects on page 189.

Adding assignable effect controls

1. From the Insert menu, choose Assignable FX or click the Insert Assignable FX button ( ) in the Mixer window. The Plug-In Chooser dialog displays a list of the available plug-ins, and the assignable effect control is added to the Mixer window.

   Important: Do not use time-altering effects (such as time stretch, gapper/snipper, pitch-shift without preserving duration, and some vibrato settings) with an ACID project. Time-altering effects cause tracks routed to the assignable effect control to play out of synchronization with the waveform display in the track view and with other tracks.

2. Add all desired plug-ins using one of the following methods:
   - Double-click the desired plug-in.
   - Drag the desired plug-in to the chain area.
   - Select the desired plug-in and click Add.

   Note: If you have preset plug-in chains saved, double-click the Packaged Chains folder to view those presets. For more information, see Saving plug-in chains as packages on page 124.

3. Click OK. The Plug-In Chooser dialog closes. The Audio Plug-In window opens and displays the plug-in chain.
4. Click a specific plug-in and adjust the effect's parameters manually, or choose one of the presets from the Preset drop-down list. For more information about effect parameters, click the Plug-In Help button ( ) in the Audio Plug-In window.

Tip: You can save an effect's parameters as a preset to be used in other projects. To save a preset, enter a name in the Preset box and click the Save Preset button ( ).

5. Click the Close button ( ) to close the Audio Plug-In window.

Working with assignable effects chains
After you add an assignable effect control, you can add plug-ins to the chain and modify them as needed. For more information, see Adding effects to mixer controls on page 121.

Routing tracks to assignable effect controls
Routing tracks to an assignable effect control allows you to assign multiple tracks to a plug-in chain.

1. Click the multipurpose slider label (this icon displays Volume by default) and choose the desired assignable effect control from the menu that appears. The slider changes to reflect the name of the assignable effect control.

2. Drag the fader to adjust the level of the track sent to the assignable effect chain.

Tip: Assignable effect chains are post-volume by default. To change to pre-volume, click the multipurpose slider label in the track list, choose the appropriate assignable effect chain from the menu, and choose Pre Volume from the submenu.

If you set the Dry Out faders in your effect chain to -inf, you can adjust the wet/dry balance using the volume and assignable effect settings on the multipurpose slider. The volume fader adjusts the dry signal and the assignable effect fader controls the effect signals.

Routing assignable effect controls to busses
By default, assignable effect controls are routed to the Master bus for output. The bus then mixes the assignable effect plug-ins with all tracks routed to the same bus and outputs the mixed signal to the appropriate output device. For more information, see Routing busses to system hardware on page 112.

To route an assignable effect control to a different bus, click the Playback Device Selector button ( ) on the assignable effect control and choose the desired bus from the drop-down list. The drop-down list displays all current busses in the project. For more information, see Adding busses to the project on page 111.
Deleting assignable effect controls

In the Mixer window, right-click the assignable effect control you want to delete and choose **Delete** from the shortcut menu, or select the control and press **Delete**. The assignable effect control is removed from the Mixer window.

Using soft synth controls

You can add soft synth bus controls in the mixer to control the routing of your MIDI tracks to software synthesizers. Soft synth controls allow you to control volume and voice mappings for your MIDI tracks and add effects to a software synthesizer. In the same way you can route a MIDI keyboard to an outboard synthesizer module, you can route each MIDI track to any soft synth control you have set up for your project.

**Tip:** You can also use soft synth controls to play MIDI from an external device. For more information, see Playing MIDI from external devices on page 150.

There are three types of soft synth bus controls you can add: DLS, VSTi, or ReWire devices.

A DLS or VSTi soft synth bus control is like a virtual synthesizer module where you can route tracks. In the same way you can route a MIDI keyboard to an outboard synthesizer module, you can route each MIDI track to any soft synth you have set up for your project or play a soft synth with an external MIDI controller.

A ReWire soft synth bus control connects a ReWire panel application with ACID, which serves as a ReWire mixer application. When ACID hosts a ReWire panel application, playback is synchronized between the two programs, and the panel application’s audio is output through the ACID mixer. With ReWire 2.0 panel applications, you can also route MIDI tracks to ports (synths) in the ReWire panel applications.

**Note:** If you receive an error that a MIDI port is currently in use when you try to play back your project, check the MIDI tab in the Preferences dialog and verify that your ReWire panel applications are not trying to access the same MIDI ports ACID is configured to use.
Adding soft synth controls to projects

If you have no external MIDI devices defined, ACID adds a soft synth control with a default DLS voice set for you when you add a MIDI track to your project. You can add more soft synth controls to a project as needed.

1. Click the Insert Soft Synth button ( ) in the Mixer window. The Soft Synth Chooser dialog appears.
2. To add a DLS or VSTi soft synth, click the Soft Synths tab and choose an available synth from the list. To add a ReWire panel application, click the ReWire Devices tab and choose an installed panel application from the list.
3. Click OK.

Note: If the VST instrument you want to use does not appear in the list, click VST Preferences. For more information, see Locating VST instruments for use in ACID on page 118. If the ReWire panel application you want to use does not appear in the list, see Locating ReWire panel applications for use in ACID on page 119.

Modifying soft synth control properties

Once you add a soft synth control to your project, you can use the Soft Synths Properties window to change the DLS, VSTi, or ReWire 2.0 soft synth used by the control, or edit the properties associated with the selected soft synth.

Accessing the Soft Synth Properties window

Note: You cannot display Soft Synth Properties for ReWire 1.0 soft synths or ReWire 2.0 soft synths routed to a specific channel.

You can display the Soft Synth Properties window by double-clicking the soft synth icon on a Mixer control ( ), or by right-clicking the icon and choosing Soft Synth Properties from the shortcut menu.

Changing the soft synth control routing

1. Double-click the soft synth icon on a control ( ). The Soft Synth Properties window appears.
2. Click the Edit Soft Synth button ( ). The Soft Synth Chooser dialog appears.
3. To route the soft synth control to a DLS or VSTi soft synth, click the Soft Synths tab and choose an available soft synth from the list. To route the soft synth control to a ReWire panel application, click the ReWire Devices tab and choose an installed panel application from the list.
Changing voice mapping for DLS soft synth controls
You can choose a DLS set from anywhere on your system for output from a DLS soft synth control.

1. Double-click the soft synth icon on a control ( ). The Soft Synth Properties window appears.

2. Choose a DLS set from the Voice set drop-down list or click the Open DLS Voice Set button ( ) to browse to a DLS set. If you have the Enable Real-Time MIDI ( ) option enabled, you can audition voices using the keyboard at the bottom of the window.

   **Note:** To set the current voice set as the default setting to be used whenever you add a DLS soft synth, click the Set as default DLS Voice Set button ( ).

Changing patches for DLS soft synth controls
The Available voices pane displays the patch names, numbers, and other parameters of the voices included in the DLS set. You can choose a patch for ACID to play until ACID receives a patch change from the MIDI file.

   **Tip:** You can make ACID ignore patch changes during playback by clicking the Playback Filter button ( ) in the Track Properties window and choosing the Patch Change check box in the MIDI Event Filter dialog. For more information, see Filtering MIDI events during playback on page 134.

1. Choose a channel from the Channel drop-down list.

2. Choose a patch in the Available voices pane. ACID uses this patch until you choose another or until ACID receives a patch change from the MIDI file.

   **Tip:** You can create patch change events in the list editor in order to change patches within MIDI files. For more information, see Creating events on page 145.

Changing VST instruments for soft synth controls
You can choose a VST instrument from anywhere on your system for output from a soft synth control.

1. Double-click the soft synth icon on a control ( ). The Soft Synth Properties window appears.

2. Click the Edit Soft Synth button ( ). The Soft Synth Chooser dialog appears.

3. Choose a VST instrument from the list and click OK.

   If the VST instrument you want to use does not appear in the list, you may need to locate the files for use in ACID. For more information, see Locating VST instruments for use in ACID on page 118.
4. Select the Enable button ( ) to enable playback of the VST instrument.

5. Modify the VST instrument settings as needed using the buttons in the Soft Synth Properties window:

- Loads an instrument preset. Choose an .fxp file to replace the current instrument preset.
- Opens an instrument bank. Choose an .fxb file to replace the current instrument bank.
- Saves the current instrument settings as a new instrument preset.
- Saves the current instrument settings as a new instrument bank.

**Locating VST instruments for use in ACID**

ACID designates a folder where you can store VST instrument files. However, if you have VST instrument files elsewhere on your system, you can direct ACID to look for files in alternate locations.

1. From the **Options** menu, choose **Preferences**. The Preferences dialog appears.

2. Click the **VST Instruments** tab.

   The Default VSTi search folder box shows the default location of VST instrument files for use in ACID. VST instrument plug-ins located in this folder already appear in the Select VST instruments to be available as soft synths box at the bottom of the dialog.

   If the VST instrument you want to use appears in this box, select its check box. If the VST instrument does not appear in the box, continue with the following steps to locate the instruments for use in ACID.

3. Click the **Browse** button next to the Alternate VSTi search folder 1 box. The Browse for Folder dialog appears.

4. Browse to the location of your VST instrument files and click **OK**. ACID locates the VST instrument plug-ins and displays them in the Select VST instruments to be available as soft synths box at the bottom of the dialog.

5. Repeat steps three and four for the Alternate VSTi search folder 2 box, if needed.

6. In the Select VST instruments to be available as soft synths box, select the check boxes for the VST instruments you want available in ACID.

7. Click **OK** to close the Preferences dialog.

**Note:** Once you add a VSTi soft synth to a project, the VST instrument stays locked until you close ACID. When a VST instrument is locked, you cannot clear its check box to make it unavailable in ACID.
Using ACID with ReWire panel applications

ACID can act as a ReWire mixer application. After you enable a ReWire panel application to work within ACID, you can insert it as a soft synth control in the mixer, and the soft synth bus connects ACID and the ReWire device and carries the data back and forth between them. The applications share timeline and cursor position data. ACID can mix or apply effects to your panel application’s audio data output and then record the data.

Note: The ReWire panel application data will not be included in playback or rendering if the panel application is not open.

Locating ReWire panel applications for use in ACID

If you have ReWire panel applications installed on your PC, you can select them for use as soft synth controls.

1. From the Options menu, choose Preferences. The Preferences dialog appears.
2. Click the ReWire Devices tab.
   All installed ReWire panel applications appear in the Select ReWire Device to be available as soft synths box at the bottom of the dialog. To choose the ReWire panel application you want to use, select its check box.
3. Click the OK button.

Inserting a ReWire panel application as a soft synth

You can insert a ReWire panel application as a soft synth on the mixer just as you would a DLS or VSTi soft synth. For more information, see Adding soft synth controls to projects on page 116.

To synchronize ACID with your ReWire panel application and edit audio data at any time, double-click the soft synth icon on a control ( ).

Opening a ReWire panel application

There are several ways to open a ReWire panel application for use with ACID:

- For ReWire 1.0 soft synths and ReWire 2.0 soft synths routed to a specific channel, double-click the soft synth control icon on the Mixer ( ) or right-click the icon and choose Open ReWire Panel from the shortcut menu.
- For ReWire 2.0 soft synths routed to the panel application’s master output, you can start the ReWire panel application by double-clicking the soft synth control icon on the Mixer ( ) to display the Soft Synth Properties window and then clicking the Open ReWire Panel Application button ( ). You can click this button again to close the application when your editing is finished.

Note: Select the Lock MIDI Port Configuration button ( ) to lock MIDI ports so ACID does not lose port assignments due to dynamic changes from ReWire panels.

- If ACID is unable to start your ReWire panel application, you can start it manually.

Note: For more information on working with your ReWire panel application, please see the application’s documentation.
Deleting soft synth controls

Just as you can add soft synth controls to a project at any time, you can also delete superfluous soft synth controls. When you delete a soft synth control from a project, tracks assigned to it are reassigned to the first soft synth control in the Mixer window.

To delete a soft synth control, right-click the control in the mixer and choose Delete from the shortcut menu, or select the control and press Delete.

Routing MIDI tracks to soft synth controls

If your project contains multiple soft synth controls, you can assign each MIDI track to a specific soft synth control. To assign a track to a soft synth control, click the Device Selection button ( ) on the track header and choose the desired soft synth control from the menu. For more information, see Routing MIDI tracks to MIDI devices or soft synth controls on page 149.

Using mixer controls

Although busses, assignable effects, and soft synth controls are used to accomplish different tasks, they have many features in common. You can adjust fader levels, mute or solo audio, and apply effects on all mixer controls. In addition, you can select multiple mixer controls to apply changes to several controls simultaneously. You can also view mixer controls in track view in order to automate them.

Working with mixer controls

You can adjust, solo, and mute mixer controls independently.

Adjusting faders

You can adjust mixer control levels during playback and preview the results in real-time. In addition, the stereo faders are split into two channels. This allows you to adjust the levels of the left and right channels independently of one another. For more information, see Adjusting split faders in the mixer on page 52.

Assignable effect controls contain two distinct faders, each of which is split into two channels. The left fader adjusts the level of the input signal entering the control, while the right fader adjusts the output level.

Changing meter resolution

You may specify the meter resolution at which mixer controls display their signal levels. When a mixer control’s meter resolution is changed, all meters in the Mixer window automatically change to reflect the new resolution setting. To change the meter resolution, right-click the meter and choose the desired resolution from the shortcut menu.

Setting levels

When signals are routed through a mixer control, the signal levels may cause the meter to clip. If the meter clips, the level is displayed in red at the top of the meter and the audio is distorted. You can lower the mixer control level and click the red display to reset the meter. A better way to reduce clipping, however, is to adjust the volume of each track.

Tip: You can also reset the clip by right-clicking the meter and choosing Reset Clip from the shortcut menu.
Muting mixer controls

Clicking the Mute button ( ) on a mixer control temporarily suspends playback of the control. When a mixer control is muted, it appears grayed out and the word Muted appears at the bottom of the meter. Clicking the Mute button a second time returns the mixer control to normal playback.

You can also press  to mute a mixer control or group of controls.

Tip: Press  and click the Mute button to mute only the selected mixer control (and restore any other muted controls). If the selected mixer control is already muted, press  and click the Mute button to restore all controls.

Soloing mixer controls

Clicking the Solo button ( ) on a mixer control isolates playback by muting all other mixer controls. For example, when you solo a bus, all remaining busses, assignable effects, and soft synths appear grayed out and the word Muted appears at the bottom of their respective meters. Clicking the Solo button a second time returns all mixer controls to normal playback.

You can also press  to solo a mixer control or group of controls.

Tip: Press  and click the Solo button to solo only the selected mixer control (and restore any other soloed controls). If the selected mixer control is already soloed, press  and click the Solo button to restore all controls.

Adding effects to mixer controls

ACID allows you to add DirectX compatible plug-ins, either individually or as a chain, to a mixer control. You can build plug-in chains from any DirectX compatible plug-ins installed on your system. You can add plug-ins (individually or as pieces of a chain) to a mixer control at any time, and once you have added them, you can reorder them, remove them, and combine them with additional plug-ins to achieve the desired effect.

Adding a plug-in to a mixer control results in the track signals assigned to that control being processed by the plug-in. However, plug-ins assigned at the track level are processed before plug-ins added at the mixer level. For more information, see Using track effects on page 93.

Important: Do not use time-altering effects (such as time stretch, gapper/snipper, pitch-shift without preserving duration, and some vibrato settings) with an ACID project. Time-altering effects cause a track to play out of synchronization with the waveform display in the track view and with other tracks.
Adding plug-in chains

1. Click the FX button ( ) on the mixer control. The Plug-In Chooser dialog appears.

2. Select the plug-ins that you want to add. The selected plug-ins appear in the chain area. There are three ways to add a plug-in to the chain:
   - Double-click the plug-in.
   - Drag the plug-in to the chain area.
   - Select the plug-in and click Add.

   **Tip:** If you have saved any plug-in chain packages, double-click the Packaged Chains folder to view those packages. For more information, see Saving plug-in chains as packages on page 124.

3. Click OK to close the Plug-In Chooser dialog. The Audio Plug-In window opens and displays the plug-in chain.

4. Click a specific plug-in and adjust the effect’s parameters manually, or choose one of the presets from the Preset drop-down list. For more information about effect parameters, click the Plug-In Help button ( ) in the Audio Plug-In window.

   **Tip:** You can save an effect’s parameters as a preset to be used in other projects. To save a preset, enter a name in the Preset box and click the Save Preset button ( ).

5. Click the Close button ( ) to close the Audio Plug-In window.

Adding plug-ins to existing plug-in chains

1. Click the FX button ( ) on the mixer control. The Audio Plug-In window appears.

2. Click the Edit Chain button ( ). The Plug-In Chooser dialog appears.

3. Add the desired plug-in(s) to the chain.

4. Click OK to close the Plug-In Chooser dialog. The Audio Plug-In window opens and displays the plug-in chain.

5. Click a specific plug-in and adjust the effect’s parameters manually, or choose one of the presets from the Preset drop-down list. For more information about effect parameters, click the Plug-In Help button ( ) in the Audio Plug-In window.

6. Click the Close button ( ) to close the Audio Plug-In window.
Arranging plug-ins on plug-in chains

The effect of plug-ins placed on a chain is cumulative. For example, when a signal passes through a plug-in, it carries those settings through the next plug-in, and carries both settings through the next plug-in, and so on. Because of this cumulative effect, you may need to rearrange the plug-ins on the chain so that one plug-in’s processing does not adversely affect the next one in the chain.

There is no right or wrong way to order plug-ins, and the chain’s plug-in order is strictly based on your preferences and desired output. However, certain plug-ins function better at specific points in the chain. For example, the dither plug-in typically works best as the last plug-in on a chain.

1. Click the **FX** button ( ) on the mixer control. The Audio Plug-In window appears.

2. There are two ways to arrange plug-ins in your chain:
   - Drag the plug-in to a new location in the chain.
   - Right-click the plug-in and select **Move Left** or **Move Right** from the shortcut menu.

3. Click the **Close** button ( ) to close the Audio Plug-In window.

Bypassing plug-ins on plug-in chains

You can bypass a plug-in without removing it from the chain by clearing the check box on the plug-in. Alternately, right-click the plug-in and choose **Bypass** from the shortcut menu.

**Tip:** To bypass (or re-enable) all plug-ins in a chain, right-click the **FX** button ( ) on the mixer control and choose **Bypass All** or **Enable All**.

Removing plug-ins from chains

You can remove a plug-in from a chain at any time.

1. Click the **FX** button ( ) on the mixer control. The Audio Plug-In window appears.

2. Right-click the plug-in and choose **Remove** from the shortcut menu, or click the **Remove Selected Plug-In** button ( ).

3. Click the **Close** button ( ) to close the Audio Plug-In window.
Removing or bypassing all effects on a mixer control

You can clear a mixer control of all effects by right-clicking the FX button ( ) and choosing Delete All from the shortcut menu.

You can bypass the effects on a mixer control without removing them by right-clicking the FX button ( ) and choosing Bypass All from the shortcut menu. To apply them again, right-click the FX button and choose Enable All from the shortcut menu.

Saving plug-in chains as packages

ACID allows you to save plug-in chains as packages so that you may re-use them in other projects. If you use a combination of plug-ins often, saving them as a package saves you time. Effect packages retain their chain order and individual plug-in settings.

You may save plug-in chains as packages from existing plug-in chains or in the Plug-In Chooser dialog during the actual creation of the chain. The plug-in chains that you save as packages appear in the Plug-In Chooser dialog in the Packaged Chains folder.

1. Click the FX button ( ) on the mixer control. The Plug-In Chooser dialog appears if a plug-in chain does not already exist.

   To save an existing chain, click the FX button ( ) to open the Audio Plug-In window and skip to step four.

2. Add and arrange plug-ins to create a plug-in chain and click OK.

3. In the Audio Plug-In window, adjust the settings for each plug-in to achieve the effect you want. For more information about effect parameters, click the Plug-In Help button ( ) in the Audio Plug-In window.

4. Click the Save Chain Preset button ( ). The Save Plug-In Package dialog appears.

5. Enter a name for the package.

6. Click OK to save the plug-in chain as an effect package.

Organizing your plug-ins

ACID allows you to create folders for organizing your plug-ins within the Plug-In Chooser dialog. You will notice that the Plug-In Chooser dialog functions similarly to Windows Explorer. However, the Plug-In Chooser dialog only allows you to work with plug-ins installed on your system.

Using the Preset Manager

Once you have created custom presets for effects or effect chains, you can use the Preset Manager to back up, transfer, or delete custom presets from any of the plug-ins you use in ACID. The Preset Manager is a standalone application that you can use to manage ACID, Sound Forge, and Vegas presets.

You can install the Preset Manager from the ACID CD. After you install the application, choose Contents and Index from the Help menu in the Preset Manager for instructions on how to manage your presets.
Working with multiple mixer controls

When you select multiple busses, assignable effect controls, or soft synth controls in the mixer, you can simultaneously perform functions on the controls. These functions include the following:

- Change bus or hardware routing
- Mute/solo bus or control
- Delete bus or control
- Change fader level

You can select multiple, nonadjacent controls by holding the Ctrl key while clicking each control's name. You can select multiple, adjacent controls by clicking the first control and holding the Shift key while clicking the last control in the range.

Note: You cannot group the Preview fader in this manner with other mixer controls.

Automating mixer controls in track view

You can automate bus, assignable effect, and soft synth controls in track view. ACID allows you to view each of these controls on tracks at the bottom of track view and to add envelopes to automate functions such as volume, pan, and assignable effect chain input/output levels. You can also add envelopes to automate effect parameters for plug-ins that support automation. For more information, see Adding effect automation envelopes on page 98.

For creative ways to use bus automation, see Fading in and out of mixes on page 190.

Viewing bus tracks

From the View menu, choose Show Bus Tracks or press U. The bus tracks appear at the bottom of the track view. A bus track appears for each mixer control in your project.

Adding track envelopes

Right-click the track header in the list, choose Insert/Remove Envelope from the shortcut menu, and choose the appropriate envelope type from the submenu.

You can identify which mixer controls have envelopes by looking at each control's letter or number. An automated mixer control has a small fader icon on its letter or number in the Mixer window.

Modifying track envelopes

You can modify a track envelope for a bus, assignable effect, or soft synth in the same way you do with any other track. For more information, see Using track envelopes on page 97.
ACID is a loop-based audio-production tool. It is not designed for multi-track recording projects. However, the application does allow you to record audio from your system's sound card. This limited recording capability makes it possible for you to record audio or MIDI from an external source and place it in your project.

This feature actually makes ACID an excellent tool for recording song demos. You can build a backing track of the appropriate length and tempo using a variety of loops and combine the backing track with a one-shot vocal or guitar track that you record.

Note: Recording MIDI is covered in greater depth in Recording MIDI tracks on page 131.

Recording audio

If you are familiar with other Sonic Foundry applications, recording in ACID should be fairly intuitive. The following procedure briefly outlines the steps involved in recording audio.

1. Connect the audio source or MIDI device to your computer.
2. For audio recording, verify that the card is properly configured for the audio source (microphone, line level, etc.).
3. Place the cursor in the track view at the position where recording will begin. To record multiple takes, create a loop region instead. For more information, see Recording multiple takes on page 130.
4. Click the Record button ( ) on the transport bar. The Record dialog appears.
5. Set the desired recording properties. For more information, see Setting ACID's recording properties on page 128.
6. Set the recording level. For more information, see Setting recording levels on page 129.
7. Click Start to begin recording. ACID creates a new track in the project and begins to record the incoming audio signal into it.

8. Click Stop to end recording.

The recorded audio is placed on its track as a Beatmapped file and can now be manipulated at the track or event level, like any other file in the project.

ACID adds regions to mark each measure in the recording. You can view the regions in the Track Properties window. These regions can be useful when creating loops from your recordings in ACID or Sound Forge.

**Setting ACID’s recording properties**

Prior to recording in ACID, you must configure the application’s recording properties in the Record dialog. This ensures that you are recording through the appropriate device with the desired attributes, and that you are storing the recorded file in the appropriate folder.

**Record type**

Use these radio buttons to specify the type of recording you are about to make.

**File name**

This box allows you to name the recorded file prior to actually recording it. If you do not specify a name, ACID provides the default name “Record Take” and appends a unique number to identify it. ACID saves recorded audio as a WAV file and saves MIDI as a MID file.

**Record folder**

This box displays the path to the folder where recorded files are stored. If you want to specify an alternate location, click Browse and specify the new folder.

**Free space**

This value indicates the amount of available free space in the current record folder.

**Time recorded**

This value provides you with a running summary of the length and size (in megabytes) of the audio currently being recorded.

**Record from**

By default, ACID begins recording at the cursor position when you click the Record button ( ). However, you can use the Record from radio buttons to specify an alternate starting point for recording.

- Selecting the Start of project radio button configures ACID to start recording at the beginning of the current project.
- Selecting the Position radio button allows you to enter the recording start position in measures and beats format.

**Make new track follow project tempo**

Selecting this check box configures ACID to use its stretching features to expand/contract your recording in relation to the project tempo. However, if you are recording your audio track at the final project tempo, you should clear this check box to allow ACID to treat the recorded file as a one-shot.

**Record device**

This drop-down list allows you to choose the hardware device and channel that ACID uses to record your audio.
If you chose Microsoft Sound Mapper in the Audio device type drop-down list in the Preferences dialog, you cannot choose a specific device. Choose a device other than the Sound Mapper to specify hardware devices. 
*For more information, see Using the Audio tab on page 181.*

When recording MIDI, you can choose a device from the MIDI Thru drop-down list to provide MIDI playback as you record. *For more information, see Recording MIDI tracks on page 131.*

**Attributes and the Change button**

The Attributes values display the recording sample rate and bit depth. Sample rate is the number of samples per second, measured in Hertz (Hz), used to record audio. You can change the sample rate or bit depth by clicking the Change button, which displays the Audio tab of the Project Properties dialog. *For more information, see Using the Audio tab on page 34.*

---

**Note:** Attributes and the Change button do not apply when recording MIDI.

---

**Monitor**

Selecting this check box turns on the record meters, which display the incoming audio level for the specified recording device.

**Setting recording levels**

When recording audio, it is important to record with the highest possible signal without clipping. Clipping occurs when the incoming signal is too high to be represented as a digital value and is indicated visually by a red clip warning at the top of the meters. The aural result of clipping is distortion. Be assured that digital clipping distortion is very different from analog clipping distortion. The saturation level of analog tape is non-exact and pushing the levels into the red often create a nice overdriven effect. However, the saturation point of digital recording is exactly 0 dB and levels surpassing that result in ugly digital distortion that can easily ruin a project.

1. Connect the audio source to the sound card’s input and verify that the card is properly configured for the audio source (microphone, line level, etc.).

2. Click the Record button ( ) and set the desired recording properties. *For more information, see Setting ACID’s recording properties on page 128.*

3. Select the Monitor check box. Incoming audio levels appear on the record meters and the peak signal level appears (in decibels) at the top of the meters. Keep in mind that a meter reading of 0 dB is the maximum for a digital signal and any signal that surpasses that level will distort.

4. Continue adjusting the input level of the source audio until maximum levels are achieved without clipping.

If the meter clips, decrease the source audio level and click the numbers at the top of the meter. The peak is reset and a new peak reading is calculated. Continue adjusting the levels and resetting the meter until the level is maximized.

---

**Note:** Setting digital recording levels can be difficult. If you are not familiar with the source audio and have only one opportunity to capture the recording, allow yourself plenty of headroom.
Recording multiple takes

Using the Loop Playback button ( ) in conjunction with the record feature allows you to record multiple takes into an ACID project. All takes are recorded into the same track and saved as one WAV file. However, ACID delineates each take by creating a region that is saved with the recorded media file. To view the regions, open the recorded track's properties.

1. Create a loop region for the part of the project you want to play while recording your take.

![Loop region](image)

2. Verify that the Loop Playback button ( ) is selected.
3. Begin recording. ACID plays back the specified loop region while recording your takes on a new track.

Reviewing and saving takes

After you have recorded all your takes, you can review them and save only the best take.

1. Click Cancel to close the Record dialog.
2. Click the Solo button ( ) on the track you just recorded.
3. Click the Play From Start button ( ) and review all takes.
4. Create a time selection containing the take you want to keep.
5. From the Tools menu, choose Render to New Track. The Render to New Track dialog appears.
6. Enter a name for the new file in the File name box and click Save. ACID saves the take to a new file and creates a new track for it.
7. Delete the track containing the original takes.
ACID allows you to record MIDI tracks and, through support for Yamaha's Open Plug-in Technology (OPT), edit MIDI in your projects. ACID provides two native OPT plug-ins: the piano roll editor and the list editor. You can also use ACID to render projects with MIDI tracks, play MIDI from an external device, and synchronize to MIDI timecode (MTC).

Adding MIDI tracks

You can add MIDI files to your project or create new MIDI files from scratch. MIDI tracks display with the MIDI icon in the track list. You can use MIDI tracks to record and play back data from synthesizers and other MIDI-compliant equipment. MIDI tracks can use MID, SMF, and RMI files.

Adding MIDI files

You can add existing MIDI files to your project just as you would add other files. Simply add the file to the project and use the Draw tool or Paint tool to add events to the track that ACID creates for you.

Creating new MIDI files

You can insert a new blank MIDI track into your project by choosing MIDI Track from the Insert menu. Once you've added the track, you can use an OPT plug-in (such as the piano roll editor or list editor) to create or step record MIDI.

Recording MIDI tracks

The Record dialog allows you to record audio or MIDI tracks. For more information, see Recording in ACID on page 127.

1. Click the Record button on the transport bar. The Record dialog appears.
2. Select the MIDI radio button in the line labeled Record type.
3. In the Record device drop-down list, choose the MIDI device from which you will record.

Note: If the device from which you want to record does not appear in the list, you may need to enable the device in the MIDI tab of the Preferences dialog. For more information, see Using the MIDI tab on page 182.

4. From the MIDI Thru drop-down list, choose the output device or soft synth control to use for monitoring the incoming MIDI. This allows you to hear the MIDI input as you record.
5. In the File name box, enter a name for the recorded file.
6. If necessary, click Browse and select a location for ACID to save the recorded file.

7. Complete the remainder of the Record dialog as needed. For more information, see Setting ACID's recording properties on page 128.

8. Click Start to begin recording.

9. When you have finished, click Stop to end recording.

ACID saves the recorded MIDI file with the name and location you selected and adds a new MIDI track to the project. You can paint the recorded MIDI on the new MIDI track.

Tip: You can also record MIDI using the step recording feature of the list editor plug-in. For more information, see Step recording events on page 145.

Changing MIDI track properties

The General tab of the Track Properties window allows you to pitch-shift or set a root note for a MIDI file in the same way you can with a loop or Beatmapped file. In addition, the General tab allows you to add, delete, and work with the tracks within the MIDI file. You can mute, solo, rename, and change channel, volume or pan settings for individual tracks in a MIDI file.

Pitch shifting MIDI tracks

You can change the pitch of all events on a MIDI track.

1. Double-click the MIDI icon ( ) on the track header to open the Track Properties window.

2. On the General tab, enter a value in the Pitch shift box (or use the spinner control) to adjust the pitch of all events on the track.

Setting root notes for MIDI tracks

Choose a root note from the Root note drop-down list to set the base note for tracks that you want to conform to the project key. Otherwise, choose Don't transpose.
Working with tracks in a MIDI file

Within the MIDI file, you can add new tracks or delete existing tracks. You can also mute, solo, change settings, and rename tracks. If you want, you can save the changes you make in ACID to the original MIDI file. For more information, see Saving, reloading, or replacing MIDI files on page 148.

Viewing track and channel information

The General tab of the Track Properties window displays information about the tracks and channels in a MIDI file.

- In an SMF (standard MIDI file) type 0 file, all MIDI data is saved to a single track. Each channel within the single track displays as a separate track in the Track Properties window.
- An SMF type 1 file can save MIDI tracks separately, and these tracks are displayed in the Track Properties window. If a track sends data to more than one channel, the Channel column for that track displays a dash (-). You can use the list editor to locate and view channel messages. For more information, see Filtering the list on page 141.

Adding and deleting tracks

Click the Add New Track button ( ) to add a new track to the MIDI file. Select a track and click the Delete Track button ( ) to remove a track.

Renaming tracks

1. Double-click a track name and type a new name.
2. Press Enter to rename the track.

Editing channel information (channelization)

1. Double-click the number in the Channel column for a track.
2. Type a new channel number in the box.
3. Press Enter. All MIDI messages are sent to the new channel.

Note: After you’ve edited the channel for a multichannel track, channel information cannot be edited in the list editor. To revert to the previous channelization and enable channel editing in the list editor, enter -1 in the Channel column. For more information, see Using the list editor on page 140.

Muting and soloing tracks

To mute or solo a track within a MIDI file, click the Mute ( ) or Solo ( ) button for the track.

Changing track volume and pan

Drag the volume or pan sliders to adjust volume or panning for a track in a MIDI file. The adjustment you make adds a bias to the original volume or pan setting in the MIDI file. For example, if a track has a volume setting of 50 and you set the volume slider to 20, the resulting track plays at 70.
Be aware of the following as you change track volume and panning:

- The volume slider settings are added to the track volume and any volume information in the MIDI file. This allows you to manipulate the volume of the track and still maintain volume controller information that may be present in the file. The overall volume of the MIDI track, however, is bound at 0 and 127.
- Volume and panning settings are not saved in the MIDI file, but are saved in the ACID project file. When you click the **Reload** button ( ) to reload the MIDI file, the volume and panning settings do not reset but are retained. For more information, see Saving, reloading, or replacing MIDI files on page 148.

**Previewing MIDI files**

You can play your MIDI file to test out your changes before leaving the General tab. Use the buttons on the transport bar at the bottom of the window to control MIDI playback.

---

**Tip:** To control volume during playback in the General tab, drag the Preview fader in the Mixer window.

---

**Chasing MIDI events during playback**

When playback loops or begins at a point other than the beginning of the MIDI file, ACID can automatically chase (update) controller, SysEx, and patch changes to ensure correct playback.

1. Click the **Chase Filter** button ( ) to display the Chase Event Filter dialog.
2. Select the check box for each event type that you do not want to chase during playback. Clear a check box to chase events of that type.
3. Click **OK** to close the Chase Event Filter dialog.

**Filtering MIDI events during playback**

You can choose to filter out certain event types when you play MIDI from the General tab.

1. Click the **Playback Filter** button ( ) to display the MIDI Event Filter dialog.
2. Select the check box for each event type that you want to exclude during playback. Clear a check box to include events of that type.
3. Click **OK** to close the MIDI Event Filter dialog.

**Using the piano roll editor**

The Piano Roll Editor tab on the Track Properties window allows you to view and edit a MIDI file.

The top pane of the piano roll editor displays MIDI information in the manner of a piano roll for a player piano. Each note is represented by a rectangular note event of a certain length and pitch. The piano keys along the left side of the window indicate the pitch of a note event. The beat ruler across the top of the window shows the length and location of a note event.

The lower pane of the piano roll editor displays velocity information for each note event. A transport bar for previewing MIDI appears at the bottom of the window.
Viewing the piano roll editor

1. Double-click the MIDI icon ( ) on the track header to open the Track Properties window.
2. Click the Piano Roll Editor tab. The piano roll editor appears.

Previewing MIDI

You can preview the entire MIDI file, a loop selection, or single notes using the piano roll editor.

Tip: To control volume during playback in the piano roll editor, drag the Preview fader in the Mixer window.

Previewing the MIDI file

Use the transport bar buttons at the bottom of the piano roll editor to play your MIDI.

Tip: You can use the Solo button ( ) to solo a particular MIDI track during preview playback.

Previewing a selection in looped playback

You can preview a selection in looped playback just as you would in the main ACID window.

1. Drag the handles of the loop bar in the piano roll editor to create the desired loop region.
2. Click the Loop Playback button ( ) to turn on looped playback.
3. Click the transport bar’s Play button ( ) or press Space. The piano roll editor loops the playback of the selected area. To stop playback, click the transport bar’s Stop button ( ) or press Space.
Previewing notes
Before you paint a note, you can click a key on the keyboard to preview its sound. You can also preview notes as you draw, paint, or select them.

1. Select the Enable Real-Time MIDI button ( ) at the top of the Track Properties window.
2. In the piano roll editor, click the Monitor button ( ) to turn on the note monitor.
3. Click any key in the keyboard. The note plays back.

The piano roll editor also plays notes when you add them using the Draw ( ) or Paint ( ) tools or select them using the Draw tool. For more information, see Adding note events on page 136 and Selecting note events on page 138.

Selecting MIDI tracks
As you view, add, or edit MIDI note events, you must first select a track within the MIDI file to work with. Choose a track from the Track drop-down list to work with that track.

Adding note events
You can add note events using the Draw tool ( ) or the Paint tool ( ) in the same way you do in the main ACID window.

Tip: As you drag to create new events, the event edge snaps to the divisions on the beat ruler. To snap to smaller divisions, click the Zoom In Time button ( ) at the bottom of the window to zoom in more tightly. Or, to turn off snapping altogether, click the Enable Snapping button ( ) to toggle it off.

You can choose to hear the notes as you add them. For more information, see Previewing notes on page 136.

Drawing note events
The Draw tool limits you to drawing one pitch at a time. In other words, you cannot drag up and down with the Draw tool to draw note events across several pitches at once.

1. Click the Draw Tool button ( ). The Draw tool is selected.
2. Drag in the row for the pitch you wish to create. A new note event appears as you drag.

Painting note events
Unlike the Draw tool, the Paint tool allows you to create note events across multiple pitches with a single drag of the mouse. The Paint tool also allows you to select the note length you want to paint.

1. Click the arrow adjacent to the Paint Tool button ( ) and choose a note length to paint from the menu.
2. Click the Paint Tool button ( ). The Paint tool is selected.
3. Drag to create new note events. The new events appear as you drag.
Editing note events

You can change the length or pitch of a note event using the Draw tool. You can also cut, copy, and paste events in the same way you do in the main ACID window.

Changing pitch
With the Draw tool ( ) selected, drag a note event to a new row.

Changing length
With the Draw tool ( ) selected, drag the edge of a note event to a new location.

Tip: As you drag the edge of a note event, the event edge snaps to the divisions on the beat ruler. To snap to smaller divisions, click the Zoom In Time button ( ) at the bottom of the window to zoom in more tightly. Or, to turn off snapping altogether, click the Enable Snapping button ( ) to toggle it off.

Specifying a velocity value for notes

To enter a specific velocity value, right-click a note event in the piano roll, choose Velocity from the shortcut menu, and choose the appropriate command from the submenu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set to Maximum</td>
<td>Sets the velocity to 127.</td>
</tr>
<tr>
<td>Set to Default</td>
<td>Sets the velocity to 64.</td>
</tr>
<tr>
<td>Set to Minimum</td>
<td>Sets the velocity to 0.</td>
</tr>
<tr>
<td>Set to...</td>
<td>Allows you to enter a custom velocity value.</td>
</tr>
</tbody>
</table>

Changing velocity data

1. In the lower-left corner of the Piano Roll Editor tab, click the drop-down arrow and choose Velocity from the menu.

2. In the area at the bottom of the Piano Roll Editor tab, drag the top of a velocity bar up or down to change the velocity value. You can also drag across multiple bars to change their values at the same time.
Setting pitch bend
1. In the lower-left corner of the Piano Roll Editor tab, click the drop-down arrow and choose Pitch Bend from the menu.
2. In the area at the bottom of the Piano Roll Editor tab, drag to draw your pitch bend curve. To erase a curve, right-click and drag.

Changing continuous controller information
1. In the lower-left corner of the Piano Roll Editor tab, click the drop-down arrow, choose All Continuous Controllers from the menu, and choose a controller from the submenu.
2. In the area at the bottom of the Piano Roll Editor tab, drag to draw your controller information.

Selecting note events
With the Draw tool selected, you can select individual note events by clicking them. You can also use one of several methods to select multiple events:

- With the Draw tool selected, press Ctrl or Shift while clicking note events. Pressing Shift allows you to select the first and last note events of a range in order to select all notes in between, while pressing Ctrl allows you to select non-contiguous note events.
- Click the Selection Tool button ( ) and drag across note events you wish to select.
- Press Ctrl+A to select all note events on a track.

Moving note events
After you select note events, you can drag them to new positions.

Tip: Press Alt while dragging note events to restrict your movement to vertical (change pitch) or horizontal (change location in time).

Using cut, copy, and paste
After you select note events, you can click the Cut ( ) or Copy ( ) buttons to cut or copy the events. You can then position the cursor in a new location and click the Paste button ( ) to paste the events. Note events are always pasted at the same pitch as the original note event.
Quantizing note events

You can use the MIDI Quantize dialog to force notes to align with musical beats based on the parameters you specify.

1. Select the notes you want to quantize. For more information, see Selecting note events on page 138.
2. Click the Quantize button ( ). The MIDI Quantize dialog appears.
3. From the Quantize resolution drop-down list, choose the beat to which you want the selected notes to be quantized.
4. Select the Start times check box to snap start times to the beat selected in the Quantize resolution drop-down list.
5. Select the Note durations check box to snap note durations to the beat selected in the Quantize resolution drop-down list.
6. Click Apply.

Deleting note events

Use the Erase tool ( ) to erase events in the piano roll. Alternately, you can select events and press Delete. For more information, see Selecting note events on page 138.

Undoing and redoing

You can easily undo and redo actions in the piano roll editor by using keyboard shortcuts. Press Ctrl + Z to undo an action, and press Ctrl + Shift + Z to redo an action.

Saving MIDI

When you create or edit MIDI in the piano roll editor, ACID saves the MIDI information in the project, but does not save the information to a MIDI file. You can save the MIDI information to a MIDI file by clicking the Save File button ( ). For more information, see Saving, reloading, or replacing MIDI files on page 148.
Using the list editor

The List Editor tab on the Track Properties window allows you to view and edit all MIDI data using ACID’s list editor plug-in. The list editor displays each event in your MIDI file as a row in a table. The columns in the table contain information on each event’s parameters.

Viewing the list editor

1. Double-click the MIDI icon ( ) on the track header to open the Track Properties window.
2. Click the List Editor tab. The list editor appears.

Previewing MIDI

You can preview individual events or the MIDI file as a whole within the list editor.

Tip: To control volume during playback in the list editor, drag the Preview fader in the Mixer window.

Previewing the MIDI file

Use the transport bar at the bottom of the list editor to preview your MIDI. As you preview, the list editor highlights the current note being played.

Previewing a selection in looped playback

You can preview a selection in looped playback just as you would in the main ACID window.

1. Click the Loop Playback button ( ) to turn on looped playback.
2. Define the loop region:
   - Select the event where you want the loop to start and click the Mark Loop Start button ( ).
   - Select the event where you want the loop to end and click the Mark Loop End button ( ).

   The loop boxes in the lower-right corner of the window display the loop start, loop end, and loop length values.
3. Select the event where you want to begin playback and click the transport bar’s Play button ( ) or press Space. The piano roll editor begins playback and loops the marked selection. To stop playback, click the transport bar’s Stop button ( ) or press Space.
Previewing events

You can preview individual note events within the MIDI file.

1. Select the Enable Real-Time MIDI button ( ) at the top of the Track Properties window.
2. In the list editor, click the Monitor button ( ) to turn on the event monitor.
3. Click anywhere in an event row to play the event.

Filtering the list

A MIDI file can contain a dizzying number of individual events. You can speed the task of locating events in the list editor by applying a filter. You can filter what the list editor displays either by track or by event type.

Filtering the list by track

Choose a track from the Track drop-down list to view only the events for that track.

Filtering the list by event type

1. Click the Filter button ( ). The MIDI Event Filter dialog appears.
2. Select the check box for an event type to hide that type, or clear the check box to display that event type.
3. Click OK. The list is filtered according to the criteria you selected.

Editing events

Once you have located a particular event, you can edit the parameters of the event as needed.

1. Click in the event row you want to edit.
2. Click the Edit Event button ( ). The Edit MIDI Event dialog appears.

Tip: You can also double-click an event’s Message parameter to open the Edit Event dialog.

3. Edit the values in the dialog. For more information, see Event parameters on page 142.
4. Click OK. The event updates to the new values.

Tip: You can edit individual parameters in columns other than Message by double-clicking the parameter and entering a new value.
### Event parameters

The table below describes the editable event parameters for different event types.

<table>
<thead>
<tr>
<th>Event type</th>
<th>Editable parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>After Touch</td>
<td>Start Time</td>
<td>Time (in measures.beats.ticks) where you want the event to begin.</td>
</tr>
<tr>
<td></td>
<td>Channel</td>
<td>MIDI channel (1-16) where you want to send the event.</td>
</tr>
<tr>
<td></td>
<td>Pressure</td>
<td>Amount of vibrato (0-127) you want to apply to each voice on the channel.</td>
</tr>
<tr>
<td>Control Change</td>
<td>Start Time</td>
<td>Time (in measures.beats.ticks) where you want the event to begin.</td>
</tr>
<tr>
<td></td>
<td>Channel</td>
<td>MIDI channel (1-16) where you want to send the event.</td>
</tr>
<tr>
<td></td>
<td>Controller Change</td>
<td>Displays the number of the current controller change type. Choose a controller change type from the drop-down list to the right of the Event type drop-down.</td>
</tr>
<tr>
<td></td>
<td>Value</td>
<td>Controller value.</td>
</tr>
<tr>
<td>Meta</td>
<td>Start Time</td>
<td>Time (in measures.beats.ticks) where you want the event to begin.</td>
</tr>
<tr>
<td></td>
<td>Meta Event Type</td>
<td>Type of meta event that you want to add. Choose a meta event type from the drop-down list to the right of the Event type drop-down.</td>
</tr>
<tr>
<td></td>
<td>Meta Event Parameter</td>
<td>Value that you want to send for the meta event. The parameter type varies depending on the selected meta event type. For example, when you choose Text Event from the Meta Event Type drop-down list, a Meta text box displays for you to enter your parameter.</td>
</tr>
<tr>
<td>Note</td>
<td>Start Time</td>
<td>Time (in measures.beats.ticks) where you want the event to begin.</td>
</tr>
<tr>
<td></td>
<td>Channel</td>
<td>MIDI channel (1-16) where you want to send the event.</td>
</tr>
<tr>
<td></td>
<td>Note</td>
<td>Numeric value of the note you want to play. For more information, see MIDI notes and frequencies on page 144.</td>
</tr>
<tr>
<td></td>
<td>On Velocity</td>
<td>Speed of the note’s attack (0-127). Low values produce a soft attack; high values produce a strong attack.</td>
</tr>
<tr>
<td></td>
<td>Off Velocity</td>
<td>Speed of the note’s release (0-127). Low values produce a soft release; high values produce a staccato release.</td>
</tr>
<tr>
<td></td>
<td>Duration</td>
<td>Length of the note’s sustain in measures.beats.ticks.</td>
</tr>
<tr>
<td>Packed NRPN**</td>
<td>Start Time</td>
<td>Time (in measures.beats.ticks) where you want the event to begin.</td>
</tr>
<tr>
<td></td>
<td>Channel</td>
<td>MIDI channel (1-16) where you want to send the event.</td>
</tr>
<tr>
<td></td>
<td>NRP MSB</td>
<td>Parameter’s most significant byte.</td>
</tr>
<tr>
<td></td>
<td>NRP LSB</td>
<td>Parameter’s least significant byte.</td>
</tr>
<tr>
<td></td>
<td>Data MSB</td>
<td>Value for the most significant byte.</td>
</tr>
<tr>
<td></td>
<td>Data LSB</td>
<td>Value for the least significant byte.</td>
</tr>
<tr>
<td>Packed RPN***</td>
<td>Start Time</td>
<td>Time (in measures.beats.ticks) where you want the event to begin.</td>
</tr>
<tr>
<td></td>
<td>Channel</td>
<td>MIDI channel (1-16) where you want to send the event.</td>
</tr>
<tr>
<td></td>
<td>NRP MSB</td>
<td>Parameter’s most significant byte.</td>
</tr>
<tr>
<td></td>
<td>NRP LSB</td>
<td>Parameter’s least significant byte.</td>
</tr>
<tr>
<td></td>
<td>Data MSB</td>
<td>Value for the most significant byte.</td>
</tr>
<tr>
<td></td>
<td>Data LSB</td>
<td>Value for the least significant byte.</td>
</tr>
<tr>
<td>Patch</td>
<td>Start Time</td>
<td>Time (in measures.beats.ticks) where you want the event to begin.</td>
</tr>
<tr>
<td></td>
<td>Channel</td>
<td>MIDI channel (1-16) where you want to send the event.</td>
</tr>
<tr>
<td></td>
<td>Bank LSB</td>
<td>Least significant byte value for the bank.</td>
</tr>
<tr>
<td></td>
<td>Bank MSB</td>
<td>Most significant byte value for the bank.</td>
</tr>
<tr>
<td>Pitch Bend</td>
<td>Start Time</td>
<td>Time (in measures.beats.ticks) where you want the event to begin.</td>
</tr>
<tr>
<td></td>
<td>Pitch +/-</td>
<td>Number of cents by which you want to bend the pitch.</td>
</tr>
<tr>
<td>Poly Pressure</td>
<td>Start Time</td>
<td>Time (in measures.beats.ticks) where you want the event to begin.</td>
</tr>
<tr>
<td></td>
<td>Channel</td>
<td>MIDI channel (1-16) where you want to send the event.</td>
</tr>
<tr>
<td></td>
<td>Note</td>
<td>Note to which you want to apply pressure.</td>
</tr>
<tr>
<td></td>
<td>Pressure</td>
<td>Pressure (0-127) you want to apply to the note. Most devices will apply more vibrato to a note as the pressure increases.</td>
</tr>
<tr>
<td>Event type</td>
<td>Editable parameter</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Program Change</td>
<td>Start Time</td>
<td>Time (in measures, beats, ticks) where you want the event to begin.</td>
</tr>
<tr>
<td></td>
<td>Channel</td>
<td>MIDI channel (1-16) where you want to send the event.</td>
</tr>
<tr>
<td></td>
<td>Patch</td>
<td>Number of the new patch you want to play.</td>
</tr>
</tbody>
</table>

* Packed nonregistered parameter numbers (NRPN) are used to adjust settings such as vibrato and filtering, but are not part of the General MIDI specification. Refer to your MIDI device’s documentation for more information about the required parameters.

** Packed registered parameter numbers (RPN) are used to adjust common settings such as pitch wheel range.
MIDI notes and frequencies

The following table shows the musical pitch and frequency associated with each MIDI note. A5 is 440 Hz, and middle C is C5 at 261.63 Hz. These values can differ, often by one octave, from values used by other manufacturers. The following frequencies are based on equal temperament tuning.

<table>
<thead>
<tr>
<th>Pitch</th>
<th>MIDI Key</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>C 0</td>
<td>0</td>
<td>8.176</td>
</tr>
<tr>
<td>C#-0</td>
<td>1</td>
<td>8.662</td>
</tr>
<tr>
<td>D 0</td>
<td>2</td>
<td>9.177</td>
</tr>
<tr>
<td>D#0</td>
<td>3</td>
<td>9.723</td>
</tr>
<tr>
<td>E 0</td>
<td>4</td>
<td>10.301</td>
</tr>
<tr>
<td>F 0</td>
<td>5</td>
<td>10.913</td>
</tr>
<tr>
<td>F#0</td>
<td>6</td>
<td>11.562</td>
</tr>
<tr>
<td>G 0</td>
<td>7</td>
<td>12.250</td>
</tr>
<tr>
<td>G#0</td>
<td>8</td>
<td>12.978</td>
</tr>
<tr>
<td>A 0</td>
<td>9</td>
<td>13.750</td>
</tr>
<tr>
<td>A#0</td>
<td>10</td>
<td>14.568</td>
</tr>
<tr>
<td>B 0</td>
<td>11</td>
<td>15.434</td>
</tr>
<tr>
<td>C 1</td>
<td>12</td>
<td>16.352</td>
</tr>
<tr>
<td>C#1</td>
<td>13</td>
<td>17.324</td>
</tr>
<tr>
<td>D 1</td>
<td>14</td>
<td>18.354</td>
</tr>
<tr>
<td>D#1</td>
<td>15</td>
<td>19.445</td>
</tr>
<tr>
<td>E 1</td>
<td>16</td>
<td>20.601</td>
</tr>
<tr>
<td>F 1</td>
<td>17</td>
<td>21.826</td>
</tr>
<tr>
<td>F#1</td>
<td>18</td>
<td>23.124</td>
</tr>
<tr>
<td>G 1</td>
<td>19</td>
<td>24.499</td>
</tr>
<tr>
<td>G#1</td>
<td>20</td>
<td>25.956</td>
</tr>
<tr>
<td>A 1</td>
<td>21</td>
<td>27.500</td>
</tr>
<tr>
<td>A#1</td>
<td>22</td>
<td>29.135</td>
</tr>
<tr>
<td>B 1</td>
<td>23</td>
<td>30.867</td>
</tr>
<tr>
<td>C 2</td>
<td>24</td>
<td>32.703</td>
</tr>
<tr>
<td>C#2</td>
<td>25</td>
<td>34.648</td>
</tr>
<tr>
<td>D 2</td>
<td>26</td>
<td>36.708</td>
</tr>
<tr>
<td>D#2</td>
<td>27</td>
<td>38.990</td>
</tr>
<tr>
<td>E 2</td>
<td>28</td>
<td>41.203</td>
</tr>
<tr>
<td>F 2</td>
<td>29</td>
<td>43.653</td>
</tr>
<tr>
<td>F#2</td>
<td>30</td>
<td>46.249</td>
</tr>
<tr>
<td>G 2</td>
<td>31</td>
<td>48.999</td>
</tr>
<tr>
<td>G#2</td>
<td>32</td>
<td>51.913</td>
</tr>
<tr>
<td>A 2</td>
<td>33</td>
<td>55.000</td>
</tr>
<tr>
<td>A#2</td>
<td>34</td>
<td>58.270</td>
</tr>
<tr>
<td>B 2</td>
<td>35</td>
<td>61.735</td>
</tr>
<tr>
<td>C 3</td>
<td>36</td>
<td>65.406</td>
</tr>
<tr>
<td>C#3</td>
<td>37</td>
<td>69.295</td>
</tr>
<tr>
<td>D 3</td>
<td>38</td>
<td>73.416</td>
</tr>
<tr>
<td>D#3</td>
<td>39</td>
<td>77.781</td>
</tr>
<tr>
<td>E 3</td>
<td>40</td>
<td>82.406</td>
</tr>
<tr>
<td>F 3</td>
<td>41</td>
<td>87.307</td>
</tr>
<tr>
<td>F#3</td>
<td>42</td>
<td>92.499</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pitch</th>
<th>MIDI Key</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>G 3</td>
<td>43</td>
<td>97.998</td>
</tr>
<tr>
<td>G#3</td>
<td>44</td>
<td>103.82</td>
</tr>
<tr>
<td>A 3</td>
<td>45</td>
<td>110.00</td>
</tr>
<tr>
<td>A#3</td>
<td>46</td>
<td>116.54</td>
</tr>
<tr>
<td>B 3</td>
<td>47</td>
<td>123.47</td>
</tr>
<tr>
<td>C 4</td>
<td>48</td>
<td>130.81</td>
</tr>
<tr>
<td>C#4</td>
<td>49</td>
<td>138.59</td>
</tr>
<tr>
<td>D 4</td>
<td>50</td>
<td>146.83</td>
</tr>
<tr>
<td>D#4</td>
<td>51</td>
<td>155.56</td>
</tr>
<tr>
<td>E 4</td>
<td>52</td>
<td>164.81</td>
</tr>
<tr>
<td>F 4</td>
<td>53</td>
<td>174.61</td>
</tr>
<tr>
<td>F#4</td>
<td>54</td>
<td>184.99</td>
</tr>
<tr>
<td>G 4</td>
<td>55</td>
<td>195.99</td>
</tr>
<tr>
<td>G#4</td>
<td>56</td>
<td>207.65</td>
</tr>
<tr>
<td>A 4</td>
<td>57</td>
<td>220.00</td>
</tr>
<tr>
<td>A#4</td>
<td>58</td>
<td>233.08</td>
</tr>
<tr>
<td>B 4</td>
<td>59</td>
<td>246.94</td>
</tr>
<tr>
<td>C 5</td>
<td>60</td>
<td>261.63</td>
</tr>
<tr>
<td>C#5</td>
<td>61</td>
<td>277.18</td>
</tr>
<tr>
<td>D 5</td>
<td>62</td>
<td>293.66</td>
</tr>
<tr>
<td>D#5</td>
<td>63</td>
<td>311.13</td>
</tr>
<tr>
<td>E 5</td>
<td>64</td>
<td>329.63</td>
</tr>
<tr>
<td>F 5</td>
<td>65</td>
<td>349.23</td>
</tr>
<tr>
<td>F#5</td>
<td>66</td>
<td>369.99</td>
</tr>
<tr>
<td>G 5</td>
<td>67</td>
<td>391.99</td>
</tr>
<tr>
<td>G#5</td>
<td>68</td>
<td>415.31</td>
</tr>
<tr>
<td>A 5</td>
<td>69</td>
<td>440.00</td>
</tr>
<tr>
<td>A#5</td>
<td>70</td>
<td>466.16</td>
</tr>
<tr>
<td>B 5</td>
<td>71</td>
<td>493.88</td>
</tr>
<tr>
<td>C 6</td>
<td>72</td>
<td>523.25</td>
</tr>
<tr>
<td>C#6</td>
<td>73</td>
<td>554.37</td>
</tr>
<tr>
<td>D 6</td>
<td>74</td>
<td>587.33</td>
</tr>
<tr>
<td>D#6</td>
<td>75</td>
<td>622.25</td>
</tr>
<tr>
<td>E 6</td>
<td>76</td>
<td>659.26</td>
</tr>
<tr>
<td>F 6</td>
<td>77</td>
<td>698.46</td>
</tr>
<tr>
<td>F#6</td>
<td>78</td>
<td>739.99</td>
</tr>
<tr>
<td>G 6</td>
<td>79</td>
<td>783.99</td>
</tr>
<tr>
<td>G#6</td>
<td>80</td>
<td>830.61</td>
</tr>
<tr>
<td>A 6</td>
<td>81</td>
<td>880.00</td>
</tr>
<tr>
<td>A#6</td>
<td>82</td>
<td>932.32</td>
</tr>
<tr>
<td>B 6</td>
<td>83</td>
<td>987.77</td>
</tr>
<tr>
<td>C 7</td>
<td>84</td>
<td>1046.5</td>
</tr>
<tr>
<td>C#7</td>
<td>85</td>
<td>1108.7</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Pitch</th>
<th>MIDI Key</th>
<th>Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>D 7</td>
<td>86</td>
<td>1174.7</td>
</tr>
<tr>
<td>D#7</td>
<td>87</td>
<td>1244.5</td>
</tr>
<tr>
<td>E 7</td>
<td>88</td>
<td>1318.5</td>
</tr>
<tr>
<td>F 7</td>
<td>89</td>
<td>1396.9</td>
</tr>
<tr>
<td>F#7</td>
<td>90</td>
<td>1480.0</td>
</tr>
<tr>
<td>G 7</td>
<td>91</td>
<td>1568.0</td>
</tr>
<tr>
<td>G#7</td>
<td>92</td>
<td>1661.2</td>
</tr>
<tr>
<td>A 7</td>
<td>93</td>
<td>1760.0</td>
</tr>
<tr>
<td>A#7</td>
<td>94</td>
<td>1864.7</td>
</tr>
<tr>
<td>B 7</td>
<td>95</td>
<td>1975.5</td>
</tr>
<tr>
<td>C 8</td>
<td>96</td>
<td>2093.0</td>
</tr>
<tr>
<td>C#8</td>
<td>97</td>
<td>2217.5</td>
</tr>
<tr>
<td>D 8</td>
<td>98</td>
<td>2349.3</td>
</tr>
<tr>
<td>D#8</td>
<td>99</td>
<td>2489.0</td>
</tr>
<tr>
<td>E 8</td>
<td>100</td>
<td>2637.0</td>
</tr>
<tr>
<td>F 8</td>
<td>101</td>
<td>2793.8</td>
</tr>
<tr>
<td>F#8</td>
<td>102</td>
<td>2960.0</td>
</tr>
<tr>
<td>G 8</td>
<td>103</td>
<td>3136.0</td>
</tr>
<tr>
<td>G#8</td>
<td>104</td>
<td>3322.4</td>
</tr>
<tr>
<td>A 8</td>
<td>105</td>
<td>3520.0</td>
</tr>
<tr>
<td>A#8</td>
<td>106</td>
<td>3729.3</td>
</tr>
<tr>
<td>B 8</td>
<td>107</td>
<td>3951.1</td>
</tr>
<tr>
<td>C 9</td>
<td>108</td>
<td>4186.0</td>
</tr>
<tr>
<td>C#9</td>
<td>109</td>
<td>4434.9</td>
</tr>
<tr>
<td>D 9</td>
<td>110</td>
<td>4698.6</td>
</tr>
<tr>
<td>D#9</td>
<td>111</td>
<td>4978.0</td>
</tr>
<tr>
<td>E 9</td>
<td>112</td>
<td>5274.0</td>
</tr>
<tr>
<td>F 9</td>
<td>113</td>
<td>5587.7</td>
</tr>
<tr>
<td>F#9</td>
<td>114</td>
<td>5919.9</td>
</tr>
<tr>
<td>G 9</td>
<td>115</td>
<td>6271.9</td>
</tr>
<tr>
<td>G#9</td>
<td>116</td>
<td>6644.9</td>
</tr>
<tr>
<td>A 9</td>
<td>117</td>
<td>7040.0</td>
</tr>
<tr>
<td>A#9</td>
<td>118</td>
<td>7458.6</td>
</tr>
<tr>
<td>B 9</td>
<td>119</td>
<td>7902.1</td>
</tr>
<tr>
<td>C 10</td>
<td>120</td>
<td>8372.0</td>
</tr>
<tr>
<td>C#10</td>
<td>121</td>
<td>8869.8</td>
</tr>
<tr>
<td>D 10</td>
<td>122</td>
<td>9397.3</td>
</tr>
<tr>
<td>D#10</td>
<td>123</td>
<td>9956.1</td>
</tr>
<tr>
<td>E 10</td>
<td>124</td>
<td>10548.1</td>
</tr>
<tr>
<td>F 10</td>
<td>125</td>
<td>11175.3</td>
</tr>
<tr>
<td>F#10</td>
<td>126</td>
<td>11839.8</td>
</tr>
<tr>
<td>G 10</td>
<td>127</td>
<td>12543.9</td>
</tr>
</tbody>
</table>
Creating events

In addition to editing existing events, you can also create new events.

1. Click the Insert Event button ( ). The Insert MIDI Event dialog appears.
2. Choose a track from the Track drop-down list.
3. Choose an event type from the Event type drop-down list.
4. Enter a start time in the Start time box.
5. Enter values for the remaining event parameters.
6. Click Insert. The new event is inserted at the designated start time.

Step recording events

In step recording, you can record MIDI without worrying about tempo or rhythm. Simply record the MIDI note by note, entering event parameter values as you go.

If you have a MIDI keyboard or other device connected to your system, you can input notes using the device. For more information, see Adding external devices as MIDI inputs on page 150.

1. Click the Step Recording button ( ) on the transport bar at the bottom of the window. The MIDI Step Recording dialog appears.

2. Choose a track from the Track drop-down list.
3. If you will input MIDI from an external device, choose a device from the Input port drop-down list.

   **Note:** You must make a MIDI port available as an input device in the Preferences dialog in order to use it for step recording. For more information, see Using the MIDI tab on page 182.

4. Choose the total duration from the start of one note to the start of the next from the Step size drop-down list.
5. Choose the length of an individual note from the Duration drop-down list.

**Note:** When you choose a duration longer than the step size, ACID overlaps the note with the note in the next step.

6. Input the MIDI using an external device, or specify settings for each note you want to record:
   - In the Start time box, enter the point at which you want to start recording.
   - Select the Auto advance on insert and record check box if you want to automatically increase the Start time setting by the current step size each time you click Insert or play a note on a MIDI input device. Clear the check box to adjust the Start time manually (when creating chords, for example).
   - In the Channel box, enter the MIDI channel you want to play the note.
   - In the Note box, enter the note you want to play. You can enter the note as a numeric value (69) or as a pitch (A5).
   - In the On velocity box, specify the speed of the note's attack (0-127). Low values produce a soft attack; high values produce a strong attack.
   - In the Off velocity box, specify the speed of the note's release (0-127). Low values produce a soft release; high values produce a staccato release.
   - In the Duration box, specify the length of the note's sustain in measures.beats.ticks.
   - Click Insert to record the note.

7. Repeat step six as needed to record each note.

8. Click Add to add the notes to the MIDI and continue step recording, or click OK to close the MIDI Step Recording dialog and add the notes to the MIDI in the list editor.

**Quantizing events**

You can use the MIDI Quantize dialog to force events to align with musical beats based on the parameters you specify.

1. To quantize only specific events, select the events you want to quantize.

   **Tip:** Hold \([\text{Shift}]\) or \([\text{Ctrl}]\) while clicking event rows to select multiple events.

2. Click the Quantize button (\(\text{Q}\)). The MIDI Quantize dialog appears.

3. From the Quantize resolution drop-down list, choose the beat to which you want the selected events to be quantized.
4. Choose the appropriate options for quantizing:
   - Select the Start times check box to snap event start times to the beat selected in the Quantize resolution drop-down list.
   - Select the Note durations check box to snap note durations to the beat selected in the Quantize resolution drop-down list.
   - Select the Notes only check box to quantize note events alone. When you select this check box, the list editor does not quantize after touch, control change, meta, NRPN, RPN, pitch bend, poly pressure, and program change events.
   - Select the Apply to current selection only check box to quantize only the selected events. Clear the check box to quantize all events within the list.

5. Click Apply.

Deleting events

Click an event row and click the Delete button ( ).

Undoing and redoing

You can easily undo and redo actions in the list editor by using keyboard shortcuts. Press [Ctrl]+[Z] to undo an action, and press [Ctrl]+[Shift]+[Z] to redo an action.

Saving MIDI

When you create or edit MIDI in the list editor, ACID saves the MIDI information in the project, but does not save the information to a MIDI file. You can save the MIDI information to a MIDI file by clicking the Save File button ( ). For more information, see Saving, reloading, or replacing MIDI files on page 148.

Loading third-party OPT plug-ins

With ACID’s OPT support, you can load third-party OPT MIDI plug-ins on your system in the Track Properties window.

If an external MIDI device has an OPT software component, ACID makes the OPT plug-in available to you in the Track Properties window when you select the MIDI device in the MIDI tab of the Preferences dialog. For more information, see Using the MIDI tab on page 182.

Note: You can choose OPT plug-ins to be included with every new MIDI track you create. For more information, see Setting default track properties on page 178.

1. Double-click the MIDI icon ( ) on the track header to open the Track Properties window.
2. Click the MIDI Editors button ( ). The OPT MIDI Editor Plug-In Chooser dialog appears.
3. Choose a MIDI editor plug-in in the Available editor plug-ins pane and click the Add button to add it to the Connected editor plug-ins pane.
4. Click OK. The new plug-in appears as a tab in the Track Properties window.

**Note:** When you load an OPT plug-in in the Track Properties window, ACID loads the plug-in for that track alone. To use the plug-in in a different MIDI track, you must load the plug-in from the Track Properties window for that track.

**Saving, reloading, or replacing MIDI files**

When you alter a MIDI file using any of the tabs in the Track Properties window, ACID saves the changes in the project file alone; it does not alter the original MIDI file. To save your changes to the MIDI file, click the Save File button ( ) in the Track Properties window.

**Tip:** To save MIDI to a different file, click the Save File As button ( ).

You also have the option of reloading the original (unmodified) MIDI file or replacing the MIDI file with another file. For more information, see Reloading files on page 108 and Replacing files on page 109.

Volume and pan changes made in the General tab of the Track Properties window are not saved to the file when you click the Save File button. The MIDI file retains its original volume and pan settings; however, the volume and pan changes made in the General tab are retained in the ACID project file. This means that when you reload a MIDI file, the volume and pan changes are not reset but are retained. For more information, see Changing track volume and pan on page 133.
Routing MIDI tracks to MIDI devices or soft synth controls

You can assign a soft synth control in the Mixer window to any DLS set, VST instrument, or ReWire panel application on your computer. You can then route a MIDI track to the soft synth control or ReWire 2.0 port. For more information, see Using soft synth controls on page 115. Alternately, you can route a track directly to an external MIDI device through a MIDI port.

Tip: You can use Shift or Ctrl to select multiple MIDI tracks and change their soft synth routing all at once.

1. Click the Device Selection button ( ). A menu displays available MIDI devices and soft synth controls.

- If a soft synth for a particular DLS set, VST instrument, or ReWire panel application does not appear in the menu, choose Insert Soft Synth to add a soft synth control to the project and route it to a DLS set, VST instrument, or ReWire panel application. For more information, see Adding soft synth controls to projects on page 116.
- If a MIDI device does not appear in the menu, choose External MIDI Device Preferences to make MIDI devices available on the MIDI tab of the Preferences dialog. For more information, see Using the MIDI tab on page 182.

Note: Devices selected for generating MIDI timecode on the Sync tab of the Preferences dialog are unavailable as MIDI output devices. For more information, see Using the Sync tab on page 184.

2. Choose a device, soft synth control, or port from the menu to send the current track to that control.

The Device Selection button indicates whether the track is routed to a soft synth ( ) or MIDI device ( ).

Resetting MIDI ports

When a MIDI port is stuck playing a sustaining sound, ACID provides a quick method to turn off MIDI ports (much like the panic button on MIDI hardware devices). From the Tools menu, choose Reset All MIDI Ports to send a global Note Off command to all MIDI ports.

Tip: Press Ctrl + Alt + F7 to reset all MIDI ports.
Rendering projects with MIDI tracks

To render projects that contain MIDI tracks, route the MIDI tracks to soft synths (DLS sets or VST instruments) rather than to external MIDI devices; MIDI tracks that are routed to external MIDI devices are not included in the rendered file. For more information, see Rendering projects on page 54.

Playing MIDI from external devices

You can set up ACID to receive MIDI input from an external device such as a MIDI keyboard. You can then use a soft synth control (with its DLS set or VST instrument) or external MIDI device to output the sound from the external device.

Adding external devices as MIDI inputs

1. Verify that the Enable Real-Time MIDI command is selected in the Options menu.
2. From the Options menu, choose Preferences. The Preferences dialog appears.
3. Click the MIDI tab.
4. Select a device in the Make these devices available for MIDI input pane.
5. To enable MIDI thru for the selected input, right-click the entry in the MIDI Thru column and choose a MIDI thru device from the shortcut menu.

   Note: The MIDI thru device must be selected in the Make these devices available for MIDI track playback and Generate MIDI Clock pane in order to appear in the menu. You can choose more than one MIDI device for MIDI thru output, if desired.

6. Click OK.

Assigning MIDI inputs to soft synth controls

You can route MIDI input from an external device to any soft synth control in your project. For more information, see Adding soft synth controls to projects on page 116.

   You can assign both individual tracks and external MIDI devices to a single soft synth.

1. In the Mixer window, double-click the soft synth icon on a control ( ). The Soft Synth Properties window appears.
2. Click the External MIDI Input Port button ( ) and select the MIDI input device from the menu.

   When using VSTi soft synths, make sure the Enable button ( ) is selected for real-time MIDI playback.
Soloing MIDI device inputs

External MIDI devices can be routed to multiple soft synths or MIDI thru devices. Soloing a MIDI device input prevents your device from playing through other soft synths and MIDI thru devices, soloing the input through the selected soft synth control. You can solo MIDI input on more than one soft synth control, if desired.

1. Double-click the soft synth icon on a control ( ). The Soft Synth Properties window appears.
2. Click the Solo Listen to MIDI Input button ( ).

Synchronizing using MIDI timecode

ACID can generate MIDI timecode (MTC) and MIDI clock as well as trigger from MIDI timecode. These features allow ACID to be synchronized with other audio applications and external audio hardware.

---

**Note:** ACID cannot chase MTC or MIDI clock.

---

Generating MIDI timecode

MIDI timecode is a standard timecode that most applications and some hardware devices use to synchronize themselves. ACID generates stable MTC at all available frame rates for other applications to chase.

1. Specify a MIDI output device to which you will send timecode and a frame rate for the timecode. These options can be found on the Sync tab of the Preferences dialog. For more information, see Using the Sync tab on page 184.
2. From the Options menu, choose Timecode, and choose Generate MIDI Timecode from the submenu.

ACID begins generating MTC wherever you click the Play button ( )

Generating MTC with an offset

In some cases, you may want to start sending timecode with an offset (e.g., 01:00:00:00) to allow time for multiple devices to synchronize. You can create an offset on the ACID time ruler to accomplish this. For more information, see Using the ruler offset on page 173.

Viewing outgoing timecode

You can view outgoing timecode in the time display located directly above the track list. Right-click the time display and choose MIDI Timecode Out from the shortcut menu to display outgoing MTC time.
_triggering from MIDI timecode_

You can trigger ACID playback using MTC. This means that ACID initiates playback by receiving timecode from another device.

1. Connect a word clock signal between your computer and triggering device to lock synchronization.

   **Note:** If the MIDI trigger device can output MIDI timecode, a timecode converter is not necessary; you can connect the trigger device directly to your computer.

2. Configure your triggering device to send MTC to your computer.

3. From the Options menu, choose Preferences and select the Sync tab to configure ACID to receive MTC.
   - From the Input device drop-down list, choose the port through which you receive MTC.
   - From the Frame rate drop-down list, choose the frame rate that your trigger device uses to send MTC to ACID.

4. From the Options menu, choose Timecode, and choose Trigger from MIDI Timecode from the submenu.

   When ACID receives an incoming MTC signal, it begins playing from the position indicated by the timecode. If ACID is not receiving MTC, you can play and edit normally.

**Viewing incoming timecode**

You can view the incoming timecode in the time display located directly above the track list. Right-click the time display and choose MIDI Timecode In from the shortcut menu to show the incoming MTC time.

This display also shows status and error information. If Trigger from MIDI Timecode is enabled but no MTC is detected, the display reads Waiting…; If the wrong frame rate of MTC is being detected, the display reads Wrong format.

**Generating MIDI clock**

MIDI clock differs from MTC in that it contains tempo as well as positional information. MIDI clock is essentially measured in ticks from the beginning of the project. MIDI clock sends 24 ticks per quarter note.

The advantage of using MIDI clock is that ACID can send its tempo changes to the chasing application and they will be preserved.

1. Specify a MIDI output device to which you will send the clock. This option can be found on the Sync tab of the Preferences dialog. For more information, see Using the Sync tab on page 184.

2. From the Options menu, choose Timecode, and choose Generate MIDI Clock from the submenu.

   ACID generates MIDI clock when you click the Play button ( ).

**Viewing outgoing MIDI clock**

You can view the outgoing clock in the time display located directly above the track list. Right-click the time display and choose MIDI Clock Out from the shortcut menu to display the outgoing MIDI clock time.
By adding a video track to your ACID project, you can use ACID as a scoring tool.

Video is always added to the top track in the track list. Depending on your horizontal zoom level, each frame displayed in the video track may represent multiple frames from the source video. As you zoom in, marks display to represent each frame, and you can zoom further to view individual frames.

Managing video

ACID makes it easy to add video to a project and work with the video track.

Adding or replacing video files

Use the Explorer window to find the file you want to use, and then add it to the project by double-clicking it or dragging it into the track view. ACID places the video file in the top track, and if the file has an audio stream, ACID places it as a separate, one-shot track in the track view.

If your project already contains a video track, ACID prompts you to replace the existing video if you open another video file.

Tip: You can also add a still image (such as a BMP, JPEG, PSD, GIF, PNG, or TGA file) to the video track.

Removing the video track

Right-click anywhere in the video track and choose Remove Video from the shortcut menu.

Hiding and showing the video track

By default, video displays in the track view when you add it to a project. You can hide or show the video track at any time by choosing Show Video Track from the View menu. A check mark next to the command indicates that the video track displays.

Synchronizing audio and video

Editing the audio associated with a video file can cause it to become out of sync with the video. To resynchronize the audio and video, right-click the audio file and choose Synchronize with Video from the shortcut menu.

Note: This does not work if you have changed the audio track to a loop.
Removing the video’s audio

Right-click the audio track in the track list and choose **Delete Track** from the shortcut menu. The audio track is removed, but the video remains.

Changing frame numbering

ACID numbers each frame in the video track. You can change the numbering format or turn off frame numbering altogether.

1. From the **Options** menu, choose **Preferences**. The Preferences dialog appears.
2. Click the **Video** tab.
3. Choose a setting from the Show source frame numbers on video thumbnails as drop-down list.

Editing video events

ACID provides several video editing options to help you score your video.

Moving video events

Drag the event to a new location along the video track.

Trimming video events

Drag either end of the video event. The video event stays in place, but the beginning or end of the video moves.

You cannot trim the beginning or end of the event past the event’s original end. You cannot trim an event earlier than its starting point unless the event has been trimmed previously.

Slipping and sliding video events

To help you picture what happens when you slip and slide events, think of an event as a window to a media file. The window can display the entire media file or a small section. When the window displays only a portion of the media file, you can move either the window or the underlying media to adjust the media played by an event:

- When you **slip** an event, your event maintains its place on the timeline, but the media file moves in the direction you drag.
- When you **slide** an event, the media file maintains its place on the timeline, but the event moves in the direction you drag.

Shifting the contents of video events (slipping)

Hold **Alt** while dragging the video event to move the position of the video within the event. The event itself does not move.

Slip-trimming video events

Hold **Alt** while dragging the beginning or end of a video event. The video moves with the event edge, and the opposite edge of the event remains fixed.

Sliding video events

Hold **Ctrl** + **Alt** while dragging the video event to move the event while leaving the video in place. The relative position of the video changes as when you slip an event.
Using the Video window

The Video window is used to view the video as it plays or to view the frame at the cursor position. To display the Video window, choose Video from the View menu, or press Alt + 4.

Using toolbar buttons

The toolbar allows you to access two commonly used functions of the Video window.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Copy Frame" /></td>
<td>Copies the current frame to the Windows clipboard.</td>
</tr>
<tr>
<td><img src="image" alt="External Monitor" /></td>
<td>Sends the preview to an external monitor.</td>
</tr>
</tbody>
</table>

Using the shortcut menu

Right-click anywhere in the Video window to display a shortcut menu with Video window options.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy Frame</td>
<td>Copies the current frame to the Windows clipboard.</td>
</tr>
<tr>
<td>Default Background</td>
<td>Sets the background color of the Video window to the default color.</td>
</tr>
<tr>
<td>Black Background</td>
<td>Sets the background color of the Video window to black.</td>
</tr>
<tr>
<td>White Background</td>
<td>Sets the background color of the Video window to white.</td>
</tr>
<tr>
<td>External Monitor</td>
<td>Sends the preview to an external monitor.</td>
</tr>
<tr>
<td>Display Square Pixels</td>
<td>Compensates for any spatial distortions due to non-square pixel aspect ratios.</td>
</tr>
<tr>
<td>Display at Media Size</td>
<td>Displays video at the native resolution, clipping if necessary.</td>
</tr>
<tr>
<td>Show Toolbar</td>
<td>Toggles the display of the Video window toolbar.</td>
</tr>
<tr>
<td>Show Status Bar</td>
<td>Toggles the display of the Video window status bar.</td>
</tr>
</tbody>
</table>

Viewing the status bar

Right-click the Video window and choose Show Status Bar from the shortcut menu to view the status bar. The status bar shows the video's frame size, frame rate, and display size.
Previewing on external monitors

ACID allows you to use your system’s external monitor for previewing video playback. You must have an OHCI IEEE-1394 adapter and a device to convert the DV signal to video, such as a DV camcorder, deck, or media converter.

To specify an external monitor, click the External Monitor button ( ) on the Video window, or choose Preferences from the Options menu and click the Video tab.

Other settings for the external monitor can also be found on the Video tab. For more information, see Using the Video tab on page 183.

Scoring video with ACID

ACID provides tools that allow you to adjust the tempo of a project to easily synchronize audio with specific video frames.

1. Add your audio track(s) and video to your project.
2. If the Video window is not displayed, choose Video from the View menu.
3. Click the Play button ( ) to begin playback.
4. Press each time you want to place a time marker at a frame you want to emphasize (where an explosion is heard, for example).
5. Click the Stop button ( ) to stop playback.
6. Return to the leftmost time marker and fine tune its placement so it coincides exactly with the desired video frame.

Tip: Holding Alt while pressing the right or left arrow keys allows you to step the cursor through your video by individual frames. You may need to drag your time marker to the cursor to get it on the desired frame.

7. Place the cursor at the point to which you want to synchronize your time marker. For example, you might want the frame that you marked in step six to coincide with a downbeat.
8. Right-click the time marker and select Adjust Tempo to Match Marker to Cursor from the shortcut menu. The new tempo appears in the track list.
9. Press T to insert a tempo change marker. ACID detects the adjusted tempo and inserts it in the tempo marker’s box. The tempo change marker preserves synchronization between the time marker and location on the beat ruler as you perform editing further down the timeline. For more information, see Adding tempo/key/time signature change markers on page 81.
10. Repeat steps six through nine to synchronize the rest of your video.
ACID allows you to create 5.1-channel mixes to wrap a listener in your remixes or prepare audio for cinema, DVD-Video, DVD-Audio, or DTS 5.1 Music projects.

**Note:** ACID plays and mixes uncompressed 5.1-channel audio. Authoring software such as the Sonic Foundry 5.1 Surround Plug-In Pack is required to encode 5.1-channel audio for compressed delivery formats.

What is 5.1 surround?

5.1 surround is a standard format consisting of three speakers across the front and two speakers in the rear. The “.1” is a sixth channel called low frequency effects (LFE) that enhances the bass levels in the mix.

The LFE channel is commonly used in motion pictures to enhance low audio frequencies for effects such as explosions or crashes. Audio in this channel is commonly limited to a range from about 25 Hz to 120 Hz. Unlike the five primary channels, the LFE channel adds no directional information. Depending on the speaker setup and audio levels, the sound assigned to the LFE channel may be routed among the five main speakers or to an additional subwoofer.
Setting up surround hardware

Before you create surround projects in ACID, you should set up your system to provide 5.1 surround playback. To play a 5.1 surround project, you must have an appropriate speaker setup such as:

- Six powered speakers
- Six passive speakers with a six-channel amplifier

Your system must also have an appropriate sound card setup such as:

- 5.1-compatible sound card
- Sound card with three stereo outputs
- Three stereo sound cards

There are several ways to set up your system, depending on the sound card and speaker setup you are using.

<table>
<thead>
<tr>
<th></th>
<th>Six powered speakers</th>
<th>Six passive speakers with a six-channel amplifier</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1-compatible sound card</td>
<td>Connect powered speakers to your sound card’s outputs as indicated by your sound card’s documentation.</td>
<td>Connect your sound card’s front, rear, and center/subwoofer outputs to the appropriate inputs on a six-channel amplifier/home theater receiver. Connect front, rear, center, and LFE speakers to the amplifier.</td>
</tr>
<tr>
<td>Sound card with three stereo outputs</td>
<td>Connect powered speakers to your sound card’s outputs where you have routed each of the pairs of channels. The left channel of the Center/LFE pair is the center channel; the right channel is the LFE channel.</td>
<td>Connect your sound card’s outputs to the appropriate inputs on a six-channel amplifier/home theater receiver. Connect front, rear, center, and LFE speakers to the amplifier.</td>
</tr>
<tr>
<td>Three stereo sound cards</td>
<td>Connect powered speakers to your sound card’s outputs where you have routed each of the pairs of channels. The left channel of the Center/LFE pair is the center channel; the right channel is the LFE channel.</td>
<td>Connect your sound card’s outputs to the appropriate inputs on a six-channel amplifier/home theater receiver. Connect front, rear, center, and LFE speakers to the amplifier.</td>
</tr>
</tbody>
</table>

Setting up surround projects

You can configure an ACID project to use 5.1 surround in the Project Properties dialog. You can also choose to apply a low-pass filter for the LFE channel. Applying a low-pass filter approximates the bass-management system in a 5.1 decoder and ensures that you’re sending only low-frequency audio to the LFE channel.

1. From the File menu, choose Properties.
2. Click the Audio tab.
3. From the Master bus mode drop-down list, choose 5.1 surround.
4. To limit the audio sent to the LFE channel, do the following:
   - Select the Enable low-pass filter on LFE check box and enter a value in the Cutoff frequency for low-pass filter box. The low-pass filter isolates the audio sent to the LFE channel by limiting it to frequencies lower than the value entered in the Cutoff frequency for low-pass filter box.
   - Choose a setting from the Low-pass filter quality drop-down list to determine the sharpness of the filter's rolloff curve. Best produces the sharpest curve.

Note: Before rendering your surround project, check your surround authoring application’s documentation to determine its required audio format. Some encoders require a specific cutoff frequency and rolloff, while other encoders require that no filter be applied before encoding.

5. Click OK.
The track list and Mixer window switch to 5.1 surround mode. The Master bus becomes the Surround Master bus, which contains faders for each of the six surround channels. Surround panners appear on tracks and mixer controls. Tracks routed to mixer controls (busses, assignable effects, or soft synths) do not have surround panners; panning for these tracks takes place on the mixer control.

Routing to hardware in the mixer

You must route the surround audio to the correct output in the mixer.

1. From the **Options** menu, choose **Preferences**.
2. Click the **Audio** tab.
3. From the **Audio device type** drop-down list, choose an audio device type other than **Microsoft Sound Mapper** (such as **Windows Classic Wave Driver**).
4. Choose the playback devices for the six surround channels:
   - From the **Default Stereo and Front playback device** drop-down list, choose the appropriate device for the front left and right surround channels.
   - From the **Default Rear playback device** drop-down list, choose the appropriate device for the rear left and right surround channels.
   - From the **Default Center and LFE playback device** drop-down list, choose the appropriate device for the center and LFE surround channels.
5. Click **OK**.

Overriding the default device routing

By setting up the device routing in the Audio tab of the Preferences dialog, you have set the defaults for surround routing in ACID. However, you can override the default device routing at any time using the Surround Master bus in the Mixer window.

1. In the Mixer window, click the Audio Device Selector button ( ) on the Surround Master bus. A menu of surround channels (**Front L/R**, **Rear L/R**, and **Center/LFE**) appears.
2. In the submenu, match a surround pair with the appropriate output.
3. Repeat steps one and two to match each surround pair to the appropriate output.
Assigning audio to the LFE channel

Once the project is in 5.1 surround mode, you must decide whether a track will provide the “5” (surround panning) or the “1” (LFE channel) in 5.1 surround. Initially, all tracks in a surround project are set to provide surround panning, but you can assign a track to the LFE channel instead.

You can assign an individual track to the LFE channel or you can route the track to a mixer control (bus, soft synth, or assignable effect chain) and assign the mixer control to the LFE channel.

To assign audio to the LFE channel, right-click the surround panner on the track header or mixer control and choose LFE Only from the shortcut menu. The track or mixer control is assigned to the LFE channel.

Right-click the surround panner and choose LFE Only... ...to assign the track or mixer control to the LFE channel.

To change a track or mixer control back to surround panning, right-click the LFE indicator and choose Surround Pan from the shortcut menu.

Note: Before rendering your surround project, check your surround authoring application’s documentation to determine its required audio format with respect to the LFE channel. For more information, see Setting up surround projects on page 158.

Panning audio

You can pan audio in a 5.1 surround project in two ways:

- Pan tracks individually using the Surround Panner window.
- Route tracks to mixer controls (busses, assignable effect chains, or soft synths) and pan the mixer controls using the Surround Panner window.

Note: You cannot pan audio on tracks or busses that are routed to hardware outputs in a 5.1 surround project.
Panning tracks

1. Double-click the surround panner on the track you wish to pan. The Surround Panner window appears.

2. Adjust the panning settings. For more information, see Using the Surround Panner window on page 163.

3. Close the Surround Panner window.

Tip: You can also use the surround panner in the track header to pan your track.
Panning mixer controls

You may choose to route tracks to busses or other mixer controls (such as soft synths or assignable effect chains) and pan them as a group rather than panning each track individually.

**Note:** When you route a track to a bus or soft synth control, ACID sends stereo (two-channel) output to the mixer control and the mixer control sends 5.1 (six-channel) output to the Surround Master bus.

1. Add a mixer control to the project. For more information, see Using the Mixer on page 111.
2. Route tracks to the mixer control. For more information, see Using the Mixer on page 111.
3. Double-click the surround panner on the mixer control to display the Surround Panner window.

4. Adjust the panning settings. For more information, see Using the Surround Panner window on page 163.
5. Close the Surround Panner window.

**Tip:** You can also use the surround panner on the mixer control to pan your track.
Using the Surround Panner window

Whether you're adjusting track panning or mixer control panning, you use the same controls in the Surround Panner window.

View the Surround Panner window by double-clicking a surround panner on a track header or mixer control. Once the Surround Panner window is open, you can dock it in the ACID workspace. For more information, see Docking and floating ACID windows on page 172.

Tip: You can also choose Surround Panner from the View menu to display the Surround Panner window. Once the Surround Panner window is displayed, double-click the surround panner for a track or mixer control to view its pan settings.

1. Click the speaker icons to mute or include channels.
   Muting a channel ensures that no audio bleeds through a channel. For example, you might want to mute all but the center channel when you're panning dialogue to the center channel.

   Tip: [Ctrl] + click a speaker icon to solo the channel.

2. Drag the pan point to position the sound within the sound field. For more information, see Moving the pan point on page 164.

3. Click the center speaker icon to include the center channel and drag the Center fader to apply a gain to the center channel.
   Applying a gain to the center channel may make dialogue more present in the mix.

   Note: When automating panning using keyframes, you cannot automate the gain applied using the Center fader. For more information, see Automating panning on page 165.

4. Drag the Smoothness slider to adjust the smoothness of the interpolation path between panning keyframes. The smoothness setting appears only when you are automating panning using keyframes. For more information, see Adjusting the Smoothness slider on page 167.
Moving the pan point

ACID provides a variety of methods to help you position the pan point in the Surround Panner window.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click symbol</td>
<td>Click to toggle through three options for constraining pan point motion as you drag: Move Freely ( ), Move Left/Right Only ( ), and Move Front/Back Only ( )</td>
</tr>
<tr>
<td>Double-click</td>
<td>Double-clicking the pan point resets it to the center front of the surround panner. Double-clicking in the Surround Panner window moves the pan point to the double-click location.</td>
</tr>
<tr>
<td>Shift+drag</td>
<td>Constrains motion to vertical, horizontal, or diagonal motion at 45 degree increments.</td>
</tr>
<tr>
<td>Alt+drag</td>
<td>Constrains motion to a constant radius from the center of the surround panner.</td>
</tr>
<tr>
<td>Shift+Alt+drag</td>
<td>Constrains motion to the maximally inscribed circle (a constant radius at the greatest possible distance from the center of the surround panner).</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>Moves front/back/left/right.</td>
</tr>
<tr>
<td>Ctrl+ Arrow keys</td>
<td>Makes fine adjustments.</td>
</tr>
<tr>
<td>Page Up/Page Down</td>
<td>Moves front/back.</td>
</tr>
<tr>
<td>Shift+Page Up/Page Down</td>
<td>Moves left/right.</td>
</tr>
<tr>
<td>Numeric keypad 1-9</td>
<td>Jumps to a corner, edge, or center of the surround panner.</td>
</tr>
<tr>
<td>Ctrl+Numeric keypad 1,3,7,9</td>
<td>Jumps to a location on the maximally inscribed circle (a constant radius at the greatest possible distance from the center of the surround panner).</td>
</tr>
<tr>
<td>Mouse wheel</td>
<td>Moves front/back.</td>
</tr>
<tr>
<td>Shift+mouse wheel</td>
<td>Moves left/right.</td>
</tr>
<tr>
<td>Ctrl+mouse wheel</td>
<td>Makes fine front/back adjustments.</td>
</tr>
<tr>
<td>Ctrl+Shift+mouse wheel</td>
<td>Makes fine left/right adjustments.</td>
</tr>
</tbody>
</table>

Choosing pan types

When you pan a track or mixer control, you can choose among several pan types to determine how ACID pans the audio. The current pan type appears at the bottom of the Surround Panner window.

Right-click the Surround Panner window and choose a pan type from the shortcut menu.

- **The Add Channels pan type** makes the audio appear to move as a unit among the surround channels. As you move the pan point toward a channel (speaker icon), more and more of the signal from the other channels is folded into the channel you are panning towards, until at the extreme, all channels are fed at full intensity into a single channel. This pan type uses a linear panning curve.

- **The Balance pan type** is most useful for adjusting the relative signal levels of the channels. In this pan type, as you move the pan point from the center to a channel, the signal in the channel you are panning towards starts at the base dB level (either 0 dB, -3 dB, or -6 dB) and increases to 0 dB. The signal in the channel you are panning away from starts at a base dB level (either 0 dB, -3 dB, or -6 dB) and decays to no signal level. For example, when you pan fully to the right, only the right channel is audible. This pan type uses a linear panning curve.

- **The Constant Power pan type** maintains a constant volume as you move the pan point from channel to channel. This pan type, which uses the constant-power panning curve, is most useful for panning monaural source media.

Using the grid to monitor panning

The grid in the Surround Panner window helps you to visualize how your panning will sound. The grid's spacing changes to match the current pan type.

The vertical lines represent the points where the left-to-right signal ratio is 6 dB, 0 dB, and -6 dB respectively: at the far-left line, the left channel is 6.0 dB louder than the right channel.
The horizontal lines represent the points where the front-to-rear signal ratio is 6 dB, 0 dB, and -6 dB respectively. As you adjust the Center fader, the lines move forward or backward to compensate for the center-channel gain.

The grid assumes that you’re using a correctly set-up surround system (matched speakers and ideal positioning). Variations in your monitoring system will cause inconsistencies between the graph and perceived output.

### Automating panning

You can automate panning on a track or mixer control by adding keyframes. Keyframes are similar to envelope points in that they mark specific locations in the track where settings change. However, unlike envelope points, keyframes appears just below the track to which they apply.

To add panning keyframes to a mixer control, you must first view the mixer control in track view. From the View menu, choose Show Bus Tracks to view the bus track at the bottom of the track view. For more information, see Viewing bus tracks on page 125.

### Turning on panning keyframes

Before adding individual keyframes, you must first turn on the panning keyframes for the track or bus track.

1. Select the track or bus track for which you want to automate panning.
2. From the Insert menu, choose Envelopes, and choose Surround Pan Keyframes from the submenu.

An additional row appears below the track with a single keyframe positioned at the beginning of the project. This single keyframe represents the current panning settings for the track.

### Adding panning keyframes

With panning keyframes turned on, you can add keyframes at any location along the track or bus track.

1. Position the cursor where you want to begin panning the track.
2. Double-click the surround panner to display the Surround Panner window.
3. Adjust the panning settings. For more information, see Using the Surround Panner window on page 163.

**Note:** You cannot automate muting including channels or the gain applied to the center channel using the Center fader.
4. Close the Surround Panner window.

A keyframe with the pan settings you created appears below the track at the cursor position.

Tip: You can also add keyframes by double-clicking the keyframe row or by right-clicking the row and choosing Add Keyframe from the shortcut menu. Once you’ve added the keyframe, double-click it to adjust panning settings in the Surround Panner window.

As you add keyframes to a track or bus track, the Surround Panner window shows the path of the panning keyframes. The Smoothness slider controls the smoothness of the interpolation path between the keyframes. For more information, see Adjusting the Smoothness slider on page 167.

Working with keyframes

After you add keyframes, you can work with them in much the same way as envelope points. For more information, see Using track envelopes on page 97.

Moving keyframes

Drag a keyframe to a new position below its track.

Duplicating keyframes

Hold Ctrl and drag a keyframe to a new position below its track.

Editing keyframes

1. Double-click a keyframe to open the Surround Panner window.
2. Adjust the panning settings as desired and close the window.
Changing keyframe interpolation curves

To control how the pan is interpolated between keyframes, right-click a keyframe and choose an interpolation curve type from the shortcut menu. Keyframe interpolation curves control how the pan occurs over time.

<table>
<thead>
<tr>
<th>Keyframe</th>
<th>Interpolation curve</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>◇</td>
<td>Hold</td>
<td>No interpolation takes place. The keyframe’s settings are maintained until the next keyframe.</td>
</tr>
<tr>
<td>□</td>
<td>Linear</td>
<td>Panning is interpolated in a linear path.</td>
</tr>
<tr>
<td>▪</td>
<td>Fast</td>
<td>Panning is interpolated in a fast logarithmic path.</td>
</tr>
<tr>
<td>□</td>
<td>Slow</td>
<td>Panning is interpolated in a slow logarithmic path.</td>
</tr>
<tr>
<td>□</td>
<td>Smooth</td>
<td>Panning is interpolated along a smooth, natural curve.</td>
</tr>
</tbody>
</table>

Adjusting the Smoothness slider

The Smoothness slider controls the perceived motion of sound within the sound field among three or more keyframes. When you drag the Smoothness slider to 0, ACID interpolates the changes between keyframes along a linear path. As you increase the smoothness value, the path between keyframes grows more curved and smooth.

1. Double-click a keyframe. The Surround Panner window appears.
2. Drag the Smoothness slider to adjust the smoothness of the spatial interpolation path leading up to this keyframe.

![Three keyframes with smoothness=100...]

...and the same three keyframes with smoothness=0.

Locking keyframes to events

If you want keyframes to move with an event when it is moved along the timeline, choose Lock Envelopes to Events from the Options menu.

Hiding keyframes

1. Select the track for which you want to hide keyframes.
2. From the View menu, choose Show Envelopes, and choose Surround Pan Keyframes from the submenu.

Deleting keyframes

Right-click a keyframe and choose Delete from the shortcut menu.
Rendering surround projects

ACID renders 5.1 surround projects to produce six monaural files (WAV or AIFF). You can then use an authoring application to create the final cinema, DVD-Audio, DVD-Video, or DTS 5.1 Music project from the rendered files.

With the addition of the Sonic Foundry 5.1 Surround Plug-In Pack, you can render AC-3 files in ACID and burn the resulting files to DVD.

**Note:** Before rendering your surround project, check your surround authoring application's documentation to determine its required audio format with respect to the LFE channel. For more information, see Setting up surround projects on page 158.

1. From the **File** menu, choose **Render As**. The Render As dialog appears.
2. From the **Save in** drop-down list, choose the drive and folder where the file will be saved.
3. Enter a new name for the project in the **File name** box.
4. From the **Save as type** drop-down list, choose the desired file format (AIFF or WAV). If you have the Sonic Foundry AC-3 Encoder, you can choose AC-3 from the list as well.
5. If necessary, click Custom to customize the rendering settings. For more information, see Creating custom rendering settings on page 55.

**Note:** ACID limits you to creating monaural files when rendering a surround project.

6. Click **Save**.

Rendering the surround project SampleProject.wav... ...results in six WAV files.

---

**Note:** ACID renders 5.1 surround projects to produce six monaural files (WAV or AIFF). You can then use an authoring application to create the final cinema, DVD-Audio, DVD-Video, or DTS 5.1 Music project from the rendered files.

With the addition of the Sonic Foundry 5.1 Surround Plug-In Pack, you can render AC-3 files in ACID and burn the resulting files to DVD.

**Note:** Before rendering your surround project, check your surround authoring application’s documentation to determine its required audio format with respect to the LFE channel. For more information, see Setting up surround projects on page 158.

1. From the **File** menu, choose **Render As**. The Render As dialog appears.
2. From the **Save in** drop-down list, choose the drive and folder where the file will be saved.
3. Enter a new name for the project in the **File name** box.
4. From the **Save as type** drop-down list, choose the desired file format (AIFF or WAV). If you have the Sonic Foundry AC-3 Encoder, you can choose AC-3 from the list as well.
5. If necessary, click Custom to customize the rendering settings. For more information, see Creating custom rendering settings on page 55.

**Note:** ACID limits you to creating monaural files when rendering a surround project.

6. Click **Save**.

Rendering the surround project SampleProject.wav... ...results in six WAV files.
Burning AC-3 files to DVD

With the addition of the AC-3 DVD Burner included in the Sonic Foundry 5.1 Surround Plug-In Pack, you can burn AC-3 files to a DVD.

1. From the **Tools** menu, choose **Start AC-3 DVD Burner**. The AC-3 DVD Burner application starts.

2. Follow the instructions for burning a DVD in the AC-3 DVD Burner online help. To access online help, click **Help** in the AC-3 DVD Burner screen.
You can customize ACID to suit your project needs and working preferences. You may change these settings at any time. If you use the same settings for all of your projects, you may set ACID to use your settings as defaults.

In this chapter, you will find information about functions that allow you to customize ACID and set the application’s preferences.

### Working with ACID windows

ACID has various windows that allow you to perform specific tasks related to your project or manage your media. These windows can float on the workspace or be docked in the window docking area. All these windows may be viewed or hidden via the View menu or their respective shortcut keys.

<table>
<thead>
<tr>
<th>Window</th>
<th>Shortcut keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explorer</td>
<td>Alt+1</td>
<td>Allows you to view and access your media files without leaving the workspace. You may also preview media files and place them in your project from this window.</td>
</tr>
<tr>
<td>Chopper</td>
<td>Alt+2</td>
<td>Allows you to select portions of a media file that can be placed into tracks as events.</td>
</tr>
<tr>
<td>Mixer</td>
<td>Alt+3</td>
<td>Allows you to work with busses, assignable effect chains, and soft synth controls.</td>
</tr>
<tr>
<td>Video</td>
<td>Alt+4</td>
<td>Displays a project’s video output at the current cursor position in the timeline.</td>
</tr>
<tr>
<td>Audio Plug-In</td>
<td>Alt+5</td>
<td>Allows you to view and edit settings for assignable, bus, soft synth, and track effect chains.</td>
</tr>
<tr>
<td>Track Properties</td>
<td>Alt+6</td>
<td>Allows you to view and edit track attributes. For MIDI tracks, allows you to edit MIDI using the piano roll editor, list editor or other OPT plug-ins.</td>
</tr>
<tr>
<td>Surround Panner</td>
<td>Alt+7</td>
<td>In a 5.1 surround project, this allows you to control panning for a track or mixer control.</td>
</tr>
<tr>
<td>Soft Synth Properties</td>
<td>Alt+8</td>
<td>Allows you to change the attributes of a soft synth control in the Mixer window.</td>
</tr>
</tbody>
</table>
Docking and floating ACID windows

The window docking area allows you to keep frequently used windows available but out of the way while you are working with a project. You can dock windows either in a single stack spanning the width of the screen or divide the window docking area into sections (e.g., right, middle, and left) and create several stacks.

Windows that are not visible display a tab that you can click to display it. You can also expand, restore, or close a window using the buttons in the window’s upper-left corner.

Docking windows

1. If the window is floating on the workspace, grab the window by its title bar and drag it below the track view. As you drag the window, the window’s outline appears.

2. Position the window’s outline in the docking area where you want it and release the mouse.

Floating windows

You may float a window so that it does not appear in the docking area.

1. Grab the window by its handle (the border along the left side) and drag the window to the workspace. As you drag the window, the window’s outline appears.

2. Position the window anywhere in the workspace and release the mouse. You can move the floating window by dragging it to a new position or docking it again.

Note: When the last window in the docking area is closed or removed, the docking area minimizes automatically. When the docking area is minimized, dragging a dockable window over the bottom of the ACID window causes the docking area to open again.
Preventing windows from docking

Press [Ctrl] while dragging a window to prevent it from docking in the workspace.

**Note:** You can choose to reverse this behavior so that windows will not dock unless you press [Ctrl]. From the **Options menu**, choose **Preferences**, and clear the **Allow floating windows to dock** check box on the **General tab**.

Resizing the window docking area

You can resize the track list, track view and docking area sections of the ACID workspace by dragging the dividers between them.

**Tip:** You can quickly hide or show the window docking area by pressing [F11].

Changing the time ruler format

You may specify a time format for the ACID time ruler to display. The ruler, located below the track view, displays real time in several formats. You may change the ruler format in one of the following ways:

- From the **View menu**, choose **Time Ruler**, and choose the desired format from the submenu.
- Right-click the time ruler and choose the desired format from the shortcut menu. In addition to right-clicking the time ruler in the track view, you can use this technique on the time rulers in the Chopper and Track Properties windows.

The following table describes the time formats available in ACID.

<table>
<thead>
<tr>
<th>Time format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Samples</td>
<td>Displays the time ruler in samples.</td>
</tr>
<tr>
<td>Time</td>
<td>Displays the time ruler in hours:minutes:seconds.milliseconds.</td>
</tr>
<tr>
<td>Seconds</td>
<td>Displays the time ruler in seconds.</td>
</tr>
<tr>
<td>Time &amp; Frames</td>
<td>Displays the time ruler in hours:minutes:seconds.frames with a frame rate equal to that of your video.</td>
</tr>
<tr>
<td>Absolute Frames</td>
<td>Displays the time ruler in total frames from the beginning of the project.</td>
</tr>
<tr>
<td>Feet &amp; Frames 16 mm</td>
<td>Displays the time ruler in feet+frames at a rate of 40 frames per foot.</td>
</tr>
<tr>
<td>Feet &amp; Frames 35 mm</td>
<td>Displays the time ruler in feet+frames at a rate of 16 frames per foot.</td>
</tr>
<tr>
<td>SMPTE Film Sync (24 fps)</td>
<td>Displays the time ruler in hours:minutes:seconds.frames with a frame rate of 24 frames per second for synchronizing with film.</td>
</tr>
<tr>
<td>SMPTE EBU (25 fps)</td>
<td>Displays the time ruler in hours:minutes:seconds.frames with a frame rate of 25 frames per second for European Broadcasting Union.</td>
</tr>
<tr>
<td>SMPTE Non-Drop (29.97 fps)</td>
<td>Displays the time ruler in hours:minutes:seconds.frames with a frame rate of 29.97 frames per second.</td>
</tr>
<tr>
<td>SMPTE Drop (29.97 fps)</td>
<td>Displays the time ruler in hours:minutes:seconds.frames with a frame rate of 29.97 frames per second using dropped frame numbers.</td>
</tr>
<tr>
<td>SMPTE 30 (30 fps)</td>
<td>Displays the time ruler in hours:minutes:seconds.frames with a frame rate of 30 frames per second.</td>
</tr>
</tbody>
</table>

Using the ruler offset

The ruler offset allows you to change the project ruler to start at a specific time. Typically, this feature is used in conjunction with SMPTE and MIDI projects when their timelines are the main reference. Basically, the ruler offset allows you to set the ACID time ruler based on another project’s timeline for reference purposes, i.e., the SMPTE or MIDI timelines.
When you enter a new value along the timeline, ACID adjusts the ruler’s time units at the cursor position and at the start of the timeline. For example, if the cursor is positioned at the 2:00 minute mark and you enter 15:00 minutes, the start of the project will begin at 13:00 minutes. The ruler offset feature works the same for all time formats in ACID.

1. Position the cursor anywhere along the timeline.
2. Right-click the time ruler to display a shortcut menu.
3. From the shortcut menu, choose Set Time at Cursor. A box opens at the cursor position.
4. Enter a time value.
5. Press [Enter] to set the cursor position’s time value. The value that you enter at the cursor position affects all time values that precede and follow it.

Using the project grid

The project grid appears on the track view and is mainly used to align the events in your project. The grid divides your project into equal units based on the setting that you choose. The grid setting can be based on the project type or how you prefer to work.

It is important to remember that in some cases the grid lines and the ruler divisions do not match. This is because they are two independent functions. However, you may set the grid to align to the ruler, which is the default setting.

The grid can use the following formats:

| Ruler Marks         | 16th Notes
|---------------------|------------
| Measures            | 16th Note Triplets
| Half Notes          | 32 Notes
| Quarter Notes       | 32nd Note Triplets
| Quarter Note Triplets| 64th Notes
| 8th Notes           | 64th Note Triplets
| 8th Note Triplets   |             |

Setting the grid type

You may change the grid type at any time and apply it to your project. There are two ways to set the grid type for your project.

- From the Options menu, choose Grid Spacing, and choose the type of grid you want from the submenu.
- Right-click the marker bar, choose Grid Spacing from the shortcut menu, and choose the type of grid that you want from the submenu.
Using the toolbar

ACID is set up to display the toolbar below the menu bar. However, you may hide and customize the toolbar to suit your preferences. The settings that you apply to the toolbar remain set until you change them again.

Hiding and displaying the toolbar

If you prefer to use shortcut keys when working with your project, you may hide the toolbar to create more workspace. Choose Toolbar from the View menu to hide it. The check mark next to the command is removed and the toolbar disappears. The toolbar remains hidden until you choose Toolbar from the View menu to display it again.

Reordering toolbar buttons

ACID allows you to change the toolbar’s button order to suit your preferences. You may either reorder the buttons directly on the workspace or via the Customize Toolbar dialog.

Reordering buttons on the ACID workspace

1. Hold Shift and drag the button that you want to move to the new location on the toolbar. A hand icon (Index) within an outline of the button indicates that you are moving the button.
2. Release the mouse to drop the button in its new location.

Tip: If you drag the button off the toolbar, the button is removed.

Reordering buttons in the Customize Toolbar dialog

The Customize Toolbar dialog allows you to control the order and functionality available on the Toolbar. You may return the toolbar to its default settings by clicking the Reset button.

1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog appears.

2. On the Current toolbar buttons pane, select the button that you want to move and click Move Up or Move Down.
3. Click Close to save the toolbar changes and close the dialog.
Adding buttons to the toolbar

ACID includes a series of buttons that you may add to the toolbar. These buttons are listed in the Customize Toolbar dialog. You may also add separators on the toolbar to organize the buttons to suit your preferences.

You may return the toolbar to its default settings by clicking the Reset button on the dialog.

1. From the **Options** menu, choose **Customize Toolbar**. The Customize Toolbar dialog appears.

2. On the Available toolbar buttons pane, use the scroll bars to locate the button that you want to add and select it.

3. On the Current toolbar buttons pane, select the button that you want the newly added button to proceed in order.

   For example, if you want to add the Save As button and want it to precede the Publish To button, select the Publish To button in the Current toolbar buttons pane.

4. Click **Add**. The new button is added above the selected button on the Current toolbar buttons pane.

   **Tip:** You may also double-click a button to add it to the toolbar.

5. Click **Close** to save the toolbar settings and close the dialog.

Removing buttons from the toolbar

You may remove buttons and separators from the toolbar. If you have added buttons to the toolbar, removing unused or unwanted buttons allows you to maximize the toolbar’s space. You may remove toolbar buttons either directly on the workspace or via the Customize Toolbar dialog.

**Removing buttons on the ACID workspace**

1. Hold **Shift** and drag the button that you want to remove off the toolbar. A hand icon within an outline of the button indicates that you are removing the button.

2. Release the mouse to remove the button.
Removing buttons in the Customize Toolbar dialog

You may return the toolbar to its default settings by clicking the Reset button on this dialog.

1. From the Options menu, choose Customize Toolbar. The Customize Toolbar dialog appears.
2. On the Current toolbar buttons pane, select the button that you want to remove.
3. Click Remove. The button is removed from the Current toolbar buttons pane and will not appear on the toolbar.

   Tip: You may also double-click a button to remove it.

4. Click Close to save the toolbar settings and exit the dialog.

Using the time display

The time display above the track list reflects the cursor’s position on the timeline.

Changing cursor position

You can edit the cursor position using time as it is displayed on either the beat ruler or time ruler:

- To set the cursor’s position based on the beat ruler, right-click the time display and choose Edit Cursor Position - Beats from the shortcut menu.
- To set the cursor’s position based on the time ruler, right-click the time display and choose Edit Cursor Position - Time from the shortcut menu.

Once you make your selection from the shortcut menu, a box appears for the appropriate time display. Enter the cursor’s new position and press Enter.

   Tip: You can also edit the cursor position directly by double-clicking the desired time display value and entering the new cursor position.

Changing the time display

The time display window always reflects the format of the time ruler. You may change the ruler settings for the time ruler via the time display window.

1. Right-click the time display window to display a shortcut menu.
2. Choose Time at Cursor Format to display a submenu.
3. Choose the desired time format.
   - Both the time window and time ruler display the chosen time format.
Monitoring MIDI timecode

You can use the time display to monitor incoming or outgoing MIDI timecode.

ACID can be set to monitor MIDI in the following ways:

- Display MIDI timecode generated from external sources.
- Display MIDI timecode and MIDI clock information that ACID is generating.

Within ACID, the time display settings work in conjunction with your project’s properties and MIDI setup options.

1. Right-click the time display window to display a shortcut menu.
2. From the shortcut menu, choose the type of MIDI monitoring for ACID to display.

Once you have made your selection, the time display window displays both the MIDI code being input or output and a status message.

Setting default track properties

Each new track in ACID has certain default properties, including height, volume, pan type, and track effects. MIDI tracks also have a default set of MIDI editors that appear in the Track Properties window. You can modify these track properties and then use the modified track as a standard for all new tracks you create.

1. Modify a track’s volume (pg. 46), pan type (pg. 103), height (pg. 45), track effects (pg. 93), and/or MIDI editors (pg. 147).
2. Right-click the track header and choose Set Default Track Properties from the shortcut menu.
3. Select the check boxes for properties you wish to set. Clear the check boxes for the properties you wish to leave as they are.

   Tip: Select the Restore original defaults check box to return to the original track properties.

4. Click OK.
Setting ACID preferences

From the **Options** menu, choose **Preferences** to display the Preferences dialog.

### Using the General tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically open last project on startup</td>
<td>Select this check box if you want ACID to reopen the project that was open the last time ACID was closed. When you clear this check box, ACID starts with a blank project.</td>
<td>Automatically open last project on startup</td>
</tr>
<tr>
<td>Show logo splash screen on startup</td>
<td>Select this check box if you want the ACID logo splash screen to display when ACID starts.</td>
<td>Use Net Notify to stay informed about Sonic Foundry products</td>
</tr>
<tr>
<td>Use Net Notify to stay informed about Sonic Foundry products</td>
<td>When you select this check box, ACID periodically displays information from Sonic Foundry at startup. Clear the check box to bypass the Net Notify dialog.</td>
<td>Use Net Notify to stay informed about Sonic Foundry products</td>
</tr>
<tr>
<td>Draw contents of events</td>
<td>Select this check box if you want ACID to draw waveforms in events. Clearing the check box can improve performance on some systems.</td>
<td>Use Net Notify to stay informed about Sonic Foundry products</td>
</tr>
<tr>
<td>Create undos for FX parameter changes</td>
<td>Select this check box if you want ACID to create Undos when you change a plug-in parameter.</td>
<td>Draw contents of events</td>
</tr>
<tr>
<td>Confirm media file deletion when still in use</td>
<td>When you select this check box, a message box appears asking if you want to delete a media file that is currently in use by the project.</td>
<td>Confirm media file deletion when still in use</td>
</tr>
<tr>
<td>Close media files when ACID is not the active application</td>
<td>When you select this check box, you can edit files in external editors while the files are contained in events in ACID.</td>
<td>Close media files when ACID is not the active application</td>
</tr>
<tr>
<td>Close audio and MIDI ports when ACID is not the active application</td>
<td>Select this check box if you want ACID to close audio and MIDI ports when you switch to another application. Clear the check box if you want to leave ports open. For example, if you have a MIDI keyboard routed to a soft synth in ACID, clearing the check box allows you to continue to hear the soft synth while you work with a sequencer.</td>
<td>Close audio and MIDI ports when ACID is not the active application</td>
</tr>
<tr>
<td>Enable multimedia keyboard support</td>
<td>When you select this check box, you can use a multimedia keyboard to control playback of a project.</td>
<td>Enable multimedia keyboard support</td>
</tr>
<tr>
<td>Automatically render large Wave files as Wave64</td>
<td>The WAV format is limited by a maximum file size of ~2GB. When you select this check box, you can render larger files as Sonic Foundry Wave64 files.</td>
<td>Automatically render large Wave files as Wave64</td>
</tr>
<tr>
<td>Prompt for region and marker names if not playing</td>
<td>When you select this check box, a box appears so you can name markers and regions as you place them.</td>
<td>Prompt for region and marker names if not playing</td>
</tr>
<tr>
<td>Create project file backups on save (.acd-bak)</td>
<td>When you select this check box, ACID makes a backup of project files when you open them. Backup files are stored in the same folder as your project and use the same file name with the extension .acd.bak. You can use backup project files to revert to a project's previous state.</td>
<td>Create project file backups on save (.acd-bak)</td>
</tr>
<tr>
<td>Preserve pitch for new Beatmapped tracks when tempo changes</td>
<td>Select the check box if you want ACID to maintain the pitch of Beatmapped tracks when the project tempo changes.</td>
<td>Preserve pitch for new Beatmapped tracks when tempo changes</td>
</tr>
<tr>
<td>Automatically start the Beatmapper Wizard for long files</td>
<td>Select the check box if you want ACID to start the Beatmapper Wizard when you add a file that is longer than 30 seconds to your project.</td>
<td>Automatically start the Beatmapper Wizard for long files</td>
</tr>
<tr>
<td>Use slower updates to prevent playback clicks during editing</td>
<td>Select this check box if you want ACID to update the audio engine more slowly. Selecting this option can prevent unwanted artifacts during timeline editing.</td>
<td>Use slower updates to prevent playback clicks during editing</td>
</tr>
<tr>
<td>Enable autosave</td>
<td>Select this check box to create a temporary project file that can aid in crash recovery. ACID autosaves your project information every five minutes without overwriting your project file.</td>
<td>Enable autosave</td>
</tr>
<tr>
<td>Allow floating windows to dock</td>
<td>Select this check box if you want to allow floating windows (such as the Explorer and Chopper) to dock in the window docking area. You can press the Ctrl key while dragging a window to prevent a window from docking. Clear the check box if you want to prevent windows from docking. You can press the Ctrl key while dragging a window to allow a window to dock.</td>
<td>Allow floating windows to dock</td>
</tr>
<tr>
<td>Use ASPI for CD burning and ripping</td>
<td>Select this check box if you want ACID to use ASPI (Advanced SCSI Programming Interface) when burning and ripping CDs. ASPI enables host adapters and device drivers to share a single SCSI hardware interface.</td>
<td>Use ASPI for CD burning and ripping</td>
</tr>
<tr>
<td>Use SPTI for CD burning</td>
<td>Select this check box if you want ACID to use SPTI (SCSI Pass-Through Interface) to communicate with your CD burning drive.</td>
<td>Use SPTI for CD burning</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Autoname extracted CD tracks</td>
<td>Select this check box if you want ACID to automatically assign file names to tracks that you extract from CDs. File names include the CD’s ID number and track number.</td>
<td></td>
</tr>
<tr>
<td>Autoname new MIDI tracks</td>
<td>Select this check box if you want ACID to automatically name and save new MIDI files as you create them. ACID names the file New MIDI track X and saves it to the recorded files folder designated in the Record dialog. When this check box is cleared, ACID prompts you to specify a name and location for each new MIDI file as you add it to your project.</td>
<td></td>
</tr>
<tr>
<td>Use bright colors for loop stretch markers</td>
<td>Select this check box if you want to use bright colors for your stretch markers in the Stretch tab of the Track Properties dialog. When this check box is cleared, ACID uses muted pastel colors for the stretch markers.</td>
<td></td>
</tr>
<tr>
<td>Recently used project list</td>
<td>Select the check box and enter a number in the box if you want ACID to list your most recently used projects at the bottom of the File menu.</td>
<td></td>
</tr>
<tr>
<td>Temporary files folder</td>
<td>Displays the folder where ACID stores temporary files. Click Browse to specify a new folder. When you add a media file to a project from a removable device, ACID stores a copy of the media file in a temporary files folder. This keeps the media file available for use even if the source of the media is no longer accessible. Be aware that this folder is cleared when you close ACID. However, the temporary files are not cleared if ACID closes inappropriately.</td>
<td></td>
</tr>
<tr>
<td>Free storage space in selected folder</td>
<td>This value displays the amount of space available in the folder specified in the Temporary files folder box.</td>
<td></td>
</tr>
<tr>
<td>Default All</td>
<td>Restores all general preferences to the default settings.</td>
<td></td>
</tr>
</tbody>
</table>
### Using the Audio tab

#### Setting audio preferences

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Audio device type</strong></td>
<td>Choose a driver type from the drop-down list. The Microsoft Sound Mapper is the default setting. If you want to activate specific sound cards, choose Windows Classic Wave Driver or an ASIO driver and choose a device from the Default Stereo and Front playback device drop-down list.</td>
</tr>
<tr>
<td><strong>Default Stereo and Front playback device</strong></td>
<td>Choose the device that you want to use for playing sound data. In a 5.1 surround project, this device plays the right and left channels. Selecting a device such as the Microsoft Sound Mapper allows Windows to select an appropriate device to use for the current sound data. If you have selected Microsoft Sound Mapper, you cannot assign busses to different devices.</td>
</tr>
<tr>
<td><strong>Default Rear playback device</strong></td>
<td>Choose the device that you want to use for playing the rear surround channels (right surround and left surround) in a 5.1 surround project.</td>
</tr>
<tr>
<td><strong>Default Center and LFE playback device</strong></td>
<td>Choose the device that you want to use for playing the center and LFE channels in a 5.1 surround project.</td>
</tr>
<tr>
<td><strong>Playback buffering (seconds)</strong></td>
<td>The Playback buffering (seconds) slider specifies the total amount of buffering that ACID uses during playback. The larger the number, the more buffering that ACID does during playback. This value should be as low as possible without gapping. To set it, start at .25 and play a typical song. Move some of the track faders. If the playback gaps at all, try increasing this slider in small increments until the gapping stops. If you simply cannot get playback to be free of gapping, you need to either decrease the number of tracks you are trying to play simultaneously, install more RAM in your computer so you can increase buffering, buy a faster access hard drive, or minimize the number of DirectX plug-ins you are trying to use simultaneously.</td>
</tr>
<tr>
<td><strong>Automatically detect and offset for hardware recording latency</strong></td>
<td>Select this check box to automatically compensate for offset between the time you initiate recording and when your sound card starts recording.</td>
</tr>
<tr>
<td><strong>User recording latency offset</strong></td>
<td>Drag this slider to specify an offset value.</td>
</tr>
<tr>
<td><strong>Open files as loops if between (seconds)</strong></td>
<td>Enter a lower and upper limit to specify which files ACID opens as loops if stretching properties are not saved in the file. Files that are shorter than the lower limit are opened as one-shot tracks; files longer than the upper limit start the Beatmapper Wizard.</td>
</tr>
<tr>
<td><strong>Quick fade edit edges of audio events</strong></td>
<td>When you select this check box, ACID places a rapid fade on the edges of audio events (10 ms by default) to soften potentially harsh transitions. When you clear this check box, edges of new events are not faded (fares that were applied before the check box is cleared are not removed). Right-click an event and select or clear the Quick Fade Edges command to override the default event fade behavior for individual events.</td>
</tr>
<tr>
<td><strong>Quick fade time</strong></td>
<td>Enter a time (in milliseconds) to specify the duration of fades applied to the edges of events.</td>
</tr>
<tr>
<td><strong>Default All</strong></td>
<td>Restores all audio preferences to the default settings.</td>
</tr>
</tbody>
</table>
Setting advanced audio preferences

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio devices</td>
<td>This list displays all of the audio devices that are installed in your computer. Selecting a device allows you to set the options for that device.</td>
</tr>
<tr>
<td>Interpolate position</td>
<td>When you select this check box, ACID attempts to compensate for inaccurate devices by interpolating the playback or recording position. If you notice that your playback cursor is offset from what you are hearing, select this option for the playback device.</td>
</tr>
<tr>
<td>Position bias</td>
<td>If the position of playback or record does not match what you hear after you enable Interpolate position, you can attempt to compensate using the Position bias slider. Moving this slider offsets the position forward or backward to compensate for the inaccuracies of the device.</td>
</tr>
<tr>
<td>Do not pre-roll buffers before starting playback</td>
<td>When you select this check box, ACID does not create buffers prior to starting playback. Some devices do not behave properly if you clear this check box. If your audio stutters when you start playback, try selecting this option.</td>
</tr>
<tr>
<td>Audio buffers</td>
<td>Drag the slider to set the number of audio buffers that will be used. Adjusting this setting can decrease gapping or help you synchronize the input and output for record input monitoring.</td>
</tr>
<tr>
<td>Buffer size (samples)</td>
<td>Choose a setting from the drop-down list to indicate the buffer size you want to use.</td>
</tr>
<tr>
<td>Priority</td>
<td>Choose a setting from the drop-down list to set the priority that is assigned to your audio buffers. Increasing the buffers’ priority can help you attain smoother playback, but it can also adversely affect other processes.</td>
</tr>
<tr>
<td>Enable input monitoring</td>
<td>Select this check box to enable the monitoring of your recording input through ACID while you are recording.</td>
</tr>
</tbody>
</table>

Using the MIDI tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make these devices available for MIDI</td>
<td>In the Port column, select the MIDI devices that you want to be available for track playback (pg. 149) and generating MIDI clock (pg. 152). In the MIDI Thru column, right-click an entry and choose a MIDI device from which the device selected in the Port column will accept incoming MIDI.</td>
</tr>
<tr>
<td>track playback and Generate MIDI Clock</td>
<td></td>
</tr>
<tr>
<td>Make these devices available for MIDI</td>
<td>In the Port column, select the MIDI devices from which you will accept incoming MIDI data for MIDI recording (pg. 131), step recording in the list editor (pg. 145), or controlling a soft synth (pg. 150). In the MIDI Thru column, right-click an entry and choose a MIDI device to which the device selected in the Port column will send MIDI output. You can choose more than one device to accept MIDI output.</td>
</tr>
<tr>
<td>input</td>
<td></td>
</tr>
<tr>
<td>Auto MIDI input routing</td>
<td>Select the check box if you want ACID to automatically route MIDI input devices to the soft synth that was viewed last in the Soft Synth Properties window. The Solo Listen to MIDI Input button in the Soft Synth Properties window is unavailable when this check box is selected.</td>
</tr>
<tr>
<td>Default All</td>
<td>Restores all MIDI preferences to the default settings.</td>
</tr>
</tbody>
</table>

Using the VST Instruments tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default VSTi search folder</td>
<td>Displays the location where ACID looks for VST instrument files.</td>
</tr>
<tr>
<td>Alternate VSTi search folder X</td>
<td>Click Browse to choose an alternate location where ACID can find VST instrument files.</td>
</tr>
<tr>
<td>Select VST instruments to be available as soft synths</td>
<td>Select the VST plug-ins that you want available for use as soft synths in ACID. Only the VST instruments located in the default or alternate search folders appear in this box. After you add a VSTi soft synth to a project, the VST instrument stays locked until you close ACID. When a VST instrument is locked, the lock icon for that VSTi displays as locked, and you cannot clear the VSTi’s check box to make it unavailable in ACID.</td>
</tr>
</tbody>
</table>
### Using the ReWire Devices tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select ReWire device to be available as</td>
<td>Select the ReWire client(s) that you want available for use as soft synths in ACID.</td>
</tr>
<tr>
<td>soft synths</td>
<td></td>
</tr>
</tbody>
</table>

### Using the Video tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show source frame numbers on video</td>
<td>Choose a setting from the drop-down list to change the format used to display frame numbers in the video track, or choose None to turn off frame numbering.</td>
</tr>
<tr>
<td>thumbnails as</td>
<td></td>
</tr>
<tr>
<td>External monitor device</td>
<td>Choose a DV output device from the drop-down list. This is the interface to which your video device is connected.</td>
</tr>
<tr>
<td>Details</td>
<td>Displays information about the device selected in the External monitor device drop-down list.</td>
</tr>
<tr>
<td>If project format is invalid for DV output, conform to the following</td>
<td>If your source media does not conform to DV standards, choose a setting from the drop-down list. ACID adjusts the video to display properly on your external monitor.</td>
</tr>
<tr>
<td>Sync offset (frames)</td>
<td>If your audio is not synchronized with your external monitor, you can configure an offset for your hardware. Drag the slider to synchronize audio and video. This setting affects synchronization for previewing on an external monitor. Audio and video synchronization in your ACID project is unaffected.</td>
</tr>
<tr>
<td>Default All</td>
<td>Restores all video preferences to the default settings.</td>
</tr>
</tbody>
</table>

### Using the Editing tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project tempo range</td>
<td>Use the up and down arrows or enter a value in the boxes to specify the minimum and maximum tempo available in the ACID project. Changing this option affects the resolution of the Project Tempo slider.</td>
</tr>
<tr>
<td>Editing Application X</td>
<td>Enter the name of each editor you want to display in the track list shortcut menu. Right-click a track in the track list and choose Edit in [editor name] to edit the media file associated with a track. You can specify any editing tool you want to use; however, this feature was designed for use with destructive audio/MIDI editors.</td>
</tr>
<tr>
<td>Browse</td>
<td>Click Browse and select the .exe file for each editor you want to have available in the track list shortcut menu.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter the name that you want to use to identify each editor. The name is displayed in the track list shortcut menu and the Tools menu.</td>
</tr>
<tr>
<td>Clear</td>
<td>Removes the specified editor from the Editing tab.</td>
</tr>
<tr>
<td>Check for Sonic Foundry editors</td>
<td>When you select this check box, ACID automatically searches for available Sonic Foundry editors on your computer. If ACID locates one, it appears as an available editor in the Editing Application X box.</td>
</tr>
<tr>
<td>Default All</td>
<td>Restores all editing preferences to the default settings.</td>
</tr>
</tbody>
</table>
## Using the Sync tab

### Setting sync preferences

#### Generate MIDI Timecode settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Output device</strong></td>
<td>Choose a MIDI device from the drop-down list. ACID sends MIDI timecode to this device. The MTC slave should also be set to this device. This device will not be available for MIDI playback.</td>
</tr>
<tr>
<td><strong>Frame rate</strong></td>
<td>Choose a frame rate from the drop-down list. ACID uses this frame rate to generate the MIDI timecode. The MTC slave must be set to the same frame rate.</td>
</tr>
</tbody>
</table>

#### Generate MIDI Clock settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Output device</strong></td>
<td>Choose a MIDI device from the drop-down list. ACID sends MIDI clock to this device. The MIDI clock slave should also be set to this device.</td>
</tr>
</tbody>
</table>

#### Trigger from MIDI Timecode settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Input device</strong></td>
<td>Choose a MIDI device from the drop-down list. ACID receives MIDI timecode from this device. The MTC master should also be set to this device.</td>
</tr>
<tr>
<td><strong>Frame rate</strong></td>
<td>Choose a frame rate from the drop-down list. This value specifies the frame rate at which the MTC master sends timecode to ACID.</td>
</tr>
<tr>
<td><strong>Advanced</strong></td>
<td>Click to open the Advanced Sync Preferences dialog.</td>
</tr>
<tr>
<td><strong>Default All</strong></td>
<td>Restores all sync preferences to the default settings.</td>
</tr>
</tbody>
</table>
Setting advanced sync preferences

**MTC Input**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free-wheel for timecode loss</td>
<td>Select this check box if you want ACID to continue to play if timecode is lost. Enabling this option can compensate for infrequent losses in timecode. If you frequently lose timecode, you should perform troubleshooting to determine the cause of the problem.</td>
</tr>
<tr>
<td>Free-wheel slack time</td>
<td>Use the up and down arrows or enter a value in the box to specify the amount of time that timecode can be lost before the free-wheel playback time starts. A longer time is more tolerant of breaks in the incoming timecode.</td>
</tr>
<tr>
<td>Free-wheel playback time</td>
<td>Use the up and down arrows or enter a value in the box to specify the amount of time that ACID plays back after the free-wheel slack time has been exceeded.</td>
</tr>
<tr>
<td>Synchronization delay time</td>
<td>Use the up and down arrows or enter a value in the box to specify the amount of time it takes for ACID to synchronize itself to incoming timecode. On slower computers, this time should be set to approximately two seconds. On faster computers, it may be set lower. Setting this value too low can sometimes result in audible pitch shifting at the start of playback.</td>
</tr>
<tr>
<td>Offset adjust</td>
<td>If ACID is consistently behind or ahead of your MTC generator, enter a value in the box to adjust a synchronization offset with quarter-frame accuracy. If ACID is behind, set this value to a negative number. A setting of -4 is a common offset. If ACID is ahead, set this value to a positive number. A setting of +4 is a common offset, although it is rare that ACID will sync ahead.</td>
</tr>
</tbody>
</table>

**MTC Output**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full-frame message generation</td>
<td>Select a radio button to determine when ACID sends full-frame timecode messages while Generate MIDI Timecode is active. Full-frame messages are used by some external synchronizable audio devices to seek to a proper location prior to actually starting synchronization. Tape-based recorders especially benefit from seeking to full-frame messages because of the time it takes to move the transport to the proper location. However, full-frame messages are ignored by some devices, and may actually cause unexpected behavior in other devices. Refer to your hardware documentation to find out if your hardware supports full-frame messages.</td>
</tr>
</tbody>
</table>

**MIDI Clock Output**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Send Start instead of Continue when beginning playback</td>
<td>Select this check box if you want ACID to send a Start command rather than a Continue command when Generate MIDI Clock is activated. When the check box is cleared, ACID sends a Continue command, as this type of command allows the chasing device to start from a specific time. However, some older sequencers that support MIDI Clock chase do not support the Continue command and must start playback from the beginning every time.</td>
</tr>
<tr>
<td>Song Position Pointer generation</td>
<td>Select a radio button to determine when ACID sends Song Position Pointer messages while Generate MIDI Clock is active. Song Position Pointer messages are used by MIDI applications and devices to seek to a proper location prior to starting synchronization.</td>
</tr>
</tbody>
</table>

**Using the Other tab**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Envelope color preference for</td>
<td>Select an envelope from the drop-down list in order to customize the envelope’s color. Choose Default to accept the standard envelope color, or choose Custom and use the Red, Green, and Blue sliders to create a custom color.</td>
</tr>
<tr>
<td>Enable multiple-selection preview in Explorer window</td>
<td>Select this check box if you want to preview multiple selected files in the Explorer. Enter values in the Number of times to repeat each Loop, Seconds of each One-Shot to play, and Number of Beatmapped measures to play boxes to specify how ACID previews different file types.</td>
</tr>
</tbody>
</table>
ACID Tips and Tricks

The following sections contain some time-saving tips and creative suggestions for building projects in ACID.

Adding long media files quickly

You can paint an entire CD track or MIDI file on an ACID track with a single click.

1. Add a long file such as a CD track or MIDI file to your ACID project. For more information, see Adding media to the project on page 36.

2. Click the Paint Tool button ( ). The Paint tool is selected.

3. Press Ctrl and click in the track. ACID paints the entire file onto the track at the position you clicked.

   Note: In a Beatmapped track, ACID paints the file starting from the location you identified as the downbeat. If the file contains pick-up notes, drag the left edge of the event to reveal audio before the downbeat.

Playing with duplicate tracks

You can duplicate a track in your ACID project and then use the new track to create some interesting effects.

Detuning paired tracks

Detuning a paired track is a quick and easy way to thicken an audio track without adding the additional processing of effects. This trick works extremely well with synths, pads, strings and ambient sounds, but you can also experiment with it to add body to drums, basses, and horns.

1. Right-click a track and choose Duplicate Track from the shortcut menu. ACID adds a copy of the track to the track list. The new track is the currently selected track.

2. Use the + and - keys on your numeric keypad to change the pitch of the duplicated track.

   Octave intervals (e.g., +12, -12, -24) typically sound best when working with pitched audio; however, experimenting with other, less ordinary intervals may produce surprising results. When working with non-pitched audio, intervals do not matter, thereby allowing you to freely experiment with radical pitch shifting.

   This technique typically works best when tuning the duplicate track to a lower octave than the original track, but you can also experiment with raising the pitch of the duplicate track.
Panning in conjunction with detuning

Few things are as uninteresting as a series of tracks panned down the middle of a stereo image. Particularly after detuning a paired track, you should experiment with spatially positioning the tracks using the panning control (on the multipurpose slider) or a pan envelope. Panning each track to a specific channel produces a nice, wide aural effect. If you are looking for something a little more dynamic, position the original track anywhere in the stereo image and use a pan envelope to sweep the duplicate track from the left channel to the right channel of the mix. For more information, see Using track envelopes on page 97.

Duplicating with offset

Another way to add interesting dynamics to a project is to duplicate tracks and add an offset to one of the pair. This trick works well with most instrument loops and allows you to create different levels of effect. For example:

- Configuring a slight offset between duplicate tracks creates a natural chorus effect.
- Configuring small offsets creates various reverb effects.
- Configuring larger offsets creates interesting echoes.

1. Right-click a track and choose Duplicate Track from the shortcut menu. ACID adds a copy of the track to the track list.
2. Hold Alt while dragging the waveform of the duplicate track. Notice that the waveform moves within the event, which retains its size and position on the timeline.
3. Experiment with different offsets between the duplicate tracks.

Tip: As with most tricks, this method can be combined with pan and volume envelopes to produce an unlimited range of effects.

Creating ping-pong pan effects

You can use a pair of tracks to ping-pong audio from one speaker to another.

1. Right-click a track and choose Duplicate track from the shortcut menu. ACID adds a copy of the track to the track list.
2. Use the multipurpose slider to pan the original track 100% right and the duplicate track 100% left.
3. Use the Erase tool ( ) to erase every other beat, alternating between the original and duplicate track.

Tip: You can also use a pan envelope on a single track to create the same effect. For more information, see Using track envelopes on page 97.
Adding depth with assignable effects

You can add depth to your mix by panning a dry signal (no effects) to one side and a wet signal (with effects such as chorus or reverb) to the other. You can pan the dry and wet signals by adding an assignable effects chain to your project.

1. Add an assignable effects chain containing an effect such as chorus or reverb to your project. For more information, see Adding assignable effect controls on page 113.

2. Press [U] to view bus tracks. For more information, see Automating mixer controls in track view on page 125.

3. Right-click the bus track for the assignable effect control, choose Insert/Remove Envelope from the shortcut menu, and choose Pan from the submenu. A pan envelope appears on the bus track.

4. Drag the envelope down to 100% right.

5. Use the multipurpose slider (on the track to which you want to apply the effect) to make three changes:
   - Pan the track 100% left.
   - Set the assignable effect send to approximately the same volume as the track.
   - Set the assignable effect send to Pre Volume.

Preview the effect. The dry signal is panned to the left, and the wet signal (with the chorus or reverb effect) is panned to the right.

Playing double time/half time

You can also produce interesting effects by misinforming ACID regarding the number of beats in a file. Configuring a file with half its actual number of beats results in double-time playback. This is an easy way to add speed metal drum tracks to your project. This technique is also useful for adding a kick drum on every beat to producing a heavy dance foundation. Conversely, configuring a file with twice its actual number of beats results in half-time playback.

1. Right-click the desired track in the track list and choose Properties from the shortcut menu. The Track Properties window appears.

2. Click the Stretch tab.

3. Change the value in the Number of beats box.
Constructing the wall of sound

As mentioned previously, it is sometimes preferable to color and thicken mixes without resorting to effects and other digital processing. Working without the benefit of multitrack recording, music producer Phil Spector colored his songs by having several instruments play slightly different parts. For example, he might have an acoustic bass, an electric bass, and a piano play slight variations on the same basic riffs. These variations, along with the different timbre of the actual instruments, produced a dense sonic mass that became known as The Wall of Sound.

- To add this aural density to your projects, experiment with using two, three, or even four tracks of similar instrumentation.
- Alter the pitch of specific tracks to help them cut through the mix. For more information, see Changing a track’s key on page 82.
- Further differentiate specific tracks using pan and volume envelopes to color the project and simulate live performance. For more information, see Using track envelopes on page 97.
- Make the effects even more pronounced by setting a start offset within specific individual events. For more information, see Changing event properties on page 68.

Adding through subtraction

You can create dynamics by removing sections of events. You can erase sections of events from a project by using the Erase ( ) tool.

To demonstrate using subtractive arranging, add three or four similar drum loops to a project. Use the Erase tool to delete specific sections of each event. For example, erase all snares from one track, all basses from another, high hats from the third, and so on. This results in a tighter, more realistic drum sound for your project.

Experiment with taking this technique a step further and randomly remove sections from each track. When doing this, remember to keep at least one of the drum tracks playing at all times, unless you want the drums to completely drop out of the mix. Randomly removing sections of events adds realism to your projects by approximating how a drummer plays with slight variations throughout a song.

Tweaking the dynamics

You can use several techniques in ACID to adjust the dynamics of your mix.

Fading in and out of mixes

With bus tracks, you can use a volume envelope to fade in and out of the entire project.

1. Press [U] to view bus tracks. For more information, see Automating mixer controls in track view on page 125.
2. Select the Master bus track and press [Shift] + [V] to add a volume envelope.
3. Add and adjust envelope points to fade into and out of the project. For more information, see Adjusting envelopes on page 99.
Adding build ups

If you are attempting to build projects that escape the perceived limitations of computer-generated loop-based music, you should concentrate on reproducing the subtle (and not so subtle) dynamics associated with live instrumentation.

One of the simplest, but most effective examples of this is the build up. When musicians play live, there is a tendency to increase dynamics as a song enters a chorus or refrain. Think of how a drummer uses accents, drum rolls, and fills that steadily increase in volume to enter a song or indicate an approaching change from verse to chorus or chorus to bridge.

This effect is easily reproduced in ACID by adding a volume envelope to the track. Add points at the various drum beats and adjust them so that the volume steadily increases. For more information, see Adding volume or pan envelopes on page 97.

Creating wah-wah effects with automated Track EQ

You can use the automatable Track EQ effect to create a custom wah-wah effect on a track. The example below provides sample values to use in the Track EQ plug-in, but you can adjust the settings to suit your taste.

1. Click the Track FX button ( ) on the track to which you want to add the effect. The Audio Plug-In window appears.
2. Adjust the settings for band 1 as follows:
   - Frequency: 20,000
   - Gain: -14.9
   - Rolloff: 24
3. Adjust the settings for band two as follows:
   - Gain: 15
   - Bandwidth: 0.9
4. Click the FX Automation button ( ). The FX Automation Chooser dialog appears.
5. Select the Band2 Frequency check box and click OK. An effect automation envelope appears on the track.
6. Add points to the envelope so that the Band2 Frequency parameter oscillates between about 100 Hz and 3000 Hz. For more information, see Adjusting envelopes on page 99.

Making automated changes more stark

ACID envelopes allow you to change settings for a variety of features over time. While you may often use envelopes to transition smoothly from one setting to another, you can also create interesting effects by making stark changes between settings.

Abruptly changing volume or pan

By holding its setting until the next envelope point, the hold fade curve allows you to use volume and pan envelopes to make abrupt changes. For more information, see Changing envelope fade curves on page 100.

1. Select a track and press (volume) or (pan) to add an envelope.

   Tip: You can also use this technique on a bus track. For more information, see Automating mixer controls in track view on page 125.
2. Click the Envelope Tool button ( ) to select the envelope tool.

3. Right-click the first point on the envelope and choose Hold from the shortcut menu.

4. Add several more points by double-clicking the envelope. Note that each new point also has the hold fade curve.

5. Set each point to a different level. For more information, see Adjusting individual envelope points on page 100. You can repeat the pattern by copying and pasting the envelope points repeatedly. For more information, see Cutting, copying, and pasting envelope points on page 101.

Turning automated effects on and off

You can use effect automation envelopes to change effect settings over time, but you can create a simple, dramatic effect by simply automating whether the effect is processed (on) or bypassed (off).

1. Add an automatable effect to a track and adjust the effect’s parameters to your liking. For more information, see Using track effects on page 93.

2. In the Audio Plug-In window, click the FX Automation button ( ) to display the FX Automation Chooser.

3. Click the automatable plug-in at the top of the FX Automation Chooser. A list of the effect’s automatable parameters appears.

4. Select the Bypass check box and click OK. An envelope for the Bypass parameter of the effect appears on the track.

5. Add multiple points to the envelope. For more information, see Adding envelope points on page 99.

6. Adjust the envelope points to alternate between bypassing the effect (Bypass=True) and processing the effect (Bypass=False). For more information, see Adjusting individual envelope points on page 100. Preview the effect. The track alternates cleanly between processing the effect and bypassing the effect. You can repeat the pattern by copying and pasting the envelope points repeatedly. For more information, see Cutting, copying, and pasting envelope points on page 101.

Making automated frequency changes more natural

When you automate an effect’s frequency parameters, such as the frequency parameters in the track EQ effect, you may notice that the frequency changes are more apparent moving through the lower frequencies than the higher frequencies. Without getting too technical, frequency scales in track EQ and other plug-ins use a logarithmic scale instead of a linear scale. Since effect automation uses linear interpolation, an effect’s automated frequency parameter will sound as if it sweeps through the lower frequencies faster than the high frequencies. You can visualize this if you watch the plug-in settings in the Audio Plug-In window during automated effect playback.

To make automated frequency changes sound more natural, use envelope fade curves to change the rate at which interpolation happens between two envelope points. For a high-to-low frequency sweep, use a fast fade curve between points, and for a low-to-high frequency sweep, use a slow curve. Although the fast and slow curves are not logarithmic curves, they are similar enough to make the frequency transitions sound more even. For more information, see Changing envelope fade curves on page 100.
Overriding compress/expand

One of the most powerful features of ACID is its ability to compress or expand a loop while maintaining the loop’s original pitch. However, you can override this feature in order to produce specific effects in your projects.

1. Right-click a track in the track list to view the track’s Track Properties window.
2. Click the Stretch tab.
3. From the Stretching method drop-down list, choose Pitch shift segments. The track's pitch will change in relation to the tempo of the project.

While this may seem like just a way of producing old school effects, it actually has practical applications as well. For example, specifying Pitch shift segments can actually improve the fidelity of drum loops recorded at a tempo near the project tempo. In addition, overriding the compress/expand feature allows you to create great bass grooves by slowing drum loops.

Slicing and dicing in the Chopper

You can use the Chopper to add creative slice-and-dice effects to your ACID project.

Chopping new loops for alternate time signatures

The Chopper makes it easy to clone a new loop from a song or sample. This feature can be particularly handy when you want to create a loop for a different time signature. In this example, you’ll create a 3/4 pattern from a 4/4 loop.

1. Set the project time signature to 3/4. For more information, see Changing project time signature on page 80.
2. Place a 4/4 loop file in the Chopper. For more information, see Placing files in the Chopper on page 87.
3. Select a three-beat section of audio to be used for the new loop. Use the Chopper’s transport bar to preview the new loop.

Tip: You can also drag a selection from the Chopper to the track list.

5. Complete the information in the Chop to New Track dialog and click Save.

ACID saves the selection and adds the file as a 3/4 loop to a new track in the project. For more information, see Saving Chopper selections as new files on page 90.

Chopping multiple files into a new loop

Want to combine short segments of several loops into a new loop? You can use the Chopper to chop segments from several files into new loops and then combine the new loops into a single loop.

1. Place a file in the Chopper. For more information, see Placing files in the Chopper on page 87.
2. Select audio in the Chopper and press Ctrl+M to chop the audio to a new loop.
3. Repeat steps one and two for as many loop segments as you want.
4. Draw events on the new tracks to create a new melodic or rhythmic pattern.
5. Select the new tracks and from the **Tools** menu, choose **Render to New Track** to render the tracks to a single track. The Render to New Track dialog appears.

6. Complete the information in the Render to New Track dialog and click **Save**. For more information, see *Mixing multiple tracks to a single track on page 109*.

   ACID saves the new composite loop and adds it to your project as a new track.

---

**Creating drum-roll build ups**

1. Place a file in the Chopper. For more information, see *Placing files in the Chopper on page 87*.

2. Create a one-measure selection. For more information, see *Creating selections of a specific musical length on page 88*.

3. Click the **Insert Selection** button ( ) once. The selection is pasted to the track view.

4. Click the **Halve Selection** button ( ). This decreases the selected portion of the waveform by half.

5. Click **Insert Selection** button ( ) twice.

6. Click the **Halve Selection** button ( ).

7. Continue to double the number of inserts after each halving of the selection until you achieve the desired drum roll effect.

---

**Creating drum fills**

1. Place a file in the Chopper.

2. Create an eighth-note (or other length) selection of a drum track in the Chopper.

3. Click the **Insert Selection** button ( ).

4. Use the **Shift Selection Left** ( ) and **Shift Selection Right** ( ) buttons to move the selection randomly through the drum track, clicking the **Insert Selection** button ( ) to insert drum hits.

---

**Creating one-track remixes**

1. Place a Beatmapped track in the Chopper. For more information, see *Using the Beatmapper on page 103*.

2. Create a selection in the Chopper.

3. Click the **Insert Selection** button ( ) twice.

4. Use the **Shift Selection Right** button ( ) to move through the track, clicking the **Insert Selection** button ( ) as desired to insert events.

---

**Creating DJ-style crossfades**

You can use the Chopper and the crossfade keyboard shortcut to crossfade between two tracks much like a DJ crossfades between two records.

1. Insert two Beatmapped tracks into your project. For more information, see *Using the Beatmapper on page 103*.

2. Place the file from track one in the Chopper.

3. Turn off the **Link Arrow to Selection** button ( ).

4. Create a three-beat selection in the Chopper and drag the increment arrow length to four beats.

5. Click **Insert Selection** button ( ).

6. Press **Ctrl** + to shift the selection right by the length of the insert increment arrow.

7. Repeat steps five and six as desired.
8. Place the file from track two in the Chopper.
9. Repeat steps four through six to insert events from track two.
10. Select all events on the two beatmapped tracks in the track view.
11. Press [F]. ACID creates crossfades between your events.

Creating pseudo-granular synthesis

1. Create a sixty-fourth note (or shorter) selection in the Chopper.
2. Click the Insert Selection button ( ).
3. Use the Shift Selection Left ( ) and Shift Selection Right ( ) buttons to move the selection randomly through the track, clicking the Insert Selection button ( ) to insert events.

Building instrument solos

The previous section described an extended technique to create challenging rhythmic variations in your projects. You can use a slightly different version of the slice-and-dice technique to build instrument solos for your projects. To demonstrate this, let’s start with an event containing a simple bass riff.

1. Slice and dice the file in the Chopper to create new riffs and add them to the project. For more information, see Using the Chopper on page 85.
2. Use the pitch shifting to transpose some of the new events. For more information, see Changing an event’s key on page 82.
3. Apply volume envelopes to simulate the varying attacks associated with live soloing. For more information, see Adding volume or pan envelopes on page 97.
4. Use tempo/key/time signature change markers to create passages with tempos that deviate from the project tempo. For more information, see Working with tempo/key/time signature change markers on page 81.

Building scales

Though it is well outside the intended scope of the application, you can use ACID to build unique scales from audio loops. To do this, you must first isolate a note and determine what pitch it is. You can easily do this using Sound Forge’s Spectrum Analysis tool. Once you isolate and identify the note, choose Save As from the File menu in Sound Forge to save the note as a new WAV file with a unique name. Finally, add the file to the ACID project and use pitch shifting to create all remaining notes in the scale.
The glossary contains terms and their definitions that you may come across in the manual. This glossary not only includes terms associated with ACID, but also includes relevant industry terms.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>.acd-zip</td>
<td>An ACID project file that contains all information regarding the project including track layout, envelope settings, and effects parameters. In addition, all audio files used in the project are embedded into the project file.</td>
</tr>
<tr>
<td>Activation Code</td>
<td>This number is based on the Computer ID number of the computer on which ACID is installed. Each computer has a unique number, similar to a license plate. When you register ACID, Sonic Foundry generates an activation code for you based on the Computer ID number. Once you enter the activation code, ACID will not time out. Since the activation number is based on the Computer ID, it is important that you have ACID installed on the computer where you will be using it.</td>
</tr>
<tr>
<td>Adaptive Delta Pulse Code Modulation (ADPCM)</td>
<td>A method of compressing audio data. Although the theory for compression using ADPCM is standard, there are many different algorithms employed. For example, Microsoft’s ADPCM algorithm is not compatible with the International Multimedia Association’s (IMA) approved ADPCM.</td>
</tr>
<tr>
<td>Advanced Streaming Format (ASF)</td>
<td>See Windows Media Format.</td>
</tr>
<tr>
<td>Aliasing</td>
<td>A type of distortion that occurs when digitally recording high frequencies with a low sample rate. For example, in a motion picture, when a car's wheels appear to slowly spin backward while the car is quickly moving forward, you are seeing the effects of aliasing. Similarly, when you try to record a frequency greater than one half of the sampling rate (the Nyquist Frequency), instead of hearing a high pitch, you may hear a low-frequency rumble. To prevent aliasing, an anti-aliasing filter is used to remove high-frequencies before recording. Once the sound has been recorded, aliasing distortion is impossible to remove without also removing other frequencies from the sound. This same anti-aliasing filter must be applied when resampling to a lower sample rate.</td>
</tr>
<tr>
<td>ASIO</td>
<td>ASIO (Audio Stream In/Out) is a low-latency driver model developed by Steinberg Media Technologies AG.</td>
</tr>
<tr>
<td>Attack</td>
<td>The attack of a sound is the initial portion of the sound. Percussive sounds (drums, piano, guitar plucks) are said to have a fast attack. This means that the sound reaches its maximum amplitude in a very short time. Sounds that slowly swell up in volume (soft strings and wind sounds) are said to have a slow attack.</td>
</tr>
<tr>
<td>Attenuation</td>
<td>A decrease in the level of a signal.</td>
</tr>
<tr>
<td>Audio Compression Manager (ACM)</td>
<td>The Audio Compression Manager from Microsoft is a standard interface for audio compression and signal processing for Windows. The ACM can be used by Windows programs to compress and decompress WAV files.</td>
</tr>
<tr>
<td>Glossary Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Audio Interchange File Format (AIFF)</td>
<td>An audio file format developed by Apple Computer.</td>
</tr>
<tr>
<td>Audio Proxy File (.sfap0)</td>
<td>See Proxy File.</td>
</tr>
<tr>
<td>Bandwidth</td>
<td>When discussing audio equalization, each frequency band has a width associated with it that determines the range of frequencies that are affected by the EQ. An EQ band with a wide bandwidth affects a wider range of frequencies than one with a narrow bandwidth. When discussing network connections, refers to the rate of signals transmitted; the amount of data that can be transmitted in a fixed amount of time (stated in bits/second): a 56 Kbps network connection is capable of receiving 56,000 bits of data per second.</td>
</tr>
<tr>
<td>Beatmapped track</td>
<td>A file that has tempo information added to it as a result of going through the Beatmapper Wizard.</td>
</tr>
<tr>
<td>Beats Per Minute (BPM)</td>
<td>The tempo of a piece of music can be written as a number of beats in one minute. If the tempo is 60 BPM, a single beat occurs once every second.</td>
</tr>
<tr>
<td>Bit</td>
<td>The most elementary unit in digital systems. Its value can only be 1 or 0, corresponding to a voltage in an electronic circuit. Bits are used to represent values in the binary numbering system. As an example, the 8-bit binary number 10011010 represents the unsigned value of 154 in the decimal system. In digital sampling, a binary number is used to store individual sound levels, called samples.</td>
</tr>
<tr>
<td>Bit Depth</td>
<td>The number of bits used to represent a single sample. For example, 8- or 16-bit are common sample sizes. While 8-bit samples take up less memory (and hard disk space), they are inherently noisier than 16-bit samples.</td>
</tr>
<tr>
<td>Buffer</td>
<td>Memory used as an intermediate repository in which data is temporarily held while waiting to be transferred between two locations. A buffer ensures an uninterrupted flow of data between computers. Media players may need to rebuffer when there is network congestion.</td>
</tr>
<tr>
<td>Bus</td>
<td>A virtual pathway where signals from tracks and effects are mixed. A bus's output can be a physical audio device in the computer from which the signal is heard.</td>
</tr>
<tr>
<td>Byte</td>
<td>Refers to a set of 8 bits. An 8-bit sample requires one byte of memory to store, while a 16-bit sample takes two bytes of memory to store.</td>
</tr>
<tr>
<td>Clipboard</td>
<td>The clipboard is the location where data cut or copied from ACID is stored. You can then paste the data back into ACID at a different location.</td>
</tr>
<tr>
<td>Clipping</td>
<td>Occurs when the amplitude of a sound is above the maximum allowed recording level. In digital systems, clipping is seen as a clamping of the data to a maximum value, such as 32,767 in 16-bit data. Clipping causes sound to distort.</td>
</tr>
<tr>
<td>Codec</td>
<td>Coder/decoder: refers to any technology for compressing and decompressing data. The term codec can refer to software, hardware, or a combination of both technologies.</td>
</tr>
</tbody>
</table>
| Compression Ratio (audio)     | A compression ratio controls the ratio of input to output levels above a specific threshold. This ratio determines how much a signal has to rise above the threshold for every 1 dB of increase in the output. For example, with a ratio of 3:1, the input level must increase by three decibels to produce a one-decibel output-level increase:  
  - Threshold = -10 dB  
  - Compression Ratio = 3:1  
  - Input = -7 dB  
  - Output = -9 dB  
  Because the input is 3 dB louder than the threshold and the compression ratio is 3:1, the resulting signal is 1 dB louder than the threshold. |
**Compression Ratio (file size)**

The ratio of the size of the original noncompressed file to the compressed contents. For example, a 3:1 compression ratio means that the compressed file is one-third the size of the original.

**Computer ID**

Each computer has a unique number, similar to a license plate. Sonic Foundry creates an activation number for ACID based on that number. Since the activation number is based on the Computer ID, it is important that you have ACID installed on the computer where you will be using it. The Computer ID is automatically detected and provided to you when you install ACID.

The Computer ID is used for registration purposes only. It doesn’t give Sonic Foundry access to any personal information and can’t be used for any purpose other than for generating a unique activation number for you to use ACID.

**Crossfade**

Mixing two pieces of audio by fading one out as the other fades in.

**DC Offset**

DC offset occurs when hardware, such as a sound card, adds DC current to a recorded audio signal. This current results in a recorded wave that is not centered around the zero baseline. Glitches and other unexpected results can occur when sound effects are applied to files that contain DC offsets.

**Decibel (dB)**

A unit used to represent a ratio between two numbers using a logarithmic scale. For example, when comparing the numbers 14 and 7, you could say 14 is two times greater than the number 7; or you could say 14 is 6 dB greater than the number 7. Where did we pull that 6 dB from? Engineers use the equation $dB = 20 \times \log \left( \frac{V1}{V2} \right)$ when comparing two instantaneous values. Decibels are commonly used when dealing with sound because the ear perceives loudness in a logarithmic scale.

In ACID, most measurements are given in decibels. For example, if you want to double the amplitude of a sound, you apply a 6 dB gain. A sample value of 32,767 (maximum positive sample value for 16-bit sound) can be referred to as having a value of 0 dB. Likewise, a sample value of 16,384 can be referred to having a value of -6 dB.

**Device Driver**

A program that enables Windows to connect different hardware and software. For example, a sound card device driver is used by Windows software to control sound card recording and playback.

**Digital Rights Management (DRM)**

A system for delivering songs, videos, and other media over the Internet in a file format that protects copyrighted material. Current proposals include some form of certificates that validate copyright ownership and restrict unauthorized redistribution.

**Digital Signal Processing (DSP)**

A general term describing anything that alters digital data. Signal processors have existed for a very long time (tone controls, distortion boxes, wah-wah pedals) in the analog (electrical) domain. Digital Signal Processors alter the data after it has been digitized by using a combination of programming and mathematical techniques. DSP techniques are used to perform many effects such as equalization and reverb simulation.

Since most DSP is performed with simple arithmetic operations (additions and multiplications), both your computer’s processor and specialized DSP chips can be used to perform any DSP operation. The difference is that DSP chips are optimized specifically for mathematical functions while your computer’s microprocessor is not. This results in a difference in processing speed.

**DirectX**

A set of Application Program Interfaces designed by Microsoft for multimedia development. A DirectX plug-in, such as the Sonic Foundry Noise Reduction DirectX Plug-In, uses the DirectX Media Streaming Services (DMSS) API. Because DMSS is a standard API, a DirectX plug-in can be used in any application that supports DMSS.

**Downbeat**

This term is used in the Beatmapper to refer to the first beat of the first measure.

**Downloadable Sound (DLS)**

A DLS file stores a custom sound set that you can load into your soft synth, giving you another set of voices for MIDI playback.
<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drag and Drop</td>
<td>A quick way to perform certain operations using the mouse. To drag and drop, you click and hold an item, drag it (hold the left mouse button down and move the mouse) and drop it (let go of the mouse button) at another position on the screen.</td>
</tr>
<tr>
<td>Dynamic Range</td>
<td>The difference between the maximum and minimum signal levels. It can refer to a musical performance (high-volume vs. low-volume signals) or to electrical equipment (peak level before distortion vs. noise floor). For example, orchestral music has a wide dynamic range, while thrash metal has a very small (always loud) range.</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Envelopes allow you to automate the change of a certain parameter over time. In the case of volume, you can create a fade out (which requires a change over time) by adding an envelope and creating a point in the line to indicate where the fade starts. Then you pull the end point of the envelope down to -inf.</td>
</tr>
<tr>
<td>Equalization (EQ)</td>
<td>Equalizing a sound file is a process by which certain frequency bands are raised or lowered in level. EQ has various uses. The most common use for ACID users is to simply adjust the subjective timbral qualities of a sound.</td>
</tr>
<tr>
<td>Event</td>
<td>An instance of a media file on a track. An event may play an entire media file or a portion of the file.</td>
</tr>
<tr>
<td>File Format</td>
<td>A file format specifies the way in which data is stored. In Windows, the most common audio file format is the Microsoft WAV format.</td>
</tr>
<tr>
<td>Frame Rate</td>
<td>Audio uses frame rates only for the purposes of synching to video or other audio. To synchronize with audio, a rate of 30 fps (frames per second) is typically used. To synchronize with video, 29.97 fps drop is usually used.</td>
</tr>
<tr>
<td>Frequency Spectrum</td>
<td>The frequency spectrum of a signal refers to its range of frequencies. In audio, the frequency range is basically 20 Hz to 20,000 Hz. The frequency spectrum sometimes refers to the distribution of these frequencies. For example, bass-heavy sounds have a large frequency content in the low end (20 Hz-200 Hz) of the spectrum.</td>
</tr>
<tr>
<td>Hertz (Hz)</td>
<td>The unit of measurement for frequency or cycles per second (CPS).</td>
</tr>
<tr>
<td>Insert Increment</td>
<td>Sections of silence between selections that you can create using the Chopper and insert into the track view.</td>
</tr>
<tr>
<td>Insertion Point</td>
<td>The insertion point (also referred to as the cursor position) is analogous to the cursor in a word processor. It is where markers or commands may be inserted depending on the operation. The insertion point appears as a vertical flashing black line and can be moved by clicking the left mouse button anywhere in the track view.</td>
</tr>
<tr>
<td>Loop</td>
<td>Loops are small audio clips that are designed to create a repeating beat or pattern. Loops are usually one to four measures long and are stored completely in RAM for playback.</td>
</tr>
<tr>
<td>Marker</td>
<td>A marker is an anchored, accessible reference point in a file.</td>
</tr>
<tr>
<td>MIDI Channel</td>
<td>An informational pathway over which MIDI data can travel.</td>
</tr>
<tr>
<td>Media Control Interface (MCI)</td>
<td>A standard way for Windows programs to communicate with multimedia devices such as sound cards and CD players. If a device has an MCI device driver, it can easily be controlled by most multimedia Windows software.</td>
</tr>
<tr>
<td>Media File</td>
<td>Files that may be placed within the ACID project. After a media file is placed into the project, it is referred to as an event.</td>
</tr>
<tr>
<td>MIDI Clock</td>
<td>A MIDI device-specific timing reference. MIDI Clock is not absolute time like MIDI timecode (MTC); instead it is a tempo-dependent number of ticks per quarter note. MIDI clock is convenient for synchronizing devices that need to perform tempo changes mid-song. ACID supports MIDI clock out, but does not support MIDI clock in.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MIDI Port</td>
<td>A MIDI port is the physical MIDI connection on a piece of MIDI hardware. This port can be a MIDI in, out or through. Your computer must have a MIDI-capable card to output MIDI timecode to an external device or to receive MIDI timecode from an external device.</td>
</tr>
<tr>
<td>MIDI Timecode (MTC)</td>
<td>MTC is an addendum to the MIDI 1.0 specification and provides a way to specify absolute time for synchronizing MIDI-capable applications. MTC is essentially a MIDI representation of SMPTE timecode.</td>
</tr>
<tr>
<td>Multiple-Bit-Rate Encoding</td>
<td>Multiple-bit-rate encoding (also known as Intelligent Streaming for the Windows Media platform and SureStream™ for the RealMedia G2 platform) allows you to create a single file that contains streams for several bit rates. A multiple-bit-rate file can accommodate users with different Internet connection speeds, or these files can automatically change to a different bit rate to compensate for network congestion without interrupting playback. To take advantage of multiple-bit-rate encoding, you must publish your media files to a Windows Media server or a RealServerG2.</td>
</tr>
<tr>
<td>Musical Instrument Device Interface (MIDI)</td>
<td>A standard language of control messages that provides for communication between any MIDI-compliant devices. Anything from synthesizers to lights to factory equipment can be controlled via MIDI.</td>
</tr>
<tr>
<td>Normalize</td>
<td>Refers to raising the volume so that the highest level sample in the file reaches a user defined level. Use normalization to make sure you are using all of the dynamic range available to you.</td>
</tr>
<tr>
<td>Nyquist Frequency</td>
<td>The Nyquist Frequency (or Nyquist Rate) is one half of the sample rate and represents the highest frequency that can be recorded using the sample rate without aliasing. For example, the Nyquist Frequency of 44,100 Hz is 22,050 Hz. Any frequencies higher than 22,050 Hz produce aliasing distortion in the sample if no anti-aliasing filter is used while recording.</td>
</tr>
<tr>
<td>Offline Media</td>
<td>A media file that cannot be located on the computer. If you choose to leave the media offline, you can continue to edit events on the track; the events point to the original location of the source media file.</td>
</tr>
<tr>
<td>One-Shot</td>
<td>One-shots are chunks of audio that are not designed to loop, and they are streamed from the hard disk rather than stored in RAM if they are longer than three seconds. Things such as cymbal crashes and sound bites could be considered one-shots. Unlike loops, one-shots do not change pitch or tempo with the rest of a project.</td>
</tr>
<tr>
<td>OPT Plug-In</td>
<td>A plug-in that uses Yamaha's Open Plug-in Technology (OPT) standard. OPT plug-ins provide tools for working with MIDI such as edit views, effect processors and filters, arpeggiators, and real-time panel automation.</td>
</tr>
<tr>
<td>Pan</td>
<td>To place a mono or stereo sound source perceptually between two or more speakers.</td>
</tr>
<tr>
<td>Peak Data File</td>
<td>The file created by ACID when a file is opened for the first time. This file stores the information regarding the graphic display of the waveform so that opening a file is almost instantaneous. This file is stored in the directory where the audio file resides and has a .sfk extension. If this file is not in the same directory as the audio file or is deleted, ACID recalculates it the next time you open the file.</td>
</tr>
<tr>
<td>Proxy File</td>
<td>Working with certain types of media files with particular audio compression schemes can be inefficient and slow. To compensate for this, ACID creates audio proxy files for these formats to dramatically increase speed and performance. The file is saved as a proprietary .sfap0 file, with the same name as the original media file and the same characteristics as the original audio stream. The conversion happens automatically and does not result in a loss of quality or synchronization. You can safely delete audio proxy files at any time since ACID recreates these files as needed.</td>
</tr>
<tr>
<td><strong>Glossary Term</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>------------------</td>
<td>----------------</td>
</tr>
<tr>
<td><strong>Pulse Code Modulation (PCM)</strong></td>
<td>PCM is the most common representation of uncompressed audio signals. This method of coding yields the highest fidelity possible when using digital storage. PCM is the standard format for WAV and AIFF files.</td>
</tr>
<tr>
<td><strong>Quantization</strong></td>
<td>The correction of rhythms to align with selected note lengths or beats in a MIDI sequence.</td>
</tr>
<tr>
<td><strong>Real-Time Streaming Protocol (RTSP)</strong></td>
<td>A proposed standard for controlling broadcast of streaming media. RTSP was submitted by a body of companies including RealNetworks and Netscape.</td>
</tr>
<tr>
<td><strong>Redirector File</strong></td>
<td>A metatile that provides information to a media player about streaming media files. To start a streaming media presentation, a Web page includes a link to a redirector file. Linking to a redirector file allows a file to stream; if you link to the media file, it downloads before playback. Windows Media redirector files use the .asx or .wax extension; RealMedia redirector files use the .ram, .rpm, or .smi extension.</td>
</tr>
<tr>
<td><strong>Region</strong></td>
<td>A region in ACID is a section of time used to subdivide your project into segments.</td>
</tr>
<tr>
<td><strong>Rendering</strong></td>
<td>The process in which ACID saves the project to a specific file format like WMA or MP3.</td>
</tr>
<tr>
<td><strong>Resample</strong></td>
<td>The act of recalculating samples in a sound file at a different rate than the file was originally recorded. If a sample is resampled at a lower rate, sample points are removed from the sound file, decreasing its size, but also decreasing its available frequency range. Resampling to a higher sample rate, ACID interpolates extra sample points in the sound file. This increases the size of the sound file, but does not increase the quality. When down-sampling, one must be aware of aliasing.</td>
</tr>
</tbody>
</table>
| **Sample** | The word sample is used in many different (and often confusing) ways when talking about digital sound. Here are some of the different meanings:  
- A discrete point in time which a sound signal is divided into when digitizing. For example, an audio CD-ROM contains 44,100 samples per second. Each sample is really only a number that contains the amplitude value of a waveform measured over time.  
- A sound that has been recorded in a digital format; used by musicians who make short recordings of musical instruments to be used for composition and performance of music or sound effects. These recordings are called samples. In this manual, we try to use sound file instead of sample whenever referring to a digital recording.  
- The act of recording sound digitally, i.e., to sample an instrument means to digitize and store it. |
| **Sample Rate** | The sample rate (also referred to as the sampling rate or sampling frequency) is the number of samples per second used to store a sound. High sample rates, such as 44,100 Hz provide higher fidelity than lower sample rates, such as 11,025 Hz. However, more storage space is required when using higher sample rates. |
| **Sample Size** | See Bit Depth. |
| **Sample Value** | The sample value (also referred to as sample amplitude) is the number stored by a single sample. In 16-bit audio, these values range from -32768 to 32767. In 8-bit audio, they range from -128 to 127. The maximum allowed sample value is often referred to as 100% or 0 dB. |
| **Secure Digital Music Initiative (SDMI)** | The Secure Digital Music Initiative (SDMI) is a consortium of recording industry and technology companies organized to develop standards for the secure distribution of digital music. The SDMI specification was created to answer consumer demand for convenient accessibility to quality digital music, enable copyright protection for artists’ work, and enable technology and music companies to build successful businesses. |
| **Shortcut Menu** | A context-sensitive menu that appears when you right-click certain areas of the screen. The functions available in the shortcut menu depend on the object being right-clicked as well as the state of the program. As with any menu, you can choose an item from the shortcut menu to perform an operation. Shortcut menus are used frequently in ACID for quick access to many commands. |
| **Signal-to-Noise Ratio** | The signal-to-noise ratio (SNR) is a measurement of the difference between a recorded signal and noise levels. A high SNR is always the goal. The maximum signal-to-noise ratio of digital audio is determined by the number of bits per sample. In 16-bit audio, the signal to noise ratio is 96 dB, while in 8-bit audio the ratio is 48 dB. However, in practice this SNR is never achieved, especially when using low-end electronics. |
| **Society of Motion Picture and Television Engineers (SMPTE)** | SMPTE timecode is used to synchronize time between devices. The timecode is formatted as hours:minutes:second:frames, where frames are fractions of a second based on the frame rate. Frame rates for SMPTE timecode are 24, 25, 29.97 and 30 frames per second. |
| **Soft Synth** | A soft synth is a software-based synthesizer. Downloadable Sounds (DLS) and Virtual Studio Technology Instruments (VSTi) are two types of soft synths. In ACID, you add a soft synth control in the Mixer window for each software synthesizer you want to use in a project. |
| **Streaming** | A method of data transfer in which a file is played while it is downloading. Streaming technologies allow Internet users to receive data as a steady, continuous stream after a brief buffering period. Without streaming, users must download files completely before playback. |
| **Tempo** | Tempo is the rhythmic rate of a musical composition, usually specified in beats per minute (BPM). |
| **Threshold** | A threshold determines the level at which the signal processor begins acting on the signal. During normalization, levels above this threshold are attenuated (cut). |
| **Time Format** | The format by which ACID displays the time ruler and selection times. These can include: time, seconds, frames, and all standard SMPTE frame rates. |
| **Track** | A discrete timeline for audio data. Audio events sit on tracks and determine when a sound starts and stops. Multiple audio tracks are played together to give you a composite sound that you hear through your speakers. |
| **Track List** | The track list contains the master controls for each track. From here you can adjust the mix, select playback devices, and reorder tracks. |
| **Track View** | The majority of the track view is made up of the space where you draw events on each track. |
| **µ-Law** | µ-Law (mu-Law) is a companded compression algorithm for voice signals defined by the Geneva Recommendations (G.711). The G.711 recommendation defines µ-Law as a method of encoding 16-bit PCM signals into a non-linear 8-bit format. The algorithm is commonly used in European and Asian telecommunications. µ-Law is very similar to A-Law, however, each uses a slightly different coder and decoder. |
| **Undo/Redo** | These commands allow you to change a project back to a previous state or reapply changes after you have undone them. |
| **Virtual MIDI Router (VMR)** | A software-only router for MIDI data between programs. ACID uses the VMR to receive MIDI timecode and send MIDI clock. No MIDI hardware or cables are required for a VMR, so routing can only be performed between programs running on the same PC. |
| **VST Instrument (VSTi)** | A Virtual Studio Technology instrument (VSTi) is software synthesizer plug-in technology for outputting MIDI developed by Steinberg Media Technologies AG. |
| **WAV** | A digital audio file format developed by Microsoft and IBM. One minute of uncompressed audio requires 10 MB of storage. |
| **Waveform** | A waveform is the visual representation of wave-like phenomena, such as sound or light. For example, when the amplitude of sound pressure is graphed over time, pressure variations usually form a smooth waveform. |
| **Waveform Display** | Each event shows a graph of the sound data waveform. The vertical axis corresponds to the amplitude of the wave. For 16-bit sounds, the amplitude range is -32,768 to +32,767. For 8-bit sounds, the range is -128 to +127. The horizontal axis corresponds to time, with the leftmost point being the start of the waveform. In memory, the horizontal axis corresponds to the number of samples from the start of the sound file. |
| **Windows Media Format** | A Microsoft file format that can handle audio and video presentations and other data such as scripts, URL flips, images and HTML tags. Advanced Streaming Format files can be saved with .asf, .wma, or .wmv extensions. |
Index

Numerics

5.1 Surround Plug-In Pack, 157, 168, 169
5.1 Surround, See Surround

A

AC-3 Encoder, 157, 168, 169
Add channels panning model, 103, 164
Adding
Assignable effects, 113
Busses, 111
Events, 39
Media to projects, 36
MIDI tracks, 131
Soft synth controls, 116
Video, 153
Adjusting the mix, 46
ASIO drivers, 31
Assignable effects, 113–115, 120–125
Adding, 113
Adjusting levels sent from tracks, 97–102
Assigning tracks to, 114
Deleting, 115
Routing to busses, 114
Saving effect packages, 124
Audio Plug-In window, 18, 93–96
Audio preferences tab, 181
Audio properties tab, 34
Audio signal flow, 24–25
Automating
Effects, 97–102
Mixer controls, 125
Surround panning, 165–167

B

Balance panning model, 103, 164
Beat ruler, 17
Beatmapped tracks, 38
Stretching properties, 106, 108
Beatmapper wizard, 103
Bit depth, 34

Burning CDs, 57
Bus tracks, 125
Busses, 111–113, 120–125
Adding, 111
Adjusting levels sent from tracks, 97–102, 112
Assigning tracks to, 15, 111
Deleting, 112
Panning, 162
Routing assignable effects to, 114
Routing to hardware, 112
Using effects, 121
Using the control, 120

C

CD
Extracting media, 37
Writing media, 57
Changing the track color, 45
Channelization in MIDI files, 133
Chopper, 18, 85–91
Grid, 85
Inserting selections from, 90
Keyboard shortcuts, 86
Markers and regions, 87
Saving selections as new files, 90
Selecting audio, 87
Snapping options, 85
Tips and tricks, 193
Using with one-shots, 91
Window, 85
Clipping, 52
Cloning loops, 90, 193
Command markers, 73
Constant power panning model, 103, 164
Copying
Events, 59
Tracks, 46
Crossfade, 70, 194
Cursor, 41–44, 177
Customer service/sales, 1
INDEX

Cutting
   Events, 61
      In ripple mode, 65
   Tracks, 46

Deleting
   Assignable effects, 115
   Audio from a video, 154
   Busses, 112
   Events, 40, 61
      In ripple mode, 66
   Soft synth controls, 120
   Tracks, 46
   Video, 153

Detuning tracks, 187

DLS sets
   Changing patches, 117
   Routing tracks to, 120, 149
   Using, 117

Docking windows, 172

Downloading media from the Web, 38

Drawing events, 39

Duplicating tracks, 45

DVD burning, 169

Editing preferences tab, 183

Effects
   Assignable, 121
   Automating, 97–102
   Bus, 121
   Managing effects, 124
   Preset Manager, 124
   Project, 121
   Saving plug-in packages, 96, 124
   Saving presets, 94, 122
   Soft synth, 121
   Track, 93–96

Envelopes
   Customizing colors, 185
   Envelope tool, 100
   Event, 69
   Flipping, 100
   Mixer controls, 125
   Track, 97–102

Erasing events, 40, 190

Events
   Changing length, 40
   Changing pitch, 82
   Copying, 59
   Crossfading, 70
   Cutting, 61, 65
   Deleting, 61, 66
   Editing in ripple mode, 64–67
   Envelopes, 69
   Erasing, 40
   Fading edges for offsets, 69
   Fading in and out, 70
   Joining, 64
   Moving, 41
   Painting, 39
   Pasting, 59, 66
   Pitch shifting, 69
   Properties, 68
   Selecting, 42–44
   Shifting the contents of, 68
   Sliding, 68
   Slipping, 68
   Slip-trimming, 68
   Snapping, 78
   Speed, 69
   Splitting, 62
   Start offset, 69
   Trimming, 61
   Volume, 69

Explorer window, 35–37

Exporting loops, 110

External devices
   Playing MIDI from, 150
   Routing busses to, 112
   Routing MIDI tracks to, 149
   Routing video to, 156

External monitor, 156

Extracting media from CD, 37

Faders, Mixer, 51, 120

Fading edges of events, 69

Fading in/out
   Events, 70
   Mixer controls, 125
   Tracks, 97–102

Filtering MIDI events
   During playback, 134
   In the list editor, 141

Fitting to time, 83

Flipping envelopes, 100

Floating windows, 172

Frame numbering, 154
INDEX

G
General preferences tab, 179
Getting media from the Web, 38
Glossary, 197
Go to, 42
Grid, 174

H
Hardware
Playing MIDI from, 150
Routing busses to, 112
Routing MIDI tracks to, 149
Routing surround to, 159
Routing video to, 156
Setting up for surround, 158
Help, 12–13
Hiding/showing
Bus tracks, 125
Toolbar, 175
Track envelopes, 101–102
Video tracks, 153
Windows, 171

I
Inserting time, 82
Installation, 11

J
Joining events, 64

K
Key changes
Event, 69, 82
Marker, 81
Project, 80
Track, 82
Keyboard shortcuts
Chopper window, 86
General, 19
Keyframes, 165–167

L
LFE channel, 157, 160

List editor, 140–147
Creating MIDI events, 145
Deleting MIDI events, 147
Editing MIDI events, 141
Filtering MIDI events, 141
MIDI event parameters, 142
MIDI notes and frequencies, 144
Previewing MIDI events, 140
Quantizing note events, 146
Step recording MIDI, 145
Undoing and redoing, 147

Looped playback, 50

Loops
Creating in the Chopper, 90
Exporting from projects, 110
Stretching properties, 106, 107–108
Tracks, 38

Main window, 13
Markers, 71–75
Command markers, 73
In the Chopper, 87
Marker bar, 17
Tempo/key/time signature markers, 81
Time markers, 73

Media files
Adding to projects, 36
Downloading from the Web, 38
Exporting loops from projects, 110
Extracting from CD, 37
Previewing in Chopper, 86
Previewing in Explorer, 35
Reloading, 108
Replacing, 109
Saving track properties to, 109

Meter resolution, 120

MIDI, 131–152
Adding tracks, 131
DLS sets, 149
List editor, 140–147
Notes and frequencies, 144
OPT plug-ins, 147
Panic button, 149
Piano roll editor, 134–139
Playback devices, 149
Playing from external devices, 150
Preferences, 182
Quantizing, 139, 146
Recording, 131
Rendering, 150
Resetting ports, 149
Routing to hardware, 149
Setting device preferences, 149
Signal flow, 26–27
Step recording, 145
Timecode synchronization, 151–152
Track properties, 132–133
Tracks, 39
VST instruments, 149
Mixer window, 50–52, 111–125
Automating controls, 125
Routing surround through, 159
Working with mixer controls, 120
Working with multiple controls, 125
Mixing to a single track, 109
Monitor for video editing, 156
Moving
Events, 41
Tracks, 45
Multipurpose slider, 16, 46
Muting
Mixer controls, 121
Tracks, 16, 47
Tracks in MIDI files, 133
One-shots
Selecting in the Chopper, 91
Tracks, 38
Online help, 12
Opening
Media files, 36
Projects, 34
OPT plug-ins, 147
Other preferences tab, 185
Packages, Saving, 96, 124
Painting events, 39, 40
Panic button, 149
Panning
Pan types, 103, 164
Surround, 160
Tracks, 16, 46, 97–102
Tracks in MIDI files, 133
Pasting
Events, 59
In ripple mode, 66
Tracks, 46
Piano roll editor, 134–139
Adding note events, 136
continuous controller information, 138
Deleting note events, 139
Editing note events, 137
Previewing MIDI, 135
Quantizing note events, 139
Selecting MIDI tracks, 136
Selecting note events, 138
Undoing and redoing, 139
Pitch shifting
Events, 69, 82
MIDI tracks, 132
Projects, 80
Tracks, 82
Playing projects, 49
Plug-Ins, See Effects
Preferences
Audio, 181
Editing, 183
General, 179
MIDI, 182
Other, 185
Sync, 184
Video, 183
VST Instruments, 182
Preset Manager, 124
Presets
Managing, 124
Saving, 122
Previewing media
Adjusting preview volume, 51
Chopper window, 86
Explorer window, 35
Projects
Adding media, 36
Key, 80
Opening, 34
Playing, 49
Properties, 33
Publishing to the Internet, 56
Rendering, 54
Saving, 53
Starting, 33
Tempo, 79
Time signature, 80
Properties
Event, 68
MIDI track, 132–133
Project, 33
Recording, 128
Track, 105–109
Proxy file, 201
Publishing projects, 56
Quantizing MIDI
   In the list editor, 146
   In the piano roll editor, 139

Recording, 127–130
   MIDI step recording, 145
   MIDI tracks, 131
   Multiple takes, 130
   Properties, 128
   Setting levels, 129

Redo, 49

Regions, 76–77
   In the Chopper, 87

Registration assistance, 1

Reloading
   Media files, 108
   MIDI files, 148

Removing
   Audio from a video, 154
   Video tracks, 153

Renaming
   Mixer controls, 51
   Tracks, 45
   Tracks in MIDI files, 133

Rendering
   MIDI projects, 150
   Projects, 54
   Supported formats, 55
   Surround projects, 168
   To new tracks, 109
   Using custom settings, 55

Reordering tracks, 45

Replacing
   Media files, 109
   MIDI files, 148

Resetting MIDI ports, 149

Resizing
   Tracks, 45
   Windows, 173

ReWire panel applications
   inserting as soft synth, 119
   Locating for use in ACID, 119
   opening, 119
   using with ACID, 119

Ripping tracks from CD, 37

Ripple editing, 64–67
   Cutting events, 65
   Deleting events, 66
   Pasting events, 66
   Ruler offset, 173

Sample rate, 34

Saving
   Changes to MIDI files, 148
   Plug-in packages, 96, 124
   Presets, 122
   Projects, 53
   Track properties to media files, 109

Scoring video, 156

Selecting events, 42–44

Shortcut keys, 19

Signal flow
   Audio, 24–25
   MIDI, 26–27

Sliding
   Events, 68
   Video events, 154

Slipping
   Events, 68
   Video events, 154

Slip-trimming
   Events, 68
   Video events, 154

Snapping, 78
   In the Chopper window, 85

Soft synth controls, 115–125
   Adding, 116
   Assigning tracks to, 120
   Deleting, 120
   modifying properties, 116
   Routing to DLS sets, 117
   Routing to VST instruments, 117

Soft Synth Properties window, 19

Soloing
   Mixer controls, 121
   Tracks, 16, 48
   Tracks in MIDI files, 133

Splitting events, 62

Start offset, 69

Step recording MIDI, 145

Streaming media commands, 73

Stretching properties, 105–108

Summary properties tab, 33

Surround, 157–168
   Automating panning, 165–167
   Hardware setup, 158
   Keyframes, 165–167
   LFE channel, 157, 160
   Panning, 160
   Rendering, 168
Surround Panner window, 18, 163
Sync preferences tab, 184
Synchronizing audio and video, 153
System requirements, 11

Takes, recording multiple, 130
Technical support, 1
Tempo changes
  Marker, 81
  Project, 79
Temporary files, 36, 180
Time
  Fitting projects to time, 83
 Inserting into projects, 82
Time display, 177
Time markers, 73
Time ruler, 17, 173
Time signature changes
  Marker, 81
  Project, 80
Timecode synchronization, 151–152
Tips and tricks, 187–195
Toolbar, 14, 175–177
Track list, 15
Track Properties window, 18, 105–109, 132–133
Track view, 16
Tracks
  Adjusting bus send levels, 112
  Adjusting mix, 46
  Adjusting several simultaneously, 48
  Assigning to busses, 15, 111
  Assigning to effect chains, 114
  Assigning to soft synth controls, 120
  Changing color, 45
  Changing pitch, 82
  Copying, cutting, pasting, 46
  Default properties, 178
  Deleting, 46
  Duplicating, 45
  Effects, 93–96
  Envelopes, 97–102
  Muting, 16, 47
  Panning, 16, 46, 97–102, 161
  Properties, 105–109, 132–133, 178
  Renaming, 45
  Reordering, 45
  Resizing, 45
  Solos, 16, 48
  Stretching properties, 105–108
  Types, 38, 105
  Volume, 16, 46
Transport bar, 17
Transposing
  Beatmapped tracks to the project key, 108
  Keys within a project, 81
  Loop tracks to the project key, 107
  MIDI tracks to the project key, 132
  Project keys, 80
Trimming events, 61

U
Undo, 48
Undo history, 49

V
Video, 153–156
  Adding, 153
  Editing events, 154
  Frame numbering, 154
  Hiding/showing, 153
  Removing, 153
  Removing associated audio, 154
  Scoring, 156
  Synchronizing with audio, 153
Video preferences tab, 183
Video window, 18, 155
Voices
  Patch changes for DLS sets, 117
  VST instruments, 117
Volume
  Event, 69
  Project, 50, 120
  Recording, 129
  Track, 16, 46
  Tracks in MIDI files, 133

VST Instruments
  Preferences, 182

VST instruments
  Loading banks and presets, 118
  Locating for use in ACID, 118
  Routing MIDI tracks to, 120, 149
  Using, 117

W
  Wall of sound, 190
  What’s new?, 29–32
  What’s This? help, 13

Window docking area, 18

Windows
  Audio Plug-In, 18, 93–96
  Chopper, 18, 85
  Docking/floating, 172
  Explorer, 18, 35–37
  Hiding/showing, 171
  Main, 13
  Mixer, 18, 50–52, 111–125
  Soft Synth Properties, 19
  Surround Panner, 18, 163
  Track Properties, 18, 105–109, 132–133
  Video, 18

Writing to CD, 57

Z
  Zoom controls
    Chopper window, 86
    Main window, 17